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A tecnoloxía CFD, siglas de Computational
Fluid Dynamics, en galego Dinámica de
Fluídos Computacional, é unha técnica de
análise numérica que permite determinar
o comportamento dos fluídos mediante
a realización de experimentos virtuais no
ordenador. Esta técnica conta con varias
décadas de desenvolvemento científico
de respaldo, converténdose a día de hoxe
nun dos estándares de análise para nume-
rosos sectores industriais. É por iso que as
simulacións numéricas son empregadas
actualmente como eficaces ferramentas de
diagnóstico nas etapas de deseño, mellora
e optimización de produtos e procesos de
fabricación en industrias como a naval, a
automobilística, a aeroespacial, a hidráu-
lica, as enerxías renovables, a enxeñería
biomédica ou a construción.

Co fin de achegar o emprego desta técnica
ao alumnado do grado de Enxeñería Me-
cánica, este manual foi creado para servir
de apoio á docencia da materia Sistemas
�uidomecánicos e materiais avanzados para o

transporte, enfocándose na aplicación prác-
tica de simulacións numéricas en casos
reais da enxeñería nos que se atopan invo-
lucrados fluxos de fluídos. Esta colección
de exercicios prácticos pretende servir de
axuda na etapa formativa do alumnado,
facilitándolle a información necesaria e a
metodoloxía que deberá empregar para
levar a cabo o estudo de diferentes casos,
e favorecendo así unha comprensión intui-
tiva dos problemas propostos mediante a
análise dos resultados obtidos nas simula-
cións numéricas.

Por tratarse dun dos programas de CFD
máis empregados na industria, o software
utilizado nas actividades deste manual é
ANSYS Fluent 2020. Así tamén, as activi-
dades propostas neste manual foron dese-
ñadas para poder ser levadas a cabo con-
tando cunhas esixencias computacionais
accesibles para o alumnado, o cal poderá
realizar nun tempo axeitado os exercicios
aquí recollidos.
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Os catro autores deste
manual son docentes na Área
de Mecánica de Fluídos da
Escola de Enxeñería Industrial
da Universidade de Vigo, e
contan con experiencia no
ensino da materia Sistemas
fluidomecánicos e materiais
avanzados para o transporte, 
no Grado de Enxeñería
Mecánica. Concienciados
coa importancia de
incorporar a innovación
ao ensino universitario,
e con inquedanza por
mellorar a calidade da
docencia impartida, os
autores forman parte
dun grupo de innovación
docente denominado CFD
aplicado á docencia. Este
grupo ten como obxectivo
explorar as capacidades
do CFD (Dinámica de
Fluídos Computacional)
como ferramenta de
axuda na aprendizaxe dos
conceptos da Mecánica
de Fluídos. Mediante a
creación de novos contidos
e explicacións, busca
mellorar a comprensión dos
coñecementos por parte do
alumnado, favorecendo, ao
mesmo tempo, as tarefas
de aprendizaxe autónoma e
asíncrona.  Nos últimos anos

este grupo de innovación
docente colaborou en
diferentes proxectos nos que
levou a cabo a realización
de cursos masivos online e
abertos (MOOCs), a creación
dunha videoteca con material
formativo ou a realización de
actividades de aprendizaxe-
servizo.
No eido da investigación, os
autores pertencen ao Grupo
de Tecnoloxía Enerxética
(GTE), adscrito ao Centro de
Investigación en Tecnoloxías,
Enerxías e Procesos
Industriais (CINTECX), no
que colaboran en proxectos
de investigación nacionais
e internacionais. Este grupo
destaca polo elevado número
de contratos de colaboración
con diferentes empresas do
sector do transporte, como
son o sector ferroviario, o
aeronáutico, e súa estreita
colaboración coa industria
automobilística. A experiencia
dos autores na aplicación
da enxeñería en proxectos
industriais e de investigación
conxúgase neste manual, co
fin de trasladar ao alumnado
unha visión aplicada e
práctica dos conceptos desta
materia.
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Prólogo 

Motivación e obxectivos 

Este manual foi creado para servir de apoio na docencia de contidos 
prácticos da dinámica de fluídos na enxeñería. Unha vez que o alumnado 
adquiriu previamente as competencias de materias como Mecánica de 
Fluídos, este manual está especialmente indicado para unha aplicación 
práctica dos contidos teóricos, mediante a simulación numérica de casos 
e de supostos reais. Debido á escasa literatura previa existente neste eido, 
onde na maioría dos casos é preciso acudir a documentación técnica de 
fabricantes ou a guías de axuda de programas informáticos, o compendio 
de exercicios prácticos que aquí se recolle pretende facilitarlle ao 
alumnado a información necesaria e a metodoloxía que deberá empregar 
para levar a cabo diferentes estudos numéricos. 

Dende hai varios anos a Escola de Enxeñería Industrial da 
Universidade de Vigo [1] mantén unha estreita relación de colaboración 
con distribuidores de software específico de diferentes ramas da 
enxeñería. No campo desta materia, esta escola conta co programa de 
simulación numérica ANSYS [2], un software deseñado para a análise de 
estruturas dinámicas e estáticas, procesos fluidodinámicos e de 
transferencia de calor e masa, así como o estudo de problemas acústicos 
e electromagnéticos, o cal é empregado no ámbito industrial nas etapas 
de deseño e desenvolvemento de novos produtos e tecnoloxías. Desta 
forma, o alumnado poderá facer uso desta ferramenta de simulación 
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transferencia de calor e masa, así como o estudo de problemas acústicos 
e electromagnéticos, o cal é empregado no ámbito industrial nas etapas 
de deseño e desenvolvemento de novos produtos e tecnoloxías. Desta 
forma, o alumnado poderá facer uso desta ferramenta de simulación 

 
 

 

 

3 
 

 

Prólogo 

Motivación e obxectivos 

Este manual foi creado para servir de apoio na docencia de contidos 
prácticos da dinámica de fluídos na enxeñería. Unha vez que o alumnado 
adquiriu previamente as competencias de materias como Mecánica de 
Fluídos, este manual está especialmente indicado para unha aplicación 
práctica dos contidos teóricos, mediante a simulación numérica de casos 
e de supostos reais. Debido á escasa literatura previa existente neste eido, 
onde na maioría dos casos é preciso acudir a documentación técnica de 
fabricantes ou a guías de axuda de programas informáticos, o compendio 
de exercicios prácticos que aquí se recolle pretende facilitarlle ao 
alumnado a información necesaria e a metodoloxía que deberá empregar 
para levar a cabo diferentes estudos numéricos. 

Dende hai varios anos a Escola de Enxeñería Industrial da 
Universidade de Vigo [1] mantén unha estreita relación de colaboración 
con distribuidores de software específico de diferentes ramas da 
enxeñería. No campo desta materia, esta escola conta co programa de 
simulación numérica ANSYS [2], un software deseñado para a análise de 
estruturas dinámicas e estáticas, procesos fluidodinámicos e de 
transferencia de calor e masa, así como o estudo de problemas acústicos 
e electromagnéticos, o cal é empregado no ámbito industrial nas etapas 
de deseño e desenvolvemento de novos produtos e tecnoloxías. Desta 
forma, o alumnado poderá facer uso desta ferramenta de simulación 



 

4 
 

numérica para a resolución de problemas de sistemas fluidomecánicos 
relacionados co transporte. Neste contexto empregarase ANSYS Fluent 
como software de Dinámica de Fluídos Computacional, en inglés CFD 
(Computational Fluid Dynamics), o cal permitirá analizar e investigar o 
comportamento de diferentes sistemas industriais nos que están 
involucrados fluxos de fluídos.  

Os autores deste manual, os cales son profesores na Área de Mecánica 
de Fluídos, consideran importante a recompilación e actualización destes 
contidos nun texto de referencia para o alumnado. É por elo que a 
colección de exercicios prácticos recollidos nesta publicación pretende 
servir de axuda e de guía na súa etapa formativa. 

Para a realización deste manual fixáronse tres obxectivos fundamentais: 

• Introducir ao alumnado no emprego da Dinámica de Fluídos 
Computacional, dun xeito sinxelo pero con rigor, en aplicacións 
de sistemas fluidomecánicos asociados co transporte. 

• Fomentar no alumnado unha actitude crítica cos resultados 
acadados nas simulacións numéricas, mediante a realización de 
análises teóricas e experimentais que permitan corroborar a 
validez dos resultados numéricos obtidos. 

• Desenvolver unha comprensión intuitiva dos problemas propostos 
mediante o emprego de contidos de carácter descritivo, como 
gráficos, imaxes de exemplo, esquemas e diagramas conceptuais, 
que faciliten ao alumnado a comprensión dos conceptos tratados.  

Estrutura 

Este manual está estruturado en dez capítulos, cada un dos cales 
conta cun exercicio práctico. Se ben cada capítulo pode considerarse 
independente dos demais, a dificultade dos temas é crecente a medida

 que se
 

avanza, ao igual que o son as utilidades e ferramentas de simulación 
empregadas. Por este motivo, para unha mellor comprensión e  
seguimento das actividades, recoméndase seguilas na orde establecida. 

Todos os capítulos deste manual comparten a mesma estrutura, 
que está formada polos seguintes apartados: 
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• Obxectivos. Neste primeiro apartado defínense cales son os 
principais obxectivos de cada simulación, tendo en conta tanto os 
conceptos teóricos implicados como as funcionalidades do 
software empregadas. 

• Fundamentos e descrición do problema. Como complemento aos 
contidos teóricos impartidos nas diferentes materias, neste 
apartado amósase brevemente a física do problema en estudo, 
expoñendo os fundamentos e os procesos que serán reproducidos 
na simulación numérica. 

• Xeometría. Neste apartado preséntanse as xeometrías propostas 
para a realización das simulacións. Apórtanse todos os datos 
necesarios para que o alumnado poida reproducir e crear a 
xeometría que formará o dominio de cálculo, podendo empregar 
o programa informático que desexe ou que mellor coñeza. 
Nalgúns casos, déixase aberta a elección de certos parámetros 
xeométricos de forma intencionada, co propósito de que sexan 
seleccionados a criterio do alumnado. 

• Mallado. Para poder levar a cabo a creación da malla de cálculo, 
detállanse os parámetros requiridos para a obtención dunha malla 
cunha calidade o suficientemente boa, e que, ao mesmo tempo, 
evite incorrer nun excesivo coste computacional. Inclúense neste 
apartado imaxes da malla que o alumnado deberá obter, e que 
pretenden servir de referencia para un correcto seguimento do 
proceso de creación da mesma. 

• Configuración da simulación. Detállanse neste apartado todos os 
parámetros que o alumnado deberá empregar e axustar no 
programa de simulación, expoñendo unha breve xustificación da 
utilización de cada un deles. Do mesmo xeito, amósase o proceso 
de inicialización, de imposición das condicións de contorno, da 
configuración do solver, así como o progreso e a evolución 
esperada das simulacións. Facilítanse tamén as configuracións e os 
pre-procesos e post-procesos adicionais que poidan empregarse. 

• Análise dos resultados. Neste apartado preséntase unha análise 
crítica dos resultados obtidos en cada unha das simulacións. 
Mediante a comparativa con datos experimentais, ou en base aos 
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fundamentos teóricos de cada caso, avalíanse os resultados 
acadados, valorando as posibles desviacións con respecto a 
situacións reais. 

• Actividades propostas. Neste último apartado especifícanse as 
actividades que o alumnado deberá realizar de xeito autónomo. 
Precísase o tipo de resultados que deberá extraer, así como o 
formato que deberá empregar para entregalos para a súa 
avaliación. 

Requisitos  e  dedicación 

En canto aos requisitos materiais, as actividades propostas neste 
manual foron deseñadas para poder ser levadas a cabo contando cunhas 
esixencias computacionais accesibles para o alumnado. Deste xeito, 
calquera equipo informático que conte polo menos con 512 Megabytes 
de memoria RAM e un procesador igual ou equivalente a un Intel Core 
permitirá realizar nun tempo axeitado os exercicios aquí recollidos. 

Para a realización deste manual empregouse o sistema operativo 
Windows 10, aínda que o usuario poderá seguir o manual sen problemas 
empregando calquera outra versión de Windows ou Linux. 

O software que se empregará é ANSYS. Aínda que as actividades aquí 
mostradas foron realizadas coa versión 2020 R2 deste programa, calquera 
versión igual ou superior á 15.0 poderá ser empregada para poder seguir 
o manual sen maior dificultade. 

Neste manual non se expón de forma detallada o procedemento de 
creación da xeometría nin o de xeración da malla de cálculo, 
outorgándolle liberdade ao usuario para empregar os programas 
informáticos que desexe para levar a cabo estas tarefas. 

Os exercicios que se recollen neste manual foron deseñados para 
poñer en práctica e interactuar cos conceptos teóricos en estudo, a través 
do emprego de programas CFD, sen pretender converterse nunha guía 
completa de uso da interface do software ANSYS. Por isto, é 
recomendable que aqueles usuarios que queiran seguir este manual e non 
conten con ningún coñecemento previo deste programa, realicen algún 
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dos titoriais online dispoñibles sobre o manexo básico da interface deste 
software. 

Contando cuns coñecementos básicos do manexo desta ferramenta 
de simulación e cun equipo informático axeitado, estímase que o 
seguimento de cada un dos capítulos deste manual supón arredor de dúas 
horas de dedicación. Ademais, considérase que a realización das 
actividades propostas ao final de cada capítulo suporá un traballo 
adicional de dúas horas de duración. 

Sistema de unidades 

O sistema de unidades empregado de xeito xeral será o Sistema 
Internacional (SI). Con todo, debido á súa tradición de uso na 
industria, para certas variables poderanse empregar outras unidades, 
como por exemplo os bares para a medida da presión. 

Os valores de cada un dos parámetros empregados nas simulacións 
numéricas estarán dentro do rango comunmente atopado en 
aplicacións industriais, co propósito de guiar ao alumnado no estudo e 
na análise de supostos e situacións semellantes ás reais. 
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Nomenclatura 
 

A Área [m²] 

c Lonxitude da corda [m] 

CD Coeficiente de arrastre [-] 

CL Coeficiente de sustentación [-] 

CM Coeficiente de momento [-] 

CP Coeficiente de presión [-] 

D Diámetro [m] 

F Forza [kg m s-2] 

H Altura [m] 

L Lonxitude [m] 

p Presión [kg m-1 s-2] 

P Potencia [kg m2 s-3] 

Q Caudal volumétrico [m3 s-1] 

�̇  Fluxo másico [kg s-1] 

M Par [kg m² s-2] 

Ma Número de Mach [-] 

n Velocidade de xiro [rpm] 

r Radio [m] 

R Constante dos gases ideais [m2 K-1 s-2] 
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L Lonxitude [m] 

p Presión [kg m-1 s-2] 

P Potencia [kg m2 s-3] 

Q Caudal volumétrico [m3 s-1] 

�̇  Fluxo másico [kg s-1] 

M Par [kg m² s-2] 

Ma Número de Mach [-] 

n Velocidade de xiro [rpm] 

r Radio [m] 

R Constante dos gases ideais [m2 K-1 s-2] 

 

9 
 

Nomenclatura 
 

A Área [m²] 

c Lonxitude da corda [m] 

CD Coeficiente de arrastre [-] 

CL Coeficiente de sustentación [-] 

CM Coeficiente de momento [-] 

CP Coeficiente de presión [-] 

D Diámetro [m] 

F Forza [kg m s-2] 

H Altura [m] 

L Lonxitude [m] 

p Presión [kg m-1 s-2] 

P Potencia [kg m2 s-3] 

Q Caudal volumétrico [m3 s-1] 

�̇  Fluxo másico [kg s-1] 

M Par [kg m² s-2] 

Ma Número de Mach [-] 

n Velocidade de xiro [rpm] 

r Radio [m] 

R Constante dos gases ideais [m2 K-1 s-2] 



 

10 
 

Re Número de Reynolds [-] 

s Carreira [m] 

t Tempo [s] 

T Temperatura [K] 

v Velocidade [m s-1] 

V Volume [m³] 

y+ Distancia adimensional á parede [-] 

z Altura [m] 

   

Símbolos gregos  

 [-]  Ángulo de ataque  ߙ

 [-] Coeficiente de compresibilidade  ߚ

 [-] Coeficiente de irregularidade  ߝ

 [-] Rendemento  ߟ

 [-] Ángulo  ߠ

 Densidade [kg m-3]  ߩ

߶  Diámetro [m] 

߱  Velocidade angular [s-1] 
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1. Coeficientes aerodinámicos de 
xeometrías comúns 
 

1.1. Obxectivos 

Os obxectivos fixados para a realización deste capítulo son os 
seguintes: 

• Cuantificar os coeficientes aerodinámicos de diferentes 
xeometrías aerodinámicas empregando simulacións sinxelas 
bidimensionais (2D). 

• Entender os efectos do réxime de fluxo nos coeficientes de 
arrastre. Para acadar este obxectivo levarase a cabo a estimación 
do efecto do número de Reynolds sobre o coeficiente de arrastre 
dunha xeometría cilíndrica. 

• Amosar a importancia da validación e a verificación empírica dos 
resultados acadados nas simulacións a través da comparativa con 
datos experimentais da literatura. 

• Cuantificar o efecto da forma do obxecto sobre os coeficientes 
aerodinámicos, así como a súa posición relativa con respecto ao 
fluxo. 
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1.2. Fundamentos e descrición do 
problema 

O coeficiente de arrastre é un valor adimensional que permite 
cuantificar a resistencia dun obxecto cando se atopa inmerso nun medio 
fluído, e defínese como [3]: 

�� =
����� �� �������ó� �� ���������

Á��� ������� 1
�ߩ2

2
 (1.1) 

De xeito análogo ao coeficiente de arrastre ou de resistencia, 
calcúlase o coeficiente de sustentación, o cal avalía o empuxe que recibe 
o obxecto na dirección normal ao movemento do fluxo, e que se calcula 
coa expresión [3]: 

�� =
����� �� �������ó� ������ �� ���������

Á��� ������� 1
2 �ߩ

2
 (1.2) 

que no caso dun cilindro, a área frontal será H·D, sendo H a lonxitude do 
cilindro (na dirección transversal ao fluxo) e D o seu diámetro.  

Tal e como amosa a Figura 1.1, o movemento relativo entre o aire e 
o cilindro xera unha forza de arrastre na dirección do fluxo e unha forza 
de sustentación na dirección perpendicular. Estas forzas poden ser 
orixinadas debido ao movemento do aire sobre o obxecto, cando este se 
atopa fixo, ou pola contra, debido ao movemento do obxecto cando se 
despraza en presenza de aire en repouso. 

 
Figura 1.1: Esquema conceptual do arrastre e da sustentación nun 

cilindro. 
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Para coñecer os coeficientes aerodinámicos dun obxecto calquera, é 
necesario analizar o fluxo de aire arredor dese obxecto. E para realizar 
unha boa predición da corrente do fluído, é preciso simular como é ese 
fluxo nas proximidades do obxecto, pero tamén como é o seu 
comportamento antes de chegar a el, e como evoluciona a estela que se 
produce unha vez pasou o obstáculo. Tendo isto en consideración, nos 
casos de estudo de fluxo externo xorde sempre a seguinte cuestión: cal 
debe ser a extensión do dominio a simular? Para despexar esta incógnita, 
neste manual especifícanse cales son as dimensións do dominio de cálculo 
empregado, as cales virán definidas en función das dimensións do 
obxecto que se desexa analizar. 

1.3. Xeometría 

Para a realización desta práctica proponse a análise dos coeficientes 
aerodinámicos de diferentes figuras xeométricas con dimensión D=1 m, 
como as que se recollen na Figura 1.2. Determínase a realización de 
simulacións 2D, polo que as formas xeométricas aparecen representadas 
pola súa sección transversal. Deste xeito, o Caso A representa un cilindro 
de sección circular, o cal ten unha certa profundidade normal ao plano 
do debuxo. 

Para estes casos establécese que o dominio de cálculo está formado 
por unha sección rectangular de 60 m de longo por 20 m de ancho, tal e 
como amosa a  Figura 1.3. Para poder captar as características do fluxo de 
aire augas arriba e augas abaixo do obxecto, a figura xeométrica sitúase a 
20 m da sección de entrada, sendo suficiente esta distancia para poder 
reproducir o comportamento do aire antes e despois do obxecto de 
estudo. 

Posto que se trata de obxectos de forma moi sinxela, recoméndase 
levar a cabo o proceso de creación da xeometría completa dentro da 
plataforma de ANSYS. No caso de que sexa creada en calquera outro 
software, soamente será preciso importala no Workbench de ANSYS, 
podendo pasar a continuación directamente á fase de mallado. 
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Figura 1.2: Figuras xeométricas a simular. 

 

 
Figura 1.3: Dimensións do dominio de cálculo (expresadas en [m]). 
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obxecto en 0.15 m e empregando os valores dos parámetros para CFD 
(Fine) do mallador de ANSYS. Deste xeito, tal e como se observa na Figura 
1.4 para o caso do cilindro de sección circular, a malla está composta por 
elementos cuadriláteros (quads), os cales se atopan, en gran medida, 
orientados no sentido do fluxo de aire. Para captar os fenómenos do fluxo 
na rexión próxima ás paredes do obxecto, onde se producen maiores 
gradientes de velocidade, deberanse crear dez capas de elementos 
prismáticos empregando a ferramenta inflaction do mallador, tal e como 
se recolle na imaxe en detalle da Figura 1.4. 

Para levar a cabo a creación da malla das restantes figuras 
xeométricas seguirase o mesmo proceso. 
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1.5. Configuración da simulación 

A continuación detállanse os pasos a seguir para levar a cabo a 
configuración das simulacións. 

Abrir o programa Fluent 

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 1.5). 

 
Figura 1.5: Ventá de configuración de Fluent Launcher. 

Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
fin de aumentar a precisión do solver. Con esta opción cada número 
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decimal pasa a estar representado por 64 bits, en lugar dos 32 bits que se 
empregan nun solver de simple precisión e, ademais, aumenta o rango 
máximo e mínimo que poden alcanzar as variables que se van representar, 
aínda que isto require de máis memoria para poder ser executado. A 
continuación debe escollerse como directorio de traballo unha carpeta 
que fose creada previamente (Working Directory) e logo facer clic en Start. 

Importar/abrir a malla 

File > Read > Mesh 

Deberase empregar o explorador de arquivos para acceder dentro do 
directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa reporta na 
consola de comandos información básica sobre as características da 
mesma. Debe verificarse que o número de nodos, caras e celas se 
corresponde cos da malla que se desexa empregar. 

Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale): 

Setting Up Domain > Mesh > Scale... 

Setup > General > Mesh > Scale... 

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta. 

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado: 

Setting Up Domain > Mesh > Check 
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Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Pola contra, se o software detecta posibles fallos, amosará 
unha ventá emerxente na que se reporta o erro. É importante detectar os 
problemas da malla dende o primeiro intre, pois evitarase perder tempo 
innecesariamente na configuración dunha simulación que, por culpa da 
malla, non vai poder ser levada a cabo.  

Deberase comprobar tamén o tamaño da malla de cálculo: 

Domain > Mesh > Info > Size 

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas, tal e como amosa a Figura 1.6. 

 
Figura 1.6: Información da malla mostrada na consola de comandos. 

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla: 

Domain > Mesh > Display… 

Este comando mostrará na pantalla a ventá de visualización das 
diferentes partes da malla, permitindo visualizalas, tal e como se aprecia 
na Figura 1.7. 

 
Figura 1.7: Visualización da malla. 
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É importante identificar inequivocamente as diferentes rexións que 
compoñen o dominio, nas cales posteriormente se impoñerán as 
condicións de contorno. 

As opcións de visualización máis importantes dentro da ventá de 
visualización son: 

• Translación: a xeometría pode moverse en calquera dirección 
mantendo pulsado o botón esquerdo do rato e desprazándoo na 
dirección desexada. 

• Zoom: facendo uso da roda do rato poderase acercar ou afastar a 
imaxe. Poderase tamén utilizar a ferramenta de lupa, situada na 
marxe inferior da ventá de visualización. Neste caso será preciso 
marcar co rato o recadro sobre o que se fará zoom.  

Mediante estas operacións de visualización poderase obter unha vista 
detallada de todas as rexións da malla, podendo identificar cada unha das 
entidades que a forman. Para facilitar a navegación pola malla, poderanse 
ocultar ou visualizar as partes que se desexen, seleccionando ou 
deseleccionando, respectivamente, cada unha das entidades no apartado 
Surfaces do panel Mesh > Display…, e facendo clic posteriormente no botón 
Display.  

As ventás emerxentes, como a de visualización, poden pecharse sen 
risco de perder información, podendo reabrilas no momento que se 
precisen. 

Definición do solver 

Setup > General 

Neste caso manteranse as opcións que por defecto selecciona o 
programa: Pressure-Based no apartado Type, Absolute no cadro de Velocity 
Formulation, Steady na sección de Time e Planar no apartado de 2D Space, 
tal e como recolle a Figura 1.8. 
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Figura 1.8: Configuración xeral do solver. 

Propiedades dos fluídos 

Setup > Materials 

O fluído de traballo é o aire (air), material que por defecto xa aparece 
recollido na lista de materiais. Manteranse as condicións de densidade e 
viscosidade constantes e cos valores asignados polo programa (Figura 
1.9). 

 
Figura 1.9: Configuración do material aire. 
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Condicións de contorno 

Setup > Boundary Conditions 

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. Independentemente dos 
nomes asignados a cada unha de elas, deberase contar polo menos coas 
seguintes entidades: 

Nome Condición/Tipo 

Entrada Velocity Inlet 

Saída Pressure outlet 

Cilindro Wall (No slip) 

Paredes Symmetry 

Interior Interior 

 Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto. 

Para configurar os parámetros de entrada do fluxo deberase acceder 
á entidade Entrada facendo dobre clic sobre o nome, ou ben no botón 
Edit…. No panel de configuración introducirase a velocidade de entrada 
do fluxo, que neste caso será fixada en 0.005 m/s para a simulación do 
fluxo en réxime laminar e de 100 m/s para a simulación do fluxo en 
réxime turbulento (Figura 1.10). 

A configuración do resto de entidades non será necesario cambiala, 
mantendo os valores por defecto asignados polo programa. 

 
Figura 1.10: Panel de configuración da entrada. 
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fluxo en réxime laminar e de 100 m/s para a simulación do fluxo en 
réxime turbulento (Figura 1.10). 
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Figura 1.10: Panel de configuración da entrada. 
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Modelo turbulento 

Setup > Models > Viscous 

No caso de estudo de fluxo laminar seleccionarase a opción Laminar. 
No caso de fluxo de maior velocidade, deberase cambiar polo modelo 
turbulento de dúas ecuacións k-omega (SST) (Figura 1.11), o cal 
proporciona boas predicións dos fenómenos do fluxo na rexión da capa 
límite e reproduce de forma axeitada a corrente de aire arredor do 
obxecto [4]. 

 
Figura 1.11: Panel de configuración do modelo turbulento. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. Neste caso, por tratarse do estudo de fluxos 
externos, interesa inicializar todo o dominio de cálculo cos mesmos 
valores que foron asignados na condición de contorno da entrada. 

Configuración da simulación  
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Solution > Initialization > Standard Initialization 

Dentro da opción de inicialización estándar (Standard Initialization) 
deberase escoller a entidade da entrada dentro do despregable do  campo 
Compute from (Figura 1.12). Deste xeito, a velocidade do fluxo que foi 
seleccionada para a entrada será imposta en todo o dominio fluído, a cal 
estará máis próxima á solución final que unha velocidade nula en toda a 
rexión. Para executar a inicialización deberá premerse no botón Initialize 
que se atopa na marxe inferior.  

 
Figura 1.12: Panel de inicialización. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
na pantalla un valor do residuo asociado a cada unha das ecuacións de 
goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que os valores do residuo se sitúen por debaixo do valor 
limiar de 10-3. 
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Solution > Monitors > Residual 

Por defecto, o valor asignado para o campo Convergence Absolute 
Criterion, tanto para a ecuación de continuidade (continuity) como para as 
compoñentes da ecuación de momento e para os parámetros turbulentos 
empregados, é de 0.001, polo que manteremos este valor. 

No caso de que non se quixese empregar ningún criterio de 
converxencia asociado ao valor dos residuais, deberíase seleccionar a 
opción none no despregable do campo (Convergence Criterion), e para 
poder acceder a esta opción é preciso ter seleccionada a opción Show 
Advanced Options.   

Deberase asegurar que se atopan marcadas as opcións Print to Console 
e Plot no cadro Options (Figura 1.13). Desta forma o programa mostrará 
os valores na consola de comandos a medida que avanza o proceso 
iterativo e visualizará a gráfica da evolución dos residuais durante o 
cálculo. Para aceptar a configuración faga clic en OK. 

   
Figura 1.13: Configuración dos residuais. 

Ademais da configuración dos criterios de converxencia dos 
residuais, é fundamental avaliar para este caso a evolución do coeficiente 
de arrastre (CD) a medida que avanza o proceso iterativo. Deste xeito 
poderase analizar o cambio no valor do coeficiente, podendo determinar 
en que momento se alcanza a súa converxencia. 

Configuración da simulación  
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Solution > Monitors > Report Plots 

Facendo clic en New abrirase unha ventá emerxente na que, baixo o 
apartado Selected Report Definitions, deberá facerse clic en New e 
seleccionar Force Report > Drag... para crear un novo monitor de 
coeficiente de arrastre, tal e como indican os paneis de configuración da 
Figura 1.14. Unha vez creado o monitor, este aparecerá no apartado 
Available Report Definitions da ventá Report Definitions, onde deberá ser 
seleccionado e engadido ao apartado Selected Report Definitions facendo 
clic no botón Add>>. 

 
Figura 1.14: Paneis de configuración do monitor do coeficiente de 

arrastre. 

Para levar a cabo o cálculo deste coeficiente, o programa calculará as 
forzas que se producen sobre o obxecto derivadas do campo de 
velocidade e de presión do fluxo de aire. Non obstante, será necesario 
indicar a área e a velocidade de referencia, as cales serán empregadas polo 
programa para estimar este coeficiente.  

Setup > Reference values 

Para este caso, introducirase no apartado Area o valor de 1 m², que se 
corresponde coa área transversal do obxecto, e no apartado Velocity 
deberase introducir o valor de 0.005 m/s para o caso da simulación de 
fluxo laminar e 100 m/s para o caso de fluxo turbulento (Figura 1.15). 
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Deberase ter en conta que se nalgún momento se modifican estes valores, 
o programa actualizará o valor do coeficiente de arrastre en base aos 
novos valores de referencia, sen necesidade de calcular novamente a 
solución do fluxo de aire. 

Con este último paso finaliza o proceso de configuración da 
simulación, así como a inicialización e a definición do modelo a resolver. 
Neste intre recoméndase gardar a simulación para non perder o traballo 
de configuración realizado. 

File > Write > Case&Data 

Deberase asignar un nome que identifique inequivocamente o caso 
en cuestión, como por exemplo cilindro_turbulento.cas. Comprobarase que 
efectivamente foron creados dous arquivos con extensión .cas e .dat na 
carpeta de traballo. Se por calquera razón  se pecha o programa, poderase 
recuperar o traballo realizado ata o de agora lendo os arquivos 
cilindro_turbulento.cas e cilindro_turbulento.dat. 

 
Figura 1.15: Configuración dos valores de referencia. 

Proceso iterativo 

Deberase fixar o número de iteracións que se levarán a cabo na etapa 
de cálculo. 

Configuración da simulación  
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Solution > Run Calculation 

No apartado Number of Iterations deberase introducir o valor 2000, e 
a continuación, facer clic no botón Calculate. Isto dará comezo ao cálculo 
iterativo. 

Pode que durante o proceso de cálculo o software se deteña e amose 
unha ventá emerxente na que se indique que o cálculo foi completado 
(Calculation complete), debido a que se cumpriron os parámetros de 
converxencia fixados para os residuais (Solution is converged). Neste intre 
a evolución da gráfica dos residuais e do coeficiente de arrastre deberá 
ser similar á amosada na Figura 1.16. Neste primeiro caso recoméndase 
volver á configuración dos residuais e desactivar a opción do criterio de 
converxencia e volver activar de novo o proceso de cálculo iterativo. Deste 
xeito poderase ver de forma máis clara a evolución dos residuais e do 
coeficiente de arrastre. 

 
Figura 1.16: Evolución dos residuais (a) e do coeficiente de arrastre (b). 

Deberase asegurar unha correcta converxencia das simulacións 
atendendo ao nivel dos residuais e tamén facendo especial seguimento da 
estabilidade do monitor do coeficiente de arrastre que foi creado. 
Namentres non se acade a estabilidade de ambos criterios non se poderá 

a)

b)
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dar for finalizado o cálculo. 

Unha vez finalizado o proceso iterativo, asegurando que a solución 
alcanzada está completamente converxida, procederase a gardar o caso 
final. 

File > Write > Case&Data 

Deberase ter especial coidado de non sobrescribir os arquivos 
gardados previamente. Para elo, aconsellase empregar un nome distinto 
que permita diferenciar o caso final. Deberá verificarse de novo que 
ambos arquivos foron gardados no directorio de traballo. 

1.6. Análise dos resultados 

A análise dos resultados obtidos nas diferentes simulacións levarase a 
cabo do seguinte xeito: 

• Estimación do coeficiente de arrastre (CD) dun cilindro de 
sección circular para dous número de Reynolds diferentes, 
empregando dúas velocidades diferentes do fluxo de aire. Deste 
xeito avaliarase como o software Fluent é capaz de resolver fluxos 
laminares e turbulentos cun nivel de precisión axeitado. 

• Comparativa dos resultados obtidos nas simulacións numéricas 
fronte a datos empíricos do valor do coeficiente de arrastre 
recollidos en estudos experimentais. Para poder realizar este 
apartado facilítanse dúas representacións gráficas do valor deste 
coeficiente para diferentes números de Reynolds, tal e como 
mostra a Figura 1.17. Esta verificación dos resultados repetirase 
noutros capítulos, pero é de especial importancia neste primeiro, 
pois é preciso remarcar a necesidade de avaliar os resultados 
cando non se é un experto no manexo do software de simulación. 
Con isto quérese subliñar que esta verificación é unha tarefa 
fundamental cando non se ten experiencia previa ou os 
coñecementos suficientes do problema físico simulado, e que 
permitirá detectar posibles erros que se puideran cometer 
durante o proceso de configuración da simulación. 
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Figura 1.17: Resultados experimentais dos coeficientes de arrastre fronte 

ao número de Reynolds [5]. 

Expóñense a continuación os pasos a seguir para levar a cabo o post-
proceso e a extracción dos resultados: 

• Obtención do coeficiente de arrastre. Para isto poderase tomar o 
valor deste coeficiente amosado na consola de comandos ou 
poderase extraer no apartado Results > Reports > Forces, 
seleccionando a superficie sobre a que se desexa obter este 
coeficiente (Figura 1.18). 

• Gráfica de contornos de presión estática. No apartado Results > 
Graphics > Contours, deberase escoller a variable que se desexa 
visualizar no cadro Contours of, e seguidamente farase clic no 
botón Display, asegurando previamente que a opción Filled está 
activada. Deberase obter unha imaxe similar á da Figura 1.21. 
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dar for finalizado o cálculo. 

Unha vez finalizado o proceso iterativo, asegurando que a solución 
alcanzada está completamente converxida, procederase a gardar o caso 
final. 

File > Write > Case&Data 

Deberase ter especial coidado de non sobrescribir os arquivos 
gardados previamente. Para elo, aconsellase empregar un nome distinto 
que permita diferenciar o caso final. Deberá verificarse de novo que 
ambos arquivos foron gardados no directorio de traballo. 

1.6. Análise dos resultados 

A análise dos resultados obtidos nas diferentes simulacións levarase a 
cabo do seguinte xeito: 

• Estimación do coeficiente de arrastre (CD) dun cilindro de 
sección circular para dous número de Reynolds diferentes, 
empregando dúas velocidades diferentes do fluxo de aire. Deste 
xeito avaliarase como o software Fluent é capaz de resolver fluxos 
laminares e turbulentos cun nivel de precisión axeitado. 

• Comparativa dos resultados obtidos nas simulacións numéricas 
fronte a datos empíricos do valor do coeficiente de arrastre 
recollidos en estudos experimentais. Para poder realizar este 
apartado facilítanse dúas representacións gráficas do valor deste 
coeficiente para diferentes números de Reynolds, tal e como 
mostra a Figura 1.17. Esta verificación dos resultados repetirase 
noutros capítulos, pero é de especial importancia neste primeiro, 
pois é preciso remarcar a necesidade de avaliar os resultados 
cando non se é un experto no manexo do software de simulación. 
Con isto quérese subliñar que esta verificación é unha tarefa 
fundamental cando non se ten experiencia previa ou os 
coñecementos suficientes do problema físico simulado, e que 
permitirá detectar posibles erros que se puideran cometer 
durante o proceso de configuración da simulación. 
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Figura 1.17: Resultados experimentais dos coeficientes de arrastre fronte 

ao número de Reynolds [5]. 

Expóñense a continuación os pasos a seguir para levar a cabo o post-
proceso e a extracción dos resultados: 

• Obtención do coeficiente de arrastre. Para isto poderase tomar o 
valor deste coeficiente amosado na consola de comandos ou 
poderase extraer no apartado Results > Reports > Forces, 
seleccionando a superficie sobre a que se desexa obter este 
coeficiente (Figura 1.18). 

• Gráfica de contornos de presión estática. No apartado Results > 
Graphics > Contours, deberase escoller a variable que se desexa 
visualizar no cadro Contours of, e seguidamente farase clic no 
botón Display, asegurando previamente que a opción Filled está 
activada. Deberase obter unha imaxe similar á da Figura 1.21. 
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Figura 1.18: Cadro de obtención do coeficiente de arrastre. 

• Gráfica de contornos de velocidade. Será preciso repetir o proceso 
anterior, pero neste caso seleccionando a variable de velocidade 
(Figura 1.19). 

• Gráfica de vectores de velocidade. No apartado Results > Graphics 
> Vectors deberase escoller a variable velocidade, tal e como se 
exemplifica na Figura 1.20. Axustando os parámetros da escala 
poderase obter unha imaxe semellante á mostrada na Figura 1.21. 

 
Figura 1.19: Cadro para a visualización dos contornos de velocidade. 
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Figura 1.20: Cadro para a visualización dos vectores de velocidade. 

 
Figura 1.21: Exemplo das imaxes de contornos e vectores obtidas para o 
caso do cilindro circular, mostradas intencionadamente sen valores nin 

escala. 

a) Contornos de velocidade [m/s]

b) Contornos de presión [Pa]

c) Vectores de velocidade [m/s]
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1.7. Actividades propostas 

Empregando as mesmas condicións de contorno e configuración 
expostas para o caso de fluxo turbulento (velocidade do aire de 100 m/s 
na entrada da sección de estudo), deberase repetir o proceso de 
simulación para as restantes formas xeométricas presentadas na Figura 
1.2. 

Para a avaliación das actividades deste capítulo deberase crear un 
informe no que se recollan de forma detallada os resultados obtidos para 
cada unha das figuras xeométricas estudadas, incluíndo os datos 
numéricos e as imaxes extraídas de cada unha delas. 

Ademais, deberase incluír no informe a análise comparativa dos 
resultados obtidos nas diferentes simulacións en base aos obxectivos 
fixados. Deste xeito, deberase analizar o efecto observado para diferentes 
relacións dos parámetros L e D das figuras empregadas, así como o estudo 
do efecto producido polo cambio de orientación da sección triangular. 
Deberase complementar esta comparativa empregando os coñecementos 
teóricos da materia, e engadirase un último apartado no que se recollan 
as conclusións extraídas deste estudo. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. 

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia.
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2. Simulación da aerodinámica 
dun perfil NACA-0012 

2.1. Obxectivos 

Os obxectivos fixados para a realización deste capítulo son os 
seguintes: 

• Realizar a simulación bidimensional dun perfil de á (airfoil), para 
o caso particular do perfil NACA-0012. 

• Validar os resultados numéricos fronte a datos experimentais 
publicados [6], empregando para a comparación os coeficientes 
de arrastres (CD), de sustentación (CL), e a distribución de 
coeficientes de presión (CP) sobre as dúas caras do perfil. 

• Analizar en detalle os resultados da simulación, localizando o 
punto de desprendemento do fluxo. 

• Realizar un refinado da malla empregada e levar a cabo unha nova 
simulación para avaliar o seu efecto nos resultados obtidos. 

2.2. Fundamentos e descrición do 
problema 

O cálculo dos coeficientes aerodinámicos do perfil de á segue os 
mesmos fundamentos que os casos de estudo levados a cabo no capítulo 
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anterior. A maior diferencia no cálculo dos coeficientes aerodinámicos é 
a área de referencia a empregar, que no caso dos perfís de á se emprega 
a área de planta, polo que, por exemplo, a ecuación de cálculo do 
coeficiente de sustentación será da forma: 

�� =
����� �� �������ó� �� ���������

Á��� �� ������ 1
2 �ߩ

2
 (2.1) 

Ademais, nos perfís de á aparece a maiores o efecto do ángulo de 
ataque, que virá definido pola posición do perfil con respecto á dirección 
do fluxo de aire. Dependendo do ángulo de ataque no que se atope 
situado o perfil, variará o fluxo de aire arredor da á, tal e como 
exemplifica a Figura 2.1,  afectando notablemente tanto ao arrastre como 
á sustentación da mesma. 

 
Figura 2.1: Esquema conceptual do fluxo arredor dun perfil de á para 

dous ángulos de ataque distintos. 

O ángulo de ataque do perfil de á é, xunto coa súa xeometría, un dos 
parámetros fundamentais que definen o seu comportamento 
aerodinámico. Se este ángulo supera un determinado valor, o cal virá 
determinado pola configuración xeométrica do perfil e do número de 
Reynolds do fluxo, o perfil pode entrar en perda (stall), o que significa 
que a forza de sustentación que o fluxo xera sobre o dispositivo decae 
subitamente e, pola contra, aumenta de forma notable a forza de arrastre. 
Esta situación é, polo xeral, negativa e debe coñecerse o rango de 
condicións de operación onde pode aparecer para tentar evitala [7]. 

A NACA (National Advisory Committe for Aeronoutics, Comité 
Conselleiro Nacional para a Aeronáutica), axencia precursora de estudos 

Xeometría  
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de investigación aeronáuticos da actual NASA (National Aeronautics and 
Space Administration, Administración Nacional da Aeronáutica e do 
Espazo) emprega unha denominación codificada para os perfís 
aerodinámicos, a cal é utilizada en multitude de aplicacións. 

O perfil de á NACA-0012, que será o empregado neste caso, é un dos 
perfís máis estudados en investigacións experimentais e numéricas [8, 9], 
que conta con máis de mil artigos científicos con resultados experimentais 
dentro do servizo da NASA Technical Report.  

Para levar a cabo a validación dos resultados que se obterán na 
simulación numérica, empregarase o perfil NACA-0012 exposto a un 
fluxo cun número de Mach �� = 0.7, e con un ángulo de ataque ߙ =
1.55°. Os datos experimentais serán extraídos das medicións realizadas 
pola NASA no artigo “Two-Dimensional Aerodynamic Characteristics of the 
NACA-0012 Airfoil in the Langley 8-foot Transonic Pressure Tunnel” [6], onde 
se expón que para estas condicións de funcionamento o coeficiente de 
arrastre toma un valor de CD=0.0079, e o coeficiente de sustentación é de 
CL=0.241. Do mesmo xeito, os valores para o coeficiente de presión en 
cada un dos puntos da xeometría do perfil serán extraídos do mesmo 
artigo. 

2.3. Xeometría 

Posto que neste capítulo se empregará unha única xeometría 
correspondente ao perfil de á NACA-0012, o primeiro paso para a 
construción do dominio de cálculo será a creación do perfil. Para levar a 
cabo esta tarefa poderase acudir a diferentes manuais ou recursos na 
internet que permiten descargar perfís de á coma este, podendo 
reconstruír a xeometría en base a unha series de puntos, tal e como se 
aprecia na Figura 2.2, onde se expoñen as coordenadas para a 
reconstrución da cara superior do perfil. Posto que se trata dun perfil de 
á simétrico, estes puntos poderán ser extrapolados para a cara inferior. 
Mediante o emprego dun software de deseño CAD, poderanse definir 
estes puntos e realizar unha unión suave entre eles, reproducindo así a 
xeometría do perfil. Deberase diferenciar na xeometría a cara superior e 
a cara inferior do perfil, co fin de poder analizar posteriormente os seus 
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arrastre toma un valor de CD=0.0079, e o coeficiente de sustentación é de 
CL=0.241. Do mesmo xeito, os valores para o coeficiente de presión en 
cada un dos puntos da xeometría do perfil serán extraídos do mesmo 
artigo. 

2.3. Xeometría 

Posto que neste capítulo se empregará unha única xeometría 
correspondente ao perfil de á NACA-0012, o primeiro paso para a 
construción do dominio de cálculo será a creación do perfil. Para levar a 
cabo esta tarefa poderase acudir a diferentes manuais ou recursos na 
internet que permiten descargar perfís de á coma este, podendo 
reconstruír a xeometría en base a unha series de puntos, tal e como se 
aprecia na Figura 2.2, onde se expoñen as coordenadas para a 
reconstrución da cara superior do perfil. Posto que se trata dun perfil de 
á simétrico, estes puntos poderán ser extrapolados para a cara inferior. 
Mediante o emprego dun software de deseño CAD, poderanse definir 
estes puntos e realizar unha unión suave entre eles, reproducindo así a 
xeometría do perfil. Deberase diferenciar na xeometría a cara superior e 
a cara inferior do perfil, co fin de poder analizar posteriormente os seus 
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resultados por separado. 

A dimensión da corda do perfil empregado establécese en 1 m. Non 
obstante, déixase á decisión do usuario empregar outro valor para este 
parámetro se así o considera oportuno. 

  
x y  x y  x y  x y 

1.000000 0.001260  0.648751 0.041440  0.278033 0.059903  0.015371 0.020871 

0.992704 0.002274  0.630004 0.043098  0.259997 0.059634  0.012012 0.018579 

0.979641 0.004079  0.611266 0.044701  0.242060 0.059191  0.009117 0.016316 

0.964244 0.006169  0.592538 0.046245  0.224236 0.058562  0.006653 0.014058 

0.947231 0.008434  0.573821 0.047728  0.206544 0.057773  0.004621 0.011797 

0.929323 0.010765  0.555117 0.049149  0.189011 0.056692  0.003007 0.009544 

0.910956 0.013101  0.536430 0.050503  0.171676 0.055421  0.001777 0.007318 

0.892372 0.015420  0.517763 0.051786  0.154596 0.053909  0.000894 0.005155 

0.873723 0.017700  0.499117 0.052996  0.137852 0.052138  0.000322 0.003059 

0.855041 0.019931  0.480488 0.054127  0.121548 0.050098  0.000036 0.001014 

0.836311 0.022119  0.461875 0.055178  0.105827 0.047785  0.000036 -0.001014 

0.817558 0.024266  0.443287 0.056144  0.090903 0.045220  0.000322 -0.003059 

0.798819 0.026366  0.424740 0.057019  0.077039 0.042449  0.000894 -0.005155 

0.780088 0.028414  0.406241 0.057796  0.064541 0.039548  0.001777 -0.007318 

0.761336 0.030413  0.387789 0.058466  0.053594 0.036612  0.003007 -0.009544 

0.742560 0.032370  0.369372 0.059023  0.044211 0.033717    

0.723780 0.034284  0.350989 0.059462  0.036254 0.030913    

0.705012 0.036149  0.332648 0.059779  0.029567 0.028218    

0.686255 0.037964  0.314366 0.059965  0.023982 0.025653    

0.667502 0.039728  0.296159 0.060009  0.019310 0.023217    

Figura 2.2: Esquema e coordenadas para a construción por puntos do 
perfil NACA-0012. 

A forma e as dimensións do dominio de aire que se empregará neste 
caso amósase na Figura 2.3, onde o perfil de á se atopa aumentado para 
poder visualizalo mellor. O fluxo de aire accederá ao interior do dominio 
a través da parábola externa e sairá pola zona recta situada augas abaixo 
do perfil. Esta configuración xeométrica do contorno do dominio 
permitirá simular diferentes ángulos de ataque mediante a variación da 
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dirección do aire que accede á rexión de estudo, sen necesidade de crear 
novas xeometrías para cada unha das inclinacións que se desexen 
analizar. 

Posto que neste caso se pretende realizar unha validación 
experimental dos resultados numéricos, empregaranse unhas dimensións 
do dominio o suficientemente grandes, atendendo a requirimentos de 
simulación máis esixentes.  

 
Figura 2.3: Dimensións e forma do dominio a simular (expresadas en 

función da lonxitude da corda do perfil). O perfil de á atopase 
aumentado para poder visualizalo mellor. 

2.4. Mallado 

A malla xerada para levar a cabo esta simulación deberá ser 
totalmente estruturada, cunha calidade suficiente que asegure a 
obtención de bos resultados, atendendo ás esixencias dos obxectivos 
fixados. 

Na Figura 2.4 amósanse diferentes vistas en detalle onde se aprecian 
os elementos que forma parte desta malla. O tamaño de cela empregado 
na superficie da á é variable en función da curvatura do perfil, 
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encontrándose dentro do rango fixado entre os 2 mm e os 20 mm. A 
altura da primeira cela prismática situada sobre a parede do perfil é de 
0.01 mm. As seguintes capas de celas serán de tamaño crecente, 
asegurando que nos primeiros 0.5 mm a carón da parede existan polo 
menos vinte celas prismáticas. O tamaño máximo de cela na rexión máis 
afastada deberá fixarse en 2c, sendo para este caso de 2 m. Seguindo estas 
indicacións e criterios de tamaños, a malla final resultante deberá contar 
con entre 35000 e 40000 celas. 

Deberá asegurarse que o superficie superior e a superficie inferior do 
perfil se atopan separadas en dúas entidades diferenciadas, co fin de 
poder extraer posteriormente os resultados de cada unha delas de xeito 
separado. 

Esta será a única malla que se empregará para a realización deste 
estudo, polo que é aconsellable realizar unha elaboración coidadosa da 
mesma, prestando especial atención aos parámetros empregados, co fin 
de obter unha malla cunha calidade alta que permita obter resultados que 
poidan ser validados fronte a datos experimentais. 

Posteriormente, empregando o propio software Fluent, propoñerase 
o refinamento dunha parte deste dominio, polo que non será preciso 
empregar de novo ningún programa de mallado. 

  

 
Figura 2.4: Detalles da malla empregada. 
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2.5. Configuración da simulación 

Abrir o programa Fluent  

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 2.5).  

 
Figura 2.5: Ventá de configuración de Fluent Launcher. 

Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
fin de aumentar a precisión do solver. A continuación debe escollerse 
como directorio de traballo unha carpeta que fose creada previamente 
(Working Directory) e logo facer clic en Start. 
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Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 2.5).  

 
Figura 2.5: Ventá de configuración de Fluent Launcher. 

Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
fin de aumentar a precisión do solver. A continuación debe escollerse 
como directorio de traballo unha carpeta que fose creada previamente 
(Working Directory) e logo facer clic en Start. 
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Importar/abrir a malla  

File > Read > Mesh  

Deberase empregar o explorador de arquivos para acceder dentro do 
directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa amosa na 
consola de comandos información básica sobre as características da 
mesma. Debe verificarse que o número de nodos, caras e celas se 
corresponde cos da malla que se desexa empregar. Deberase comprobar 
que aparecen as entidades nas que se impoñerán as condicións de 
contorno. Neste caso deberase contar con catro entidades: unha entidade 
para cada unha das dúas superficies que compoñen o perfil da á, unha 
entidade para a fronteira exterior do dominio e outra entidade 
correspondente coas celas interiores de aire. 

Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale):  

Setting Up Domain > Mesh > Scale...  

Setup > General > Mesh > Scale...  

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta.  

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado:  

Setting Up Domain > Mesh > Check  

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Pola contra, se o software detecta posibles fallos, amosará 
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unha ventá emerxente na que se reporta o erro. Neste caso é posible que 
trala execución deste comando apareza na consola de comandos unha 
mensaxe de advertencia informando de existencia de elementos con alta 
relación de aspecto. É probable que ditos elementos se atopen na rexión 
situada a carón das superficies que compoñen o perfil, onde os elementos 
prismáticos teñen unha altura pequena en relación coa súa lonxitude. 
Non obstante, se o usuario ten localizados ditos elementos e está 
xustificada a súa presencia, poderase seguir co proceso de configuración 
da simulación sen facer ningún cambio na malla. 

Para poder xustificar a alta relación de aspecto obtida para estes 
elementos deberase comprobar que a altura das primeiras celas pegadas 
ao perfil da á é a desexada. Para poder acceder a este parámetro é 
necesario inicializar a simulación e, posto que non ten ningún tipo de 
interese para o cálculo que se realizará posteriormente, xa que aínda non 
se impuxeron as condicións de contorno, poderase empregar calquera 
dos métodos de inicialización dispoñibles. Unha vez inicializado o caso, 
poderase verificar que a altura das celas situadas en contacto coa 
superficie do perfil se atopa dentro do rango adecuado para o modelo 
turbulento que se vai empregar, é dicir, cun parámetro de �+ por debaixo 
de 4, o que se corresponde para as condicións fixadas cunha distancia á 
parede en torno a 5·10-6 m. 

Para comprobar este parámetro deberase acceder dende a árbore de 
comandos ao apartado Results > Graphics > Contours. Na ventá que 
aparecerá na pantalla deberase escoller a variable Mesh no despregable 
da sección Contours of, e no despregable inferior seleccionarase a variable 
Cell Wall Distance. Asegurándose que a opción Filled situada na marxe 
esquerda deste panel se atopa activada, deberase facer clic no botón 
Compute. Sen necesidade de visualizar a imaxe poderase comprobar o 
valor mínimo e máximo desta variable, que para o caso da malla creada 
cos parámetros anteriormente expostos se atopa no rango de 8.2·10-7 a 
7.1·10-6 m. Deste xeito quedará comprobada a idoneidade destes 
elementos con alta relación de aspecto nas proximidades das paredes do 
perfil, posto que a súa altura se atopa próxima á requirida para este 
estudo. 

Deberase comprobar tamén o tamaño da malla de cálculo:  
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Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas.  

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla a ventá de visualización das 
diferentes partes da malla, permitindo visualizalas, tal e como se aprecia 
na  Figura 2.6.  

 
Figura 2.6: Visualización da malla. 

É importante identificar inequivocamente as diferentes rexións que 
compoñen o dominio, nas cales posteriormente se impoñerán as 
condicións de contorno. Para facilitar o manexo e o recoñecemento das 
diferentes partes da malla, poderanse ocultar e amosar as rexións que se 
desexen, seleccionando ou deseleccionando as entidades no apartado 
Surfaces e posteriormente facendo clic no botón Display. 
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Definición do solver e dos modelos 

Setup > General 

Neste caso modificarase o tipo de solver a Density-Based, namentres 
que se manteñen o resto das opcións que por defecto selecciona o 
programa: Absolute no cadro de Velocity Formulation, Steady na sección de 
Time e Planar no apartado de 2D Space, tal e como recolle a Figura 2.7. 

 
Figura 2.7: Configuración xeral do solver e dos modelos activados. 

Ademais, deberase activar a resolución da ecuación da enerxía 
(Figura 2.7): 

Setup > Models > Energy 

De xeito análogo, deberá seleccionarse o modelo turbulento de dúas 
ecuacións k-omega (SST) (Figura 2.7): 

Setup > Models > Viscous 

Propiedades dos fluídos  

Setup > Materials  
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O fluído de traballo é o aire (air), material que por defecto xa aparece 
recollido na lista de materiais. Neste caso modelarase a densidade do aire 
empregando a ecuación dos gases ideais e o modelo de Sutherland de 3 
coeficientes para a estimación da viscosidade, tal e como mostra a Figura 
2.8. 

 
Figura 2.8: Configuración do material aire. 

Condicións de operación  

Setup > Boundary Conditions > Operating Conditions...  

Neste caso fixarase como presión de operación 0 Pa. 

Posto que a presión absoluta é a suma da presión de operación e a 
presión manométrica, e en fluxos compresibles como o que estamos 
analizando o solver emprega os valores da presión absoluta, recoméndase 
poñer este valor a 0. Deste xeito poderase fixar o valor da presión absoluta 
en cada rexión do dominio e evitarase cometer erros nas tarefas de 
configuración. 

Condicións de contorno 

Setup > Boundary Conditions 

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. Independentemente dos 
nomes asignados a cada unha de elas, deberase contar polo menos coas 
seguintes entidades: 
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Nome Condición/Tipo 

Perfil_superior Wall (No slip) 

Perfil_inferior Wall (No slip) 

Far_field Pressure-far-field 

Interior Interior 

Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto. Para este caso 
manteranse todos os parámetros asignados por defecto para cada unha 
das entidades, agás na rexión afastada do perfil, identificada con nome 
Far_Field, onde se impoñerá a presión a 73048 Pa, o número de Mach a 
0.7 e as compoñentes x e y da dirección do fluxo serán as correspondentes 
co ángulo de ataque que se empregará para este estudo, ߙ = ݔ) 1.55° =
� ;0.02705=(°1.55)��ݏ = cos(1.55°) = 0.99963), tal e como amosa a 
Figura 2.9. Os parámetros correspondentes coa turbulencia fixaranse en 
1, tanto para a intensidade de turbulencia como para a taxa de 
viscosidade. Na pestana Themal deberase introducir un valor para a 
temperatura de 283.2 K (Figura 2.9). 

 
Figura 2.9: Paneis de configuración das condicións de contorno na 

entidade fal_field. 

Métodos de solución 

Solution > Methods 



  

54 
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que foron creadas na fase de xeración da malla. Independentemente dos 
nomes asignados a cada unha de elas, deberase contar polo menos coas 
seguintes entidades: 
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Nome Condición/Tipo 

Perfil_superior Wall (No slip) 

Perfil_inferior Wall (No slip) 

Far_field Pressure-far-field 

Interior Interior 

Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto. Para este caso 
manteranse todos os parámetros asignados por defecto para cada unha 
das entidades, agás na rexión afastada do perfil, identificada con nome 
Far_Field, onde se impoñerá a presión a 73048 Pa, o número de Mach a 
0.7 e as compoñentes x e y da dirección do fluxo serán as correspondentes 
co ángulo de ataque que se empregará para este estudo, ߙ = ݔ) 1.55° =
� ;0.02705=(°1.55)��ݏ = cos(1.55°) = 0.99963), tal e como amosa a 
Figura 2.9. Os parámetros correspondentes coa turbulencia fixaranse en 
1, tanto para a intensidade de turbulencia como para a taxa de 
viscosidade. Na pestana Themal deberase introducir un valor para a 
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Figura 2.9: Paneis de configuración das condicións de contorno na 

entidade far_field. 

Métodos de solución 

Solution > Methods 
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Deberase seleccionar o esquema de discretización Green-Gauss Node 
Based para o gradiente e o esquema Second Order Upwind para a enerxía 
cinética turbulenta e para a taxa de disipación (Figura 2.10). Aínda que 
este esquema de discretización de segundo orde é máis custoso a nivel 
computacional, proporciona resultados máis preciso para o cálculo de 
fluxos compresibles como o que estamos a tratar. 

 
Figura 2.10: Panel de configuración dos métodos de solución 

empregados. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. Neste caso, por tratarse do estudo de fluxos 
externos, interesa inicializar todo o dominio de cálculo cos mesmos 
valores que foron asignados na condición de contorno da entrada. 

Solution > Initialization > Standard Initialization 

Dentro da opción de inicialización estándar (Standard Initialization) 
deberase escoller a entidade Far_field dentro do menú despregable do 
apartado Compute from (Figura 2.11). Deste xeito, as condicións fixadas 
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para esta rexión serán impostas en todo o dominio fluído. Para executar 
a inicialización deberá premerse no botón Initialize que se atopa na marxe 
inferior.  

 
Figura 2.11: Panel de inicialización. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
na pantalla un valor do residuo asociado a cada unha das ecuacións de 
goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que o usuario decida que os valores dos residuos son 
suficientemente baixos e estables. 

Solution > Monitors > Residual 

Deberase desactivar o criterio de converxencia (Convergence 
Criterion) seleccionando none no despregable, e para poder acceder a esta 
opción é preciso ter seleccionada a opción Show Advanced Options. 
Deberase asegurar que se atopan marcadas as opcións Print to Console e 
Plot no cadro Options (Figura 2.12). Desta forma o programa mostrará os 
valores na consola de comandos a medida que avanza o proceso iterativo 
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e visualizará a gráfica da evolución dos residuais durante o cálculo. Para 
aceptar a configuración faga clic en OK. 

 
Figura 2.12: Configuración dos residuais. 

Ademais da configuración xeral de converxencia dos residuais, para 
este estudo é fundamental avaliar a evolución do coeficiente 
aerodinámico de arrastre (CD), e do coeficiente de sustentación (CL), xa 
que son as principais variables de estudo que se están a analizar. Polo 
tanto, deberase determinar a evolución destes parámetros de xeito 
independente ao que lle ocorra aos residuais.  

Solution > Monitors > Report Plots 

Facendo clic en New abrirase unha ventá emerxente na que, baixo o 
apartado Selected Report Definitions, deberá facerse clic en New e 
seleccionar Force Report > Drag... para crear un novo monitor de 
coeficiente de arrastre, tal e como indican os paneis de configuración da 
Figura 2.13. Deberase seleccionar a entidade sobre a que se desexa avaliar 
o coeficiente, que neste caso son a superficie superior e a superficie 
inferior do perfil, e deberase ter especial coidado en empregar os vectores 
acorde co ángulo de ataque simulado (Figura 2.13). Unha vez creado o 
monitor, este aparecerá no apartado Available Report Definitions da ventá 
Report Definitions, onde deberá ser seleccionado e engadido ao apartado 
Selected Report Definitions facendo clic no botón Add>>. 

Configuración da simulación  
 

59 
 

 
Figura 2.13: Paneis de configuración dos coeficientes aerodinámicos. 

Procederase do mesmo xeito para crear o monitor para o coeficiente 
de sustentación, prestando de igual xeito especial atención na 
determinación dos vectores acorde co ángulo de ataque que se está a 
estudar. 

Para a selección dos valores de referencia empregaranse os valores 
correspondentes coa rexión afastada e, ademais, empregarase o valor de 
1 m² para a área de referencia, e 1 m para a profundidade e para a 
lonxitude.  

Setup > Reference Values  

Deberanse introducir os valores de referencia mencionados, tal e 
como amosa a Figura 2.14. 

Con este último paso finaliza o proceso de configuración do caso, así 
como a definición do modelo a resolver. Neste intre recoméndase gardar 
a simulación para non perder o traballo de configuración realizado.  

File > Write > Case&Data  

Deberase asignar un nome que identifique inequivocamente o caso 
en cuestión, por exemplo NACA0012_1.55.cas. Comprobarase que 
efectivamente foron creados dous arquivos con extensión .cas e .dat na 
carpeta de traballo. Se por calquera razón se pecha o programa, poderase 
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recuperar o traballo realizado ata o de agora lendo os arquivos 
NACA0012_1.55.cas e NACA0012_1.55.dat. 

 
Figura 2.14: Panel de configuración dos valores de referencia. 

Proceso iterativo 

Solution > Run Calculation  

Deberase seleccionar a opción Transonic no apartado Flow Type e, 
facendo clic no botón More Settings..., deberase modificar o factor de 
relaxación explícito, impoñendo un valor de 0.5 na ventá emerxente que 
aparecerá na pantalla (Figura 2.15). 

No apartado Number of Iterations deberase introducir o valor 1000, e 
a continuación facer clic no botón Calculate. Isto dará comezo ao calculo 
iterativo. Posto que o criterio de converxencia foi desactivado, o software 
levará a cabo as 1000 iteracións, salvo que o usuario decida paralo en vistas 
da evolución dos resultados. O proceso de cálculo poderase frear 
premendo nas teclas Ctr+C ou facendo clic no botón Stop situado na 
marxe inferior dereita do programa. A modo de orientación, a Figura 2.16 
amosa a gráfica da evolución dos residuais para este caso. 
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Figura 2.15: Paneis de configuración do proceso iterativo. 

 
Figura 2.16: Gráfica de evolución dos residuais. 

Unha vez acadada a converxencia procederase a gardar os arquivos 
correspondentes ao caso calculado.  

File > Write > Case&Data  

Deberase ter especial coidado de non sobrescribir os arquivos 
gardados previamente. Para elo, aconsellase empregar un nome distinto 
que permita diferenciar o caso final. Deberá verificarse de novo que 
ambos arquivos foron gardados no directorio de traballo. 

Refinado da malla 

Para verificar se a malla empregada presenta uns parámetros 
axeitados para a análise realizada neste estudo, así como para determinar 
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o efecto que tería sobre os resultados acadados empregar unha malla máis 
fina, procederase a continuación a refinar localmente a malla na rexión 
próxima ao elemento de interese e, posteriormente, calcularase 
novamente o problema. 

Para realizar o refinado local da malla deberase acceder na pestana 
Domain ao apartado Adapt > Refine/Coarsen.... Na ventá emerxente que 
aparecerá na pantalla deberase facer clic no botón Cell Registers e 
seleccionar New > Region.... Deberase facer clic no botón Select Points with 
Mouse e seguidamente procederase a seleccionar co botón dereito do rato 
na ventá de gráficos os dous puntos que definen a diagonal do rectángulo 
que delimitará a rexión sobre a que se aplicará o refinado. Unha vez 
seleccionados os puntos na rexión próxima ao perfil de á, farase clic no 
botón Save, gardando así a rexión anteriormente marcada (Figura 2.17). 
De volta na ventá Adaptation Control deberase seleccionar no panel 
despregable Refinement Criterion a rexión que foi creada, e para executar 
o refinamento da malla farase clic no botón Adapt (Figura 2.17). 

 
Figura 2.17: Parámetros empregados para o refinado da malla e aspecto 

da mesma na rexión modificada. 
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Unha vez realizada a modificación da malla, deberase calcular de 
novo o caso, procedendo da mesma maneira que se fixo anteriormente. 

Unha vez acadada a converxencia procederase a gardar o novo caso, 
do que se deberán extraer os resultados para que poidan ser comparados 
cos obtidos coa malla inicial. Deberá terse coidado de non sobrescribir os 
arquivos da malla previa e de verificar que os novos ficheiros aparecen 
correctamente no directorio de traballo. 

2.6. Análise dos resultados 

Debe asegurarse unha correcta converxencia das simulacións 
realizadas atendendo ao nivel dos residuais e facendo especial seguimento 
da estabilidade e converxencia dos monitores dos coeficientes creados. 
Namentres non se acade a estabilidade de todos eles, non se poderá dar 
por finalizado o proceso de cálculo.  

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Comparar os valores globais dos coeficientes aerodinámicos CD e 
CL cos valores experimentais extraídos do estudo da NASA  [6]. 
Deberase avaliar a capacidade do software Fluent e da 
configuración empregada para a resolución deste problema cun 
nivel de precisión adecuado. 

• Extraer e exportar os valores dos coeficientes de presión na cara 
superior e na cara inferior do perfil. Estes valores deberán ser 
comparados con datos experimentais da NASA [6]. 

• Gráfica de contornos de presión estática. Deberase empregar nos 
dous casos os mesmos valores mínimos e máximos da escala para 
comparar de xeito máis preciso os resultados acadados. Deberase 
obter unha gráfica similar á amosada na Figura 2.18. 

• Gráfica de contornos de número de Mach no rango 0 a 1. 
Deberase obter unha gráfica similar á amosada na Figura 2.18. 

• Gráfica de liñas de corrente e/ou vectores de velocidade de tal 
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o efecto que tería sobre os resultados acadados empregar unha malla máis 
fina, procederase a continuación a refinar localmente a malla na rexión 
próxima ao elemento de interese e, posteriormente, calcularase 
novamente o problema. 

Para realizar o refinado local da malla deberase acceder na pestana 
Domain ao apartado Adapt > Refine/Coarsen.... Na ventá emerxente que 
aparecerá na pantalla deberase facer clic no botón Cell Registers e 
seleccionar New > Region.... Deberase facer clic no botón Select Points with 
Mouse e seguidamente procederase a seleccionar co botón dereito do rato 
na ventá de gráficos os dous puntos que definen a diagonal do rectángulo 
que delimitará a rexión sobre a que se aplicará o refinado. Unha vez 
seleccionados os puntos na rexión próxima ao perfil de á, farase clic no 
botón Save, gardando así a rexión anteriormente marcada (Figura 2.17). 
De volta na ventá Adaptation Control deberase seleccionar no panel 
despregable Refinement Criterion a rexión que foi creada, e para executar 
o refinamento da malla farase clic no botón Adapt (Figura 2.17). 

 
Figura 2.17: Parámetros empregados para o refinado da malla e aspecto 

da mesma na rexión modificada. 
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Unha vez realizada a modificación da malla, deberase calcular de 
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Unha vez acadada a converxencia procederase a gardar o novo caso, 
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cos obtidos coa malla inicial. Deberá terse coidado de non sobrescribir os 
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xeito que se poida identificar o punto de desprendemento do 
fluxo para o ángulo de ataque empregado.  

Para visualizar e exportar os valores dos coeficientes de presión 
deberase empregar a ferramenta Plots: 

Results > Plots/XY Plots 

Para crear a gráfica do coeficiente de presión en ambas caras do perfil 
deberanse escoller as variables Pressure e Pressure Coefficient nos menús 
despregables e seleccionar as entidades correspondentes coa parede 
superior e coa parede inferior do perfil (Figura 2.19). Facendo clic no 
botón Save/Plot poderanse visualizar os resultados na ventá gráfica. Para 
gardar estes resultados nun ficheiro e así facilitar a labor de comparación 
cos datos experimentais, deberase seleccionar a opción Write to File situada 
na marxe esquerda, e posteriormente facer clic no botón Write. O ficheiro 
creado con extensión .xy que contén estes resultados poderá ser aberto 
en calquera editor de texto plano (Figura 2.19) ou poderá ser inserido 
nun editor de folla de cálculo. 

 
Figura 2.18: Exemplo dos resultados analizados neste capítulo, 

mostrados intencionadamente sen valores nin escala. 

Unha vez dixitalizados os datos experimentais tomados do estudo da 
NASA mediante o emprego de ferramentas como Engauge [10], estes 
poderán ser comparados cos resultados numéricos obtidos nas 
simulacións, obtendo unhas gráficas similares ás amosadas na Figura 2.20. 

 

Contornos de presión [Pa] Contornos de Mach [-]
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Figura 2.19: Configuración e resultados obtidos coa ferramenta Plots. 

 

 

 
Figura 2.20: Exemplo da comparativa dos resultados dos coeficientes de 

presión. 
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2.7. Actividades propostas 

Como tarefa de entrega neste capítulo deberase crear un informe 
detallado onde se mostren os resultados indicados no apartado anterior 
para a malla orixinal empregada. É de especial relevancia a validación cos 
resultados experimentais, polo que se deberán realizar comparativas nas 
que se mostren o nivel de concordancia entre os datos experimentais e os 
resultados numéricos acadados. 

Deberase levar a cabo a simulación de diferentes ángulos de ataque 
seguindo os mesmos pasos que os descritos neste capítulo. Deberán 
representarse os resultados obtidos para o coeficiente de sustentación en 
función do ángulo de ataque, de maneira que poida identificarse 
aproximadamente o punto no que se producirá a perda de sustentación. 
Do mesmo xeito, deberase incluír a validación dos resultados, ao igual 
que se fixo co primeiro caso proposto. 

Finalmente deberá facerse un refinado da malla na rexión próxima 
ao perfil estudado, co fin de analizar a validez do mallado a través da 
comparativa cos resultados obtidos coa malla orixinal.  

A análise dos resultados realizada nesta tarefa deberá ser comentada 
facendo uso dos coñecementos teóricos da materia, e deberase engadir 
un último apartado onde figuren as conclusións obtidas neste estudo.  

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. De xeito adicional, as gráficas xeradas poderán ser 
entregadas nunha folla de cálculo. 

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 
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3. Comportamento 
aerodinámico dun tren de alta 
velocidade 

3.1. Obxectivos 

Os obxectivos fixados para a realización deste capítulo son os 
seguintes: 

• Analizar o comportamento aerodinámico de catro modelos de 
locomotora de tren 2D, empregando ferramentas de CFD. 

• Avaliar as forzas, coeficientes e momentos globais, termos de 
presión e fricción e campos de velocidade do fluxo de aire arredor 
de cada un dos modelos de locomotora. 

• Acadar coñecementos dos fenómenos físicos asociados aos fluxos 
externos, como o arrastre por fricción, arrastre por presión ou a 
sustentación. 

3.2. Fundamentos e descrición do 
problema 

A aerodinámica de vehículos está baseada no estudo dos coeficientes 
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aerodinámicos dos mesmos, de maneira similar a como foron analizados 
no capítulo 1 deste manual. Non obstante, a complexidade asociada a 
estes casos é maior, debido a que a xeometría dos vehículos non é tan 
sinxela e está formada por diferentes partes que contribúen de xeito 
desigual ao seu comportamento aerodinámico. 

Na actualidade, as altas velocidades alcanzadas polos novos modelos 
de trens de alta velocidade confírenlle ao estudo da súa aerodinámica 
unha maior importancia e, en moitos casos, convértese nun factor clave 
na etapa de deseño dos novos trens. 

No exercicio que se propón neste capítulo analízase o 
comportamento aerodinámico da locomotora do tren, por tratarse dunha 
das partes de maior relevancia dentro da aerodinámica deste vehículo. 
Neste eido, diferentes estudos experimentais e numéricos centraron os 
seus esforzos na análise desta parte do tren, así como na optimización da 
xeometría da súa parte dianteira [11–13]. Seguindo esta liña, nas 
simulacións que se levarán a cabo neste capítulo tratarase de analizar o 
efecto aerodinámico de diferentes configuracións xeométricas do frontal 
da locomotora. 

Do mesmo xeito, o coñecemento do desprendemento do fluxo ao 
paso do tren, así como a determinación da estela xerada, son elementos 
importantes para unha correcta estimación dos coeficientes 
aerodinámicos [14, 15]. A pesar disto, neste capítulo non se levará a cabo 
a simulación do fluxo de aire considerando trens completos, debido ao 
excesivo coste computacional que suporía este estudo. Con todo, para 
avaliar o efecto do desprendemento do fluxo ao paso da locomotora, 
incluiranse simulacións de xeometrías con perfís suavizados na parte 
traseira, que a pesar de ser pouco realistas, permitirán obter unha 
estimación da influencia do desprendemento da estela na aerodinámica 
xeral do vehículo.   

Por motivos de simplicidade, os detalles xeométricos dos trens reais 
non serán incluídos nestas simulacións. Elementos como os pantógrafos 
ou os bogies, non serán tidos en conta. De igual forma, serán desprezados 
os raís e as travesas da vía. A consideración destas simplificacións 
xeométricas para levar a cabo estas simulacións numéricas é usual mesmo 
en estudos científicos relevantes, os cales obvian certo nivel de detalle das 
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formas dos trens analizados [16]. 

3.3. Xeometría 

Neste capítulo empregaranse catro xeometrías diferentes, 
correspondentes a catro modelos simplificados e bidimensionais de 
locomotoras. Na Figura 3.1 amósanse as dimensións principais dos catro 
modelos que serán empregados para as simulacións deste capítulo, sendo 
a lonxitude de todos eles (L) próxima aos 20 metros (Figura 3.2). 
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aerodinámicos dos mesmos, de maneira similar a como foron analizados 
no capítulo 1 deste manual. Non obstante, a complexidade asociada a 
estes casos é maior, debido a que a xeometría dos vehículos non é tan 
sinxela e está formada por diferentes partes que contribúen de xeito 
desigual ao seu comportamento aerodinámico. 

Na actualidade, as altas velocidades alcanzadas polos novos modelos 
de trens de alta velocidade confírenlle ao estudo da súa aerodinámica 
unha maior importancia e, en moitos casos, convértese nun factor clave 
na etapa de deseño dos novos trens. 

No exercicio que se propón neste capítulo analízase o 
comportamento aerodinámico da locomotora do tren, por tratarse dunha 
das partes de maior relevancia dentro da aerodinámica deste vehículo. 
Neste eido, diferentes estudos experimentais e numéricos centraron os 
seus esforzos na análise desta parte do tren, así como na optimización da 
xeometría da súa parte dianteira [11–13]. Seguindo esta liña, nas 
simulacións que se levarán a cabo neste capítulo tratarase de analizar o 
efecto aerodinámico de diferentes configuracións xeométricas do frontal 
da locomotora. 

Do mesmo xeito, o coñecemento do desprendemento do fluxo ao 
paso do tren, así como a determinación da estela xerada, son elementos 
importantes para unha correcta estimación dos coeficientes 
aerodinámicos [14, 15]. A pesar disto, neste capítulo non se levará a cabo 
a simulación do fluxo de aire considerando trens completos, debido ao 
excesivo coste computacional que suporía este estudo. Con todo, para 
avaliar o efecto do desprendemento do fluxo ao paso da locomotora, 
incluiranse simulacións de xeometrías con perfís suavizados na parte 
traseira, que a pesar de ser pouco realistas, permitirán obter unha 
estimación da influencia do desprendemento da estela na aerodinámica 
xeral do vehículo.   

Por motivos de simplicidade, os detalles xeométricos dos trens reais 
non serán incluídos nestas simulacións. Elementos como os pantógrafos 
ou os bogies, non serán tidos en conta. De igual forma, serán desprezados 
os raís e as travesas da vía. A consideración destas simplificacións 
xeométricas para levar a cabo estas simulacións numéricas é usual mesmo 
en estudos científicos relevantes, os cales obvian certo nivel de detalle das 
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xeométricas empregadas polo usuario non teñen por que ser idénticas ás 
mostradas na figura. Sempre e cando sexan respectadas as cotas principais 
indicadas, os resultados que se obteñan serán válidos para avaliar de xeito 
realista este fenómeno.  

A Figura 3.2 amosa as dimensións do dominio de cálculo que se 
empregará para as simulacións. Pode observarse como na xeometría se 
diferencia unha zona chamada Rexión próxima, con lonxitude igual ao 
dobre da lonxitude da locomotora. Esta zona servirá de apoio nas tarefas 
de elaboración da malla, posto que se empregarán uns parámetros de 
mallado específicos  nesta rexión para a obtención dunha malla máis fina 
nas partes do dominio situadas a carón das paredes da locomotora. Debe 
terse en conta que os límites desta rexión serán tratados como celas do 
interior do dominio e non serán considerados como paredes. 

 
Figura 3.2: Dimensións do dominio a simular (expresadas en función da 

loxitude do tren). 

Aínda que segundo as recomendacións de publicacións científicas 
desta temática a lonxitude total do dominio debería ser maior[17, 18], 
neste caso primaremos a velocidades de cálculo fronte á precisión, co fin 
de poder analizar os principais fenómenos implicados asumindo breves 
períodos de cálculo.  

3.4. Mallado 

O proceso de mallado farase empregando dous parámetros 
diferenciados para as dúas zonas definidas previamente na xeometría. Na 
rexión afastada do tren empregaranse celas máis grandes, xa que non é 
preciso tanta resolución nos resultados, posto que nestas rexións a 
perturbación do aire é moito menor. Os pequenos gradientes de 
velocidade que se xeran nestas rexións permiten adaptar o tamaño da 
malla, podendo empregar celas de maiores dimensións. 
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O tamaño de cela que se empregará na superficie do tren será de 40 
mm, mentres que o tamaño seleccionado para o perímetro da rexión 
próxima será de 250 mm. Nas superficies externas máis afastadas da 
locomotora o tamaño de cela empregado será de 4 m. 

Deberanse crear polo menos dez capas de celas prismáticas de 
tamaño crecente na rexión da capa límite sobre a superficie da 
locomotora. Para elo deberase empregar a ferramenta inflation, BL creator, 
ou outros nomes equivalentes, segundo o software de mallado que se 
utilice. Móstrase na Figura 3.3 imaxes en detalle da malla que poden servir 
de referencia para o usuario durante esta tarefa. 

 
Figura 3.3: Imaxes da malla empregada nun dos modelos de 

locomotora. 

Deberanse empregar os mesmos parámetros de mallado para os 
diferentes modelos de locomotora que se avaliarán. Aínda que o número 
total de celas poderá variar nos diferentes casos, deberase tomar a 
cantidade de 200 000 celas como valor total de referencia a ter en conta. 

3.5. Configuración da simulación 

Abrir o programa Fluent 

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

a) c)

b)



  

70 
 

xeométricas empregadas polo usuario non teñen por que ser idénticas ás 
mostradas na figura. Sempre e cando sexan respectadas as cotas principais 
indicadas, os resultados que se obteñan serán válidos para avaliar de xeito 
realista este fenómeno.  

A Figura 3.2 amosa as dimensións do dominio de cálculo que se 
empregará para as simulacións. Pode observarse como na xeometría se 
diferencia unha zona chamada Rexión próxima, con lonxitude igual ao 
dobre da lonxitude da locomotora. Esta zona servirá de apoio nas tarefas 
de elaboración da malla, posto que se empregarán uns parámetros de 
mallado específicos  nesta rexión para a obtención dunha malla máis fina 
nas partes do dominio situadas a carón das paredes da locomotora. Debe 
terse en conta que os límites desta rexión serán tratados como celas do 
interior do dominio e non serán considerados como paredes. 

 
Figura 3.2: Dimensións do dominio a simular (expresadas en función da 

loxitude do tren). 

Aínda que segundo as recomendacións de publicacións científicas 
desta temática a lonxitude total do dominio debería ser maior[17, 18], 
neste caso primaremos a velocidades de cálculo fronte á precisión, co fin 
de poder analizar os principais fenómenos implicados asumindo breves 
períodos de cálculo.  

3.4. Mallado 

O proceso de mallado farase empregando dous parámetros 
diferenciados para as dúas zonas definidas previamente na xeometría. Na 
rexión afastada do tren empregaranse celas máis grandes, xa que non é 
preciso tanta resolución nos resultados, posto que nestas rexións a 
perturbación do aire é moito menor. Os pequenos gradientes de 
velocidade que se xeran nestas rexións permiten adaptar o tamaño da 
malla, podendo empregar celas de maiores dimensións. 

16L

10LL5L

1.
5L

2L
Rexión próxima

Configuración da simulación  
 

71 
 

O tamaño de cela que se empregará na superficie do tren será de 40 
mm, mentres que o tamaño seleccionado para o perímetro da rexión 
próxima será de 250 mm. Nas superficies externas máis afastadas da 
locomotora o tamaño de cela empregado será de 4 m. 

Deberanse crear polo menos dez capas de celas prismáticas de 
tamaño crecente na rexión da capa límite sobre a superficie da 
locomotora. Para elo deberase empregar a ferramenta inflation, BL creator, 
ou outros nomes equivalentes, segundo o software de mallado que se 
utilice. Móstrase na Figura 3.3 imaxes en detalle da malla que poden servir 
de referencia para o usuario durante esta tarefa. 

 
Figura 3.3: Imaxes da malla empregada nun dos modelos de 

locomotora. 

Deberanse empregar os mesmos parámetros de mallado para os 
diferentes modelos de locomotora que se avaliarán. Aínda que o número 
total de celas poderá variar nos diferentes casos, deberase tomar a 
cantidade de 200 000 celas como valor total de referencia a ter en conta. 

3.5. Configuración da simulación 

Abrir o programa Fluent 

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

a) c)

b)

  

70 
 

xeométricas empregadas polo usuario non teñen por que ser idénticas ás 
mostradas na figura. Sempre e cando sexan respectadas as cotas principais 
indicadas, os resultados que se obteñan serán válidos para avaliar de xeito 
realista este fenómeno.  

A Figura 3.2 amosa as dimensións do dominio de cálculo que se 
empregará para as simulacións. Pode observarse como na xeometría se 
diferencia unha zona chamada Rexión próxima, con lonxitude igual ao 
dobre da lonxitude da locomotora. Esta zona servirá de apoio nas tarefas 
de elaboración da malla, posto que se empregarán uns parámetros de 
mallado específicos  nesta rexión para a obtención dunha malla máis fina 
nas partes do dominio situadas a carón das paredes da locomotora. Debe 
terse en conta que os límites desta rexión serán tratados como celas do 
interior do dominio e non serán considerados como paredes. 

 
Figura 3.2: Dimensións do dominio a simular (expresadas en función da 

loxitude do tren). 

Aínda que segundo as recomendacións de publicacións científicas 
desta temática a lonxitude total do dominio debería ser maior[17, 18], 
neste caso primaremos a velocidades de cálculo fronte á precisión, co fin 
de poder analizar os principais fenómenos implicados asumindo breves 
períodos de cálculo.  

3.4. Mallado 

O proceso de mallado farase empregando dous parámetros 
diferenciados para as dúas zonas definidas previamente na xeometría. Na 
rexión afastada do tren empregaranse celas máis grandes, xa que non é 
preciso tanta resolución nos resultados, posto que nestas rexións a 
perturbación do aire é moito menor. Os pequenos gradientes de 
velocidade que se xeran nestas rexións permiten adaptar o tamaño da 
malla, podendo empregar celas de maiores dimensións. 

16L

10LL5L

1.
5L

2L
Rexión próxima

Configuración da simulación  
 

71 
 

O tamaño de cela que se empregará na superficie do tren será de 40 
mm, mentres que o tamaño seleccionado para o perímetro da rexión 
próxima será de 250 mm. Nas superficies externas máis afastadas da 
locomotora o tamaño de cela empregado será de 4 m. 

Deberanse crear polo menos dez capas de celas prismáticas de 
tamaño crecente na rexión da capa límite sobre a superficie da 
locomotora. Para elo deberase empregar a ferramenta inflation, BL creator, 
ou outros nomes equivalentes, segundo o software de mallado que se 
utilice. Móstrase na Figura 3.3 imaxes en detalle da malla que poden servir 
de referencia para o usuario durante esta tarefa. 

 
Figura 3.3: Imaxes da malla empregada nun dos modelos de 

locomotora. 

Deberanse empregar os mesmos parámetros de mallado para os 
diferentes modelos de locomotora que se avaliarán. Aínda que o número 
total de celas poderá variar nos diferentes casos, deberase tomar a 
cantidade de 200 000 celas como valor total de referencia a ter en conta. 

3.5. Configuración da simulación 

Abrir o programa Fluent 

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

a) c)

b)



  

72 
 

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 3.4). 

Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
fin de aumentar a precisión do solver. Con esta opción cada número 
decimal pasa a estar representado por 64 bits, en lugar dos 32 bits que se 
empregan nun solver de simple precisión e, ademais, aumenta o rango 
máximo e mínimo que poden alcanzar as variables que se van representar, 
aínda que isto require de máis memoria para poder ser executado. A 
continuación, debe escollerse como directorio de traballo unha carpeta 
que fose creada previamente (Working Directory) e logo facer clic en Start. 

 
Figura 3.4: Ventá de configuración de Fluent Launcher. 

Importar/abrir a malla 

File > Read > Mesh 

Deberase empregar o explorador de arquivos para acceder dentro do 
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directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa amosa na 
consola de comandos información básica sobre as características da 
mesma. Debe verificarse que o número de nodos, caras e celas se 
corresponde cos da malla que se desexa empregar. Deberase comprobar 
que aparecen as entidades nas que se impoñerán as condicións de 
contorno: as catro fronteiras exteriores do dominio, as celas interiores e 
a parede da locomotora. 

Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale): 

Setting Up Domain > Mesh > Scale... 

Setup > General > Mesh > Scale... 

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta. 

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado: 

Setting Up Domain > Mesh > Check 

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Pola contra, se o software detecta posibles fallos, amosará 
unha ventá emerxente na que se reporta o erro. É importante detectar os 
problemas da malla dende o primeiro intre, pois evitarase perder tempo 
innecesariamente na configuración dunha simulación que, por culpa da 
malla, non vai poder ser levada a cabo.  

Deberase comprobar tamén o tamaño da malla de cálculo: 
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Figura 3.4: Ventá de configuración de Fluent Launcher. 

Importar/abrir a malla 

File > Read > Mesh 

Deberase empregar o explorador de arquivos para acceder dentro do 

Configuración da simulación  
 

73 
 

directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa amosa na 
consola de comandos información básica sobre as características da 
mesma. Debe verificarse que o número de nodos, caras e celas se 
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Domain > Mesh > Info > Size 

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas. 

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla: 

Domain > Mesh > Display… 

Este comando mostrará na pantalla a ventá de visualización das 
diferentes partes da malla, permitindo visualizalas, tal e como se aprecia 
na Figura 3.5. 

É importante identificar inequivocamente as diferentes rexións que 
compoñen o dominio, nas cales posteriormente se impoñerán as 
condicións de contorno. Para facilitar o manexo e o recoñecemento das 
diferentes partes da malla, poderanse ocultar e amosar as rexións que se 
desexen, seleccionando ou deseleccionando as entidades no apartado 
Surfaces e posteriormente facendo clic no botón Display. 

 
Figura 3.5: Visualización da malla. 

Definición do solver 

Setup > General 

Neste caso manteranse as opcións que por defecto selecciona o 
programa: Pressure-Based no apartado Type, Absolute no cadro de Velocity 
Formulation, Steady na sección de Time e Planar no apartado de 2D Space, 
tal e como recolle a Figura 3.6. 
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Figura 3.6: Configuración xeral do solver. 

Propiedades dos fluídos 

Setup > Materials 

O fluído de traballo é o aire (air), material que por defecto xa aparece 
recollido na lista de materiais. Manteranse as condicións de densidade e 
viscosidade constantes e cos valores asignados polo programa (Figura 
3.7). 

 
Figura 3.7: Configuración do material aire. 

Condicións de operación 

Setup > Boundary Conditions > Operating Conditions... 

Neste caso manterase o valor da presión de operación en 101325 Pa. 
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Condicións de contorno 

Setup > Boundary Conditions 

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. Independentemente dos 
nomes asignados a cada unha de elas, deberase contar polo menos coas 
seguintes entidades: 

Nome Condición/Tipo 

Entrada Velocity Inlet 

Saída Pressure outlet 

Parede_chan Wall (No slip) 

Parede_teito Symmetry 

Tren Wall (No slip) 

Interior Interior 

 Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto. Para este caso 
manteranse todos os parámetros asignados por defecto para cada unha 
das entidades, agás na entrada de aire, onde se deberá especificar a 
velocidade coa que accede o fluxo de aire ao interior do dominio. 
Deberase introducir o valor de 105 m/s no apartado Velocity Magnitude do 
panel de configuración desta entidade, tal e como se mostra na Figura 
3.8. 

A fronteira superior (Parede_teito) deberá configurarse como un 
plano de simetría, posto que se considera como unha fronteira sen 
fricción. 

Ao contrario do que sucede na realidade, na que o tren é o que se 
despraza e o aire e o chan mantéñense quietos, para analizar o 
movemento relativo aire-tren a simulación configúrase mantendo fixo o 
tren e impoñendo velocidade ao aire e ao chan. Por elo, deberase definir 
que a fronteira inferior (Parede_chan) se move á mesma velocidade que o 
aire de entrada, configurando no panel desta entidade o desprazamento 
na dirección X cunha velocidade de 105 m/s, como se amosa na Figura 
3.8. 
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Figura 3.8: Paneis de configuración das condiciones de contorno. 

Modelo turbulento 

Setup > Models > Viscous 

Deberase seleccionar o modelo turbulento de dúas ecuacións k-omega 
(SST), tal e como se observa na Figura 3.9. 

 
Figura 3.9: Panel de configuración do modelo turbulento. 
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Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. Neste caso, por tratarse do estudo de fluxos 
externos, interesa inicializar todo o dominio de cálculo cos mesmos 
valores que foron asignados na condición de contorno da entrada. 

Solution > Initialization > Standard Initialization 

Dentro da opción de inicialización estándar (Standard Initialization) 
deberase escoller a entidade da entrada dentro do menú despregable do 
apartado Compute from (Figura 3.10). Deste xeito, a velocidade do fluxo 
que foi seleccionada para a entrada será imposta en todo o dominio 
fluído, a cal estará máis próxima á solución final que unha velocidade 
nula en toda a rexión. Para executar a inicialización deberá premerse no 
botón Initialize que se atopa na marxe inferior.  

 
Figura 3.10: Panel de inicialización. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
na pantalla un valor do residuo asociado a cada unha das ecuacións de 
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goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que o usuario decida que os valores dos residuos son 
suficientemente baixos e estables. 

Solution > Monitors > Residual 

Deberase desactivar o criterio de converxencia (Convergence 
Criterion) seleccionando none no despregable, e para poder acceder a esta 
opción é preciso ter seleccionada a opción Show Advanced Options. 
Deberase asegurar que se atopan marcadas as opcións Print to Console e 
Plot no cadro Options (Figura 3.11). Desta forma o programa mostrará os 
valores na consola de comandos a medida que avanza o proceso iterativo 
e visualizará a gráfica da evolución dos residuais durante o cálculo. Para 
aceptar a configuración faga clic en OK. 

 

Figura 3.11: Configuración dos residuais. 

Ademais da configuración xeral de converxencia dos residuais, para 
este estudo é fundamental avaliar a evolución do coeficiente 
aerodinámico de arrastre (CD), do coeficiente de sustentación (CL) e do 
coeficiente de momento (CM) xa que son as principais variables de estudo 
que se están a analizar. Polo tanto, deberase determinar a evolución 
destes parámetros de xeito independente ao que lle ocorra aos residuais. 
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Solution > Monitors > Report Plots 

Facendo clic en New abrirase unha ventá emerxente na que, baixo o 
apartado Selected Report Definitions, debera facerse clic en New e 
seleccionar Force Report > Drag... para crear un novo monitor de 
coeficiente de arrastre, tal e como indican os paneis de configuración da 
Figura 3.12. Deberase seleccionar a entidade sobre a que se desexa avaliar 
o coeficiente, que neste caso é o tren. Unha vez creado o monitor, este 
aparecerá no apartado Available Report Definitions da ventá Report 
Definitions, onde deberá ser seleccionado e engadido ao apartado Selected 
Report Definitions facendo clic no botón Add>>. 

 
Figura 3.12: Paneis de configuración dos coeficientes aerodinámicos. 

Procederase do mesmo xeito para crear os monitores para o 
coeficiente de sustentación e o coeficiente de momento. 

Tendo en conta as definicións dos coeficientes aerodinámicos, co fin 
de evitar confusións coa área de referencia e a velocidade de referencia a 
empregar, é usual utilizar uns valores de área de referencia de 1 m², unha 
velocidade de referencia de 1 m/s e unha densidade de 2 kg/m³. Deste 
xeito, mediante o emprego destes valores de referencia os monitores 
creados mostrarán directamente o valor das forzas e dos momentos sobre 
a superficie en cuestión. 

Setup > Reference Values 
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Deberanse introducir os valores de referencia mencionados, tal e 
como amosa a Figura 3.13. 

 
Figura 3.13: Panel de configuración dos valores de referencia 

Con este último paso finaliza o proceso de configuración do caso, así 
como a inicialización e a definición do modelo a resolver. Neste intre 
recoméndase gardar a simulación para non perder o traballo de 
configuración realizado. 

File > Write > Case&Data 

Deberase asignar un nome que identifique inequivocamente o caso 
en cuestión tendo en conta os diferentes modelos de locomotora que se 
van simular, por exemplo Locomotora_A.cas. Comprobarase que 
efectivamente foron creados dous arquivos con extensión .cas e .dat na 
carpeta de traballo. Se por calquera razón  se pecha o programa, poderase 
recuperar o traballo realizado ata o de agora lendo os arquivos 
Locomotora_A.cas e Locomotora_A.dat. 

Proceso iterativo 

Deberase fixar o número de iteracións que se levarán a cabo na etapa 
de cálculo. 
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Deberanse introducir os valores de referencia mencionados, tal e 
como amosa a Figura 3.13. 

 
Figura 3.13: Panel de configuración dos valores de referencia 

Con este último paso finaliza o proceso de configuración do caso, así 
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Solution > Run Calculation 

No apartado Number of Iterations deberase introducir o valor 2000, e 
a continuación facer clic no botón Calculate. Isto dará comezo ao calculo 
iterativo. Posto que o criterio de converxencia foi desactivado, o software 
levará a cabo as 2000 iteracións, salvo que o usuario decida paralo en vistas 
da evolución dos resultados. O proceso de cálculo poderase frear 
premendo nas teclas Ctr+C ou facendo clic no botón Stop situado na 
marxe inferior dereita do programa. 

Unha vez acadada a converxencia procederase a gardar os arquivos 
correspondentes ao caso calculado. 

File > Write > Case&Data 

Deberase ter especial coidado de non sobrescribir os arquivos 
gardados previamente. Para elo, aconsellase empregar un nome distinto 
que permita diferenciar o caso final. Deberá verificarse de novo que 
ambos arquivos foron gardados no directorio de traballo. 

3.6. Análise dos resultados 

Debe asegurarse unha correcta converxencia de todas a simulacións 
realizadas, atendendo ao nivel dos residuais e facendo especial 
seguimento da estabilidade e converxencia dos monitores de forzas e 
coeficientes creados. Namentres non se acade a estabilidade de todos eles, 
non se poderá dar por finalizado o proceso de cálculo. 

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Os valores medios ou estacionarios das principais forzas e 
coeficientes aerodinámicos de arrastre e sustentación, 
diferenciando os termos de presión e fricción. 

• Os valores medios ou estacionarios dos momentos ou coeficientes 
de momentos sobre a locomotora. 

• Gráfica de contornos de presión estática e presión dinámica. 

Análise dos resultados  
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Deberanse obter imaxes semellantes ás da Figura 3.14a e da Figura 
3.14b. 

• Gráfica de contornos de velocidade, obtendo uns resultados 
semellantes aos mostrados na Figura 3.14c. 

 

 
Figura 3.14: Exemplo dos resultados analizados neste capítulo, 

mostrados intencionadamente sen valores nin escala. 

a) Contornos de presión estática [Pa]

b) Contornos de presión total [Pa]

c) Contornos de velocidade [m/s]

d) Liñas de corrente coloreadas por velocidade
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• Gráfica de liñas de corrente, con especial enfoque no 
desprendemento e formación da estela ao paso do tren(Figura 
3.14d). Poderanse realizar vídeos ou animacións das liñas de 
corrente. 

Para crear as liñas de corrente accederase ao apartado Results > 
Graphics > Pathlines. Deberase seleccionar a entrada como zona de partida 
das liñas de corrente e fixarase a variable velocidade como criterio para 
colorealas, tal e como amosa a Figura 3.15. 

 
Figura 3.15: Panel para a visualización de liñas de corrente. 

3.7. Actividades propostas 

Como entrega deste capítulo deberase crear un informe onde se 
mostren de xeito detallado os resultados indicados no apartado anterior 
para os catro modelos de locomotora simulados. Neste informe deberá 
figurar a comparativa dos resultados das principais forzas e momentos 
exercidos polo vento sobre os catro modelos de locomotora. Igualmente, 
deberanse comparar os campos de velocidade obtidos para os catro casos, 
así como a cuantificación da altura e lonxitude da estela xerada por cada 
un deles. Todas estas comparativas deberán ser comentadas facendo uso 
dos coñecementos teóricos da materia, e deberase engadir un último 
apartado onde figuren as conclusións obtidas neste estudo. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. Queda aberta a posibilidade de entrega dun vídeo 
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ou animación onde se aprecien de xeito máis claro os desprendementos 
e remuíños da estela, o cal poderá ser inserido no propio documento ou 
achegado externamente. 

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 



  

84 
 

• Gráfica de liñas de corrente, con especial enfoque no 
desprendemento e formación da estela ao paso do tren(Figura 
3.14d). Poderanse realizar vídeos ou animacións das liñas de 
corrente. 

Para crear as liñas de corrente accederase ao apartado Results > 
Graphics > Pathlines. Deberase seleccionar a entrada como zona de partida 
das liñas de corrente e fixarase a variable velocidade como criterio para 
colorealas, tal e como amosa a Figura 3.15. 

 
Figura 3.15: Panel para a visualización de liñas de corrente. 

3.7. Actividades propostas 

Como entrega deste capítulo deberase crear un informe onde se 
mostren de xeito detallado os resultados indicados no apartado anterior 
para os catro modelos de locomotora simulados. Neste informe deberá 
figurar a comparativa dos resultados das principais forzas e momentos 
exercidos polo vento sobre os catro modelos de locomotora. Igualmente, 
deberanse comparar os campos de velocidade obtidos para os catro casos, 
así como a cuantificación da altura e lonxitude da estela xerada por cada 
un deles. Todas estas comparativas deberán ser comentadas facendo uso 
dos coñecementos teóricos da materia, e deberase engadir un último 
apartado onde figuren as conclusións obtidas neste estudo. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. Queda aberta a posibilidade de entrega dun vídeo 

Actividades propostas  
 

85 
 

ou animación onde se aprecien de xeito máis claro os desprendementos 
e remuíños da estela, o cal poderá ser inserido no propio documento ou 
achegado externamente. 

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 

  

84 
 

• Gráfica de liñas de corrente, con especial enfoque no 
desprendemento e formación da estela ao paso do tren(Figura 
3.14d). Poderanse realizar vídeos ou animacións das liñas de 
corrente. 

Para crear as liñas de corrente accederase ao apartado Results > 
Graphics > Pathlines. Deberase seleccionar a entrada como zona de partida 
das liñas de corrente e fixarase a variable velocidade como criterio para 
colorealas, tal e como amosa a Figura 3.15. 

 
Figura 3.15: Panel para a visualización de liñas de corrente. 

3.7. Actividades propostas 

Como entrega deste capítulo deberase crear un informe onde se 
mostren de xeito detallado os resultados indicados no apartado anterior 
para os catro modelos de locomotora simulados. Neste informe deberá 
figurar a comparativa dos resultados das principais forzas e momentos 
exercidos polo vento sobre os catro modelos de locomotora. Igualmente, 
deberanse comparar os campos de velocidade obtidos para os catro casos, 
así como a cuantificación da altura e lonxitude da estela xerada por cada 
un deles. Todas estas comparativas deberán ser comentadas facendo uso 
dos coñecementos teóricos da materia, e deberase engadir un último 
apartado onde figuren as conclusións obtidas neste estudo. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. Queda aberta a posibilidade de entrega dun vídeo 

Actividades propostas  
 

85 
 

ou animación onde se aprecien de xeito máis claro os desprendementos 
e remuíños da estela, o cal poderá ser inserido no propio documento ou 
achegado externamente. 

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 



87 
 

4. Efectos aerodinámicos da 
posición dun motorista 

4.1. Obxectivos 

Os obxectivos fixados para a realización deste capítulo son os 
seguintes: 

• Cuantificar e analizar o efecto sobre o arrastre da posición relativa 
do piloto na motocicleta. 

• Cuantificar e analizar o efecto sobre o arrastre de dúas 
motocicletas que circulan unha tras outra na mesma dirección e 
sentido. 

• Introducir ao usuario no manexo de funcións de análise, como a 
definición de novas variables ou a creación de liñas virtuais e rakes 
para conseguir mellores post-procesados. 

4.2. Fundamentos e descrición do 
problema 

A posición do piloto dunha motocicleta afecta de forma notable á 
aerodinámica global do conxunto formado pola motocicleta mais o 
piloto. Unha situación similar ocorre en calquera outro vehículo, en 
determinados deportes, como o ciclismo, o esquí, a patinaxe, a natación 
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ou incluso o bobsleigh, ou ben en todos aqueles casos onde as velocidades 
de desprazamento sexan elevadas e a persoa se atope enfrontada 
directamente ao aire con pouco ou ningún carenado. Como exemplo de 
estudo numérico desenvolvido mediante ferramentas CFD, pódese 
destacar o levado a cabo por Beaumont et al. [19], no que se analiza en 
detalle os efectos xerados por diferentes modelos de casco empregados 
en competicións de ciclismo, e no que os resultados amosan a importancia 
dos pequenos detalles aerodinámicos destes dispositivos. 

Ademais dos parámetros máis obvios que afectan á aerodinámica, 
como son a xeometría e a área frontal do conxunto vehículo-piloto que 
se atope enfrontada ou fluxo de aire, aparecen outros efectos 
aerodinámicos a ter en conta, como o coñecido como efecto rebufo. Este 
fenómeno consiste en aproveitarse da redución do arrastre ocasionada 
debido á presencia dun vehículo que circula diante a unha determinada 
distancia. Este efecto é empregado asiduamente nas competicións de 
motor e, xestionado adecuadamente, pode permitir un aumento da 
velocidade do vehículo perseguidor, o cal pode aproveitarse para acadar 
un adiantamento. Este efecto é máis notable cando se produce en 
vehículos de dimensións diferentes, coma o que se da cando un coche 
circula detrás dun camión, motivo polo cal, nas manobras de 
adiantamento compre extremar as precaucións. 

O efecto rebufo ocasionado por unha moto sobre un ciclista foi 
analizado e reproducido mediante ferramentas CFD no estudo de 
Blocken et al. [20]. Neste capítulo, para poder analizar este efecto, 
proponse empregar dúas motocicletas, circulando unha a continuación 
da outra, co fin de cuantificar de xeito aproximado este fenómeno. 

4.3. Xeometría 

Para analizar a influencia da posición do piloto, neste capítulo 
empregaranse catro xeometrías diferentes, nas que se varía o ángulo da 
posición do condutor. Na Figura 4.1 pode observarse como a posición do 
motorista pasa dende a posición máis erguida (A), que se corresponde 
coa menos aerodinámica, a unha posición de competición (D). Estas 
catro xeometrías serán as requiridas para poder levar a cabo o estudo 
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fixado no primeiro dos obxectivos deste capítulo. 

 
Figura 4.1: Detalle das posicións relativas do piloto sobre a motocicleta. 

Por outra banda, para a análise proposta no segundo obxectivo, na 
que se pretende coñecer os efectos que se producen cando un vehículo 
circula cerca do que lle precede, empregarase unha xeometría con dúas 
motocicletas. Tal e como amosa a Figura 4.2, utilizaranse dous conxuntos 
piloto-motocicleta idénticos, situados un a continuación do outro, cunha 
distancia entre eles moi pequena. 

 
Figura 4.2: Detalle da posición relativa das dúas motocicletas. 

Unha vez expostas as cinco xeometrías necesarias para esta tarefa, 
expóñense as dimensións da motocicleta e a extensión do dominio de 
cálculo que se vai empregar. 
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vehículos de dimensións diferentes, coma o que se da cando un coche 
circula detrás dun camión, motivo polo cal, nas manobras de 
adiantamento compre extremar as precaucións. 

O efecto rebufo ocasionado por unha moto sobre un ciclista foi 
analizado e reproducido mediante ferramentas CFD no estudo de 
Blocken et al. [20]. Neste capítulo, para poder analizar este efecto, 
proponse empregar dúas motocicletas, circulando unha a continuación 
da outra, co fin de cuantificar de xeito aproximado este fenómeno. 

4.3. Xeometría 

Para analizar a influencia da posición do piloto, neste capítulo 
empregaranse catro xeometrías diferentes, nas que se varía o ángulo da 
posición do condutor. Na Figura 4.1 pode observarse como a posición do 
motorista pasa dende a posición máis erguida (A), que se corresponde 
coa menos aerodinámica, a unha posición de competición (D). Estas 
catro xeometrías serán as requiridas para poder levar a cabo o estudo 
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fixado no primeiro dos obxectivos deste capítulo. 

 
Figura 4.1: Detalle das posicións relativas do piloto sobre a motocicleta. 

Por outra banda, para a análise proposta no segundo obxectivo, na 
que se pretende coñecer os efectos que se producen cando un vehículo 
circula cerca do que lle precede, empregarase unha xeometría con dúas 
motocicletas. Tal e como amosa a Figura 4.2, utilizaranse dous conxuntos 
piloto-motocicleta idénticos, situados un a continuación do outro, cunha 
distancia entre eles moi pequena. 

 
Figura 4.2: Detalle da posición relativa das dúas motocicletas. 

Unha vez expostas as cinco xeometrías necesarias para esta tarefa, 
expóñense as dimensións da motocicleta e a extensión do dominio de 
cálculo que se vai empregar. 
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Neste caso empregaremos unha xeometría en dúas dimensións na 
que, de forma simplificada, se pretenden reproducir as dimensións 
convencionais dunha motocicleta [20], tal e como amosa a Figura 4.3. 
Aínda que as dimensións son similares ás dunha motocicleta comercial, 
non se pretenden acadar resultados que poidan ser validados 
experimentalmente, posto que, ao tratarse dunha simplificación 
bidimensional, non é posible captar os fenómenos aerodinámicos 
tridimensionais que se producen sobre unha motocicleta real. Non 
obstante, permitirán analizar os parámetros e comportamentos fixados 
como propósito deste traballo. 

 
Figura 4.3: Dimensións principais da motocicleta en estudo (expresadas 

en [mm]). 

As formas do piloto e da motocicleta empregadas non teñen por que 
ser idénticas ás mostradas na Figura 4.1 e na Figura 4.3. Sempre e cando 
se manteñan as cotas principais e as inclinacións indicadas, os resultados 
serán válidos para estudar os efectos buscados. 

A Figura 4.4 amosa as dimensións do dominio de cálculo que se 
empregará para levar a cabo as simulacións. Neste dominio pode 
diferenciarse unha rexión denominada Rexión próxima, con lonxitude 
igual a cinco veces a lonxitude da motocicleta (L). Esta rexión servirá de 
apoio para a elaboración da malla, xa que nas inmediacións dos 
elementos de estudo empregaranse uns parámetros de malla específicos 
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para a realización dunha malla máis fina. Debe terse en conta que os 
límites desta rexión serán tratados como celas do interior do dominio e 
non serán considerados como paredes. A lonxitude total do dominio 
estenderase unha lonxitude de 5L por diante dos elementos de estudo e 
unha lonxitude de 15L por detrás dos mesmos. Estas dimensións globais 
manteranse para as catro xeometrías de posición do piloto e mais para o 
caso de estudo das dúas motocicletas xuntas. 

 
Figura 4.4: Dimensións do dominio a simular. 

4.4. Mallado 

Seguindo un procedemento similar ao descrito nos capítulos 
anteriores, empregaranse dous tamaños de malla diferentes para as dúas 
zonas definidas no dominio. 

O tamaño de cela empregado na superficie do conxunto piloto-
motocicleta é de 10 mm, mentres que o tamaño de malla seleccionado 
para os límites da zona próxima e de 50 mm. 

Na rexión afastada do conxunto de estudo empregaranse celas máis 
grandes (1 m), xa que non é precisa tanta resolución numérica nos 
resultados desta zona. 

Tal e como se expuxo anteriormente, nestas simulacións sacrificouse 
o realismo dos valores numéricos, posto que se asumiu o emprego de 
xeometrías bidimensionais para xerar mallas máis pequenas e aforrar 
tempo de cálculo. Deste xeito, non parece xustificado engadir celas 
prismáticas na contorna das paredes da motocicleta e do piloto. 

A Figura 4.5 amosa dúas vistas en detalle da malla final empregada 
nun dos casos de estudo, nas que se poden apreciar o aspecto dos 
elementos que compoñen o dominio de cálculo. É aconsellable que se 
manteñan os mesmos parámetros de mallado para a realización das mallas 
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dos cinco casos, co fin de obter discretizacións espaciais similares en todos 
eles. 

  
Figura 4.5: Detalle da malla final empregada nun dos casos de estudo. 

4.5. Configuración da simulación 

Abrir o programa Fluent 

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 4.6).  
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Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
fin de aumentar a precisión do solver. Con esta opción cada número 
decimal pasa a estar representado por 64 bits, en lugar dos 32 bits que se 
empregan nun solver de simple precisión e, ademais, aumenta o rango 
máximo e mínimo que poden alcanzar as variables que se van representar, 
aínda que isto require de máis memoria para poder ser executado. A 
continuación debe escollerse como directorio de traballo unha carpeta 
que fose creada previamente (Working Directory) e logo facer clic en Start. 

 
Figura 4.6: Ventá de configuración de Fluent Launcher. 

Importar/abrir a malla 

File > Read > Mesh  

Deberase empregar o explorador de arquivos para acceder dentro do 
directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa reporta na 
consola de comandos información básica sobre as características da 
mesma. Debe verificarse que o número de nodos, caras e celas se 
corresponde cos da malla que se desexa empregar. Deberase comprobar 
que aparecen as entidades nas que se impoñerán as condicións de 
contorno: as catro fronteiras exteriores, as celas interiores e a parede do  
conxunto piloto-motocicleta.  
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Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale):  

Setting Up Domain > Mesh > Scale...  

Setup > General > Mesh > Scale...  

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta.  

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado:  

Setting Up Domain > Mesh > Check 

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Pola contra, se o software detecta posibles fallos, amosará 
unha ventá emerxente na que se reporta o erro. É importante detectar os 
problemas da malla dende o primeiro intre, pois evitarase perder tempo 
innecesariamente na configuración dunha simulación que, por culpa da 
malla, non vai poder ser levada a cabo.  

Deberase comprobar tamén o tamaño da malla de cálculo:  

Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas.  

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla a ventá de visualización das 
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diferentes partes da malla, permitindo visualizalas, tal e como se aprecia 
na Figura 4.7. 

É importante identificar inequivocamente as diferentes rexións que 
compoñen o dominio, nas cales posteriormente se impoñerán as 
condicións de contorno. Para facilitar o manexo e o recoñecemento das 
diferentes partes da malla, poderanse ocultar e amosar as rexións que se 
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Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale):  
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Setup > General > Mesh > Scale...  

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta.  
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Setting Up Domain > Mesh > Check 
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unha ventá emerxente na que se reporta o erro. É importante detectar os 
problemas da malla dende o primeiro intre, pois evitarase perder tempo 
innecesariamente na configuración dunha simulación que, por culpa da 
malla, non vai poder ser levada a cabo.  

Deberase comprobar tamén o tamaño da malla de cálculo:  

Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas.  

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla a ventá de visualización das 
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Figura 4.8: Configuración xeral do solver. 

Propiedades dos fluídos 

Setup > Materials  

O fluído de traballo é o aire (air), material que por defecto xa aparece 
recollido na lista de materiais. Manteranse as condicións de densidade e 
viscosidade constantes e cos valores asignados polo programa (Figura 
4.9). 

 
Figura 4.9: Configuración do material aire. 

Condicións de operación 

Setup > Boundary Conditions > Operating Conditions... 

Neste caso manterase o valor da presión de operación en 101325 Pa. 
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Condicións de contorno 

Setup > Boundary Conditions 

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. Independentemente dos 
nomes asignados a cada unha de elas, deberase contar polo menos coas 
seguintes entidades: 

Nome Condición/Tipo 

Entrada Velocity Inlet 

Saída Pressure outlet 

Parede_chan Wall (No slip) 

Parede_teito Symmetry 

Parede_moto Wall (No slip) 

Interior Interior 

Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto. Para este caso 
manteranse todos os parámetros asignados por defecto para cada unha 
das entidades, agás na entrada de aire, onde se deberá especificar a 
velocidade coa que accede o fluxo de aire ao interior do dominio. 
Deberase introducir o valor de 40 m/s no apartado Velocity Magnitude do 
panel de configuración desta entidade, tal e como se mostra na Figura 
4.10. 

 
Figura 4.10: Paneis de configuración das condicións de contorno. 
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A fronteira superior (Parede_teito) deberá configurarse como un 
plano de simetría, posto que se considera como unha fronteira sen 
fricción. 

Ao contrario do que sucede na realidade, na que o conxunto piloto-
motocicleta é o que se despraza e o aire e o chan mantéñense quietos, 
para analizar o movemento relativo aire-vehículo a simulación 
configurase mantendo fixo o conxunto piloto-motocicleta e impoñendo 
velocidade ao aire e ao chan. Por este motivo, deberase definir que a 
fronteira inferior (Parede_chan) se move á mesma velocidade que o aire 
de entrada, configurando no panel desta entidade o desprazamento na 
dirección X cunha velocidade de 40 m/s, como se amosa na Figura 4.10. 

Modelo turbulento  

Setup > Models > Viscous  

Deberase seleccionar o modelo turbulento de dúas ecuacións k-omega 
(SST), tal e como se observa na Figura 4.11. 

 
Figura 4.11: Panel de configuración do modelo turbulento. 
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Métodos de solución 

Solution > Methods 

Para mellorar a estabilidade do proceso de cálculo, especialmente 
naqueles casos nos que o piloto se atope nunha situación menos 
aerodinámica, deberase modificar o esquema de acoplamento presión-
velocidade. Deberase escoller a opción Coupled, e deberase asegurar que 
se atopa seleccionada a opción Pseudo Transient, tal e como amosa a 
Figura 4.12. Deste xeito, asegurarase unha mellor estabilidade do cálculo, 
principalmente nas simulacións con gradientes de presión máis acusados. 

  
Figura 4.12: Panel de configuración do método de solución empregado. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. 

Solution > Initialization 

Dentro das opcións de Inicialización deberase escoller a 
inicialización híbrida (Hybrid Initialization). Este método de inicialización 
levará a cabo dez pseudo-iteracións en función das condicións de 
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contorno impostas, conseguindo unha mellor inicialización do proceso 
de cálculo. Para executar a inicialización deberase facer clic no botón 
Initialize. O proceso de inicialización estará completado cando apareza na 
consola de comandos a mensaxe: Hybrid initialization is done. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
na pantalla un valor do residuo asociado a cada unha das ecuacións de 
goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que o usuario decida que os valores dos residuos son 
suficientemente baixos e estables. 

Solution > Monitors > Residual 

Deberase desactivar o criterio de converxencia (Convergence 
Criterion) seleccionando none no despregable, e para poder acceder a esta 
opción é preciso ter seleccionada a opción Show Advanced Options. 
Deberase asegurar que se atopan marcadas as opcións Print to Console e 
Plot no cadro Options (Figura 4.13). Desta forma o programa mostrará os 
valores na consola de comandos a medida que avanza o proceso iterativo 
e visualizará a gráfica da evolución dos residuais durante o cálculo. Para 
aceptar a configuración faga clic en OK. 

 
Figura 4.13: Configuración dos residuais. 
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Ademais da configuración xeral de converxencia dos residuais, para 
este estudo é fundamental avaliar a evolución do coeficiente 
aerodinámico de arrastre (CD) e do coeficiente de sustentación (CL), xa 
que son as principais variables de estudo que se están a analizar. Polo 
tanto, deberase determinar a evolución destes parámetros de xeito 
independente ao que lle ocorra aos residuais.  

Solution > Monitors > Report Plots 

Facendo clic en New abrirase unha ventá emerxente na que, baixo o 
apartado Selected Report Definitions, debera facerse clic en New e 
seleccionar Force Report > Drag... para crear un novo monitor de 
coeficiente de arrastre, tal e como indican os paneis de configuración da 
Figura 4.14. Deberase seleccionar a entidade sobre a que se desexa avaliar 
o coeficiente, que neste caso é o conxunto piloto-motocicleta 
(Parede_moto). Unha vez creado o monitor, este aparecerá no apartado 
Available Report Definitions da ventá Report Definitions, onde deberá ser 
seleccionado e engadido ao apartado Selected Report Definitions facendo 
clic no botón Add>>. 

 
Figura 4.14: Paneis de configuración dos coeficientes aerodinámicos. 

Procederase do mesmo xeito para crear o monitor para o coeficiente 
de sustentación. 

Tendo en conta as definicións dos coeficientes aerodinámicos, co fin 
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Figura 4.13: Configuración dos residuais. 

Configuración da simulación  
 

101 
 

Ademais da configuración xeral de converxencia dos residuais, para 
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Figura 4.14: Paneis de configuración dos coeficientes aerodinámicos. 

Procederase do mesmo xeito para crear o monitor para o coeficiente 
de sustentación. 

Tendo en conta as definicións dos coeficientes aerodinámicos, co fin 
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de evitar confusións coa área de referencia e a velocidade de referencia a 
empregar, é usual utilizar uns valores de área de referencia de 1 m², unha 
velocidade de referencia de 1 m/s e unha densidade de 2 kg/m³. Deste 
xeito, mediante o emprego destes valores de referencia os monitores 
creados mostrarán directamente o valor das forzas sobre a superficie en 
cuestión.  

Setup > Reference Values  

Deberanse introducir os valores de referencia mencionados, tal e 
como amosa a Figura 4.15. 

 
Figura 4.15: Panel de configuración dos valores de referencia. 

Con este último paso finaliza o proceso de configuración do caso, así 
como a inicialización e a definición do modelo a resolver. Neste intre 
recoméndase gardar a simulación para non perder o traballo de 
configuración realizado.  

File > Write > Case&Data  

Deberase asignar un nome que identifique inequivocamente o caso 
en cuestión tendo en conta os diferentes modelos que se van simular, por 
exemplo Moto_1.cas. Comprobarase que efectivamente foron creados 
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dous arquivos con extensión .cas e .dat na carpeta de traballo. Se por 
calquera razón se pecha o programa, poderase recuperar o traballo 
realizado ata o de agora lendo os arquivos Moto_1.cas e Moto_1.dat. 

Proceso iterativo 

Deberase fixar o número de iteracións que se levarán a cabo na etapa 
de cálculo.  

Solution > Run Calculation  

No apartado Number of Iterations deberase introducir o valor 500, e a 
continuación facer clic no botón Calculate. Isto dará comezo ao calculo 
iterativo. Posto que o criterio de converxencia foi desactivado, o software 
levará a cabo as 500 iteracións, salvo que o usuario decida paralo en vistas 
da evolución dos resultados. O proceso de cálculo poderase frear 
premendo nas teclas Ctr+C ou facendo clic no botón Stop situado na 
marxe inferior dereita do programa.  

Unha vez acadada a converxencia procederase a gardar os arquivos 
correspondentes ao caso calculado.  

File > Write > Case&Data  

Deberase ter especial coidado de non sobrescribir os arquivos 
gardados previamente. Para elo, aconsellase empregar un nome distinto 
que permita diferenciar o caso final. Deberá verificarse de novo que 
ambos arquivos foron gardados no directorio de traballo. 

4.6. Análise dos resultados 

Deberá asegurarse unha correcta converxencia de todas a 
simulacións realizadas, atendendo ao nivel dos residuais e facendo 
especial seguimento da estabilidade e converxencia dos monitores de 
forzas e coeficientes creados. Namentres non se acade a estabilidade de 
todos eles, non se poderá dar por finalizado o proceso de cálculo.  

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
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súa posterior entrega: 

• Os valores medios ou estacionarios das forzas de arrastre e 
sustentación en cada unha das posicións do piloto. No caso con 
dúas motos deberanse analizar as forzas en cada unha delas. 

• Gráfica de contornos de presión estática. Deberase empregar en 
todos os casos os mesmos valores mínimos e máximos da escala 
para comparar de xeito máis preciso os resultados acadados. 

• Gráfica de contorno de velocidade relativa adimensional. Esta 
variable deberá ser creada polo usuario e representarase no rango 
de 0 a 1 en todos os casos simulados. 

• Gráfica de liñas de corrente, as cales deberán ser lanzadas a lo 
menos dende unha Line/Rake creada polo usuario e que permita 
apreciar de xeito visual as diferencias no desprendemento da 
estela nos distintos casos. 

Para mellorar a análise dos resultados é común empregar variables 
novas definidas polo usuario. Para xerar unha variable nova deberase 
acceder ao apartado Field Functions na pestana User-Defined situada na 
marxe superior, e facer clic no botón Custom.... Para crear a variable de 
velocidade relativa deberase seleccionar a magnitude da velocidade e 
dividila pola velocidade imposta na entrada, tal e como amosa a Figura 
4.16. Seleccionando apropiadamente os límites da variable creada 
obterase unha comparativa de velocidades semellante á amosada na 
Figura 4.18. 

 

 
Figura 4.16: Panel de configuración dunha nova variable. 

Actividades propostas  
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Para mellorar o post-procesado con liñas de corrente é interesante 
empregar un Rake. Un Rake é unha sucesión de puntos equidistantes 
dentro dunha recta, a cal se define polas coordenadas do punto inicial e 
do punto final. Para crear un Rake deberase acceder na pestana Results, 
no apartado Surfaces, facendo clic no botón Create e seleccionando a 
opción Line/Rake.... Se se coñecen as coordenadas do punto inicial e do 
punto final do Rake que se desexa crear, poderanse introducir 
directamente na ventá emerxente que aparecerá na pantalla. Non 
obstante, tamén existe a posibilidade de seleccionar co rato directamente 
na ventá de gráficos o punto inicial e o punto final da recta, empregando 
a opción Select Points with Mouse. A Figura 4.17 amosa o panel de 
configuración do Rake e a rexión situada detrás da motocicleta onde 
deberá ser creado. 

 
Figura 4.17: Panel de configuración do Rake e exemplo da rexión onde 

debe ser creado. 

Unha vez xerados os Rakes que se consideren necesarios, lanzaranse 
as liñas de corrente dende eles, obtendo unha gráfica semellante á 
amosada na Figura 4.18. 

4.7. Actividades propostas 

Como tarefa de entrega neste capítulo deberase crear un informe 
detallado onde se mostren os resultados indicados no apartado anterior 
para cada un dos modelos de xeometría empregados, tanto os datos 
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numéricos obtidos como as imaxes e contornos indicados. Deberanse 
comparar os resultados alcanzados nas xeometrías con diferente 
inclinación do piloto, relacionando as imaxes obtidas cos datos numéricos 
das forzas calculadas para ca un dos casos. Igualmente, deberanse analizar 
os resultados do caso con dúas motocicletas circulando unha detrás da 
outra. Neste último apartado queda aberta a posibilidade de analizar o 
efecto da distancia entre motocicletas, mediante a creación de novas 
xeometrías nas que se varíe este parámetro e que permitan extraer 
conclusións ao respecto deste tema. 

 
Figura 4.18: Exemplo dos resultados a analizar neste capítulo, mostrados 

intencionadamente sen valores nin escala. 

Todas estas comparativas deberán ser comentadas facendo uso dos 
coñecementos teóricos da materia. Do mesmo xeito, deberase comentar 

Liñas de corrente coloreadas por velocidade [m/s]

Contornos de velocidade relativa [-] Contornos de presión estática [Pa]

Actividades propostas  
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a utilidade das dúas novas ferramentas empregadas nesta análise: a 
creación de variables definidas polo usuario e a creación de Rakes. 
Deberase engadir un último apartado onde figuren as conclusións obtidas 
neste estudo.  

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. 

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 
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5. Comportamento 
aerodinámico do alerón dun 
vehículo de Fórmula 1 

5.1. Obxectivos 

Os obxectivos fixados para a realización deste capítulo son os 
seguintes: 

• Reproducir os efectos aerodinámicos asociados ao emprego dun 
DRS (Drag Reduction System) en vehículos de Fórmula 1. 

• Empregar zonas de malla diferenciadas, que poidan activarse e 
desactivarse segundo conveña. 

• Cuantificar o efecto producido por un alerón (efecto down force) na 
estabilidade dun vehículo que se despraza a altas velocidades. 

5.2. Fundamentos e descrición do 
problema 

Os fundamentos do cálculo dos diferentes coeficientes 
aerodinámicos, así como a avaliación do comportamento do fluxo 
externo que se empregará nesta tarefa, son os mesmos que os explicados 
nos capítulos anteriores. Neste caso, a aerodinámica externa segue a ser a 
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base da simulación, pero agora o problema céntrase no estudo do efecto 
xerado por un dos compoñentes do vehículo: o alerón traseiro. Deste 
xeito, ao igual que outros estudos numéricos realizados con ferramentas 
CFD [21–23], neste capítulo preténdese analizar e comprender o 
comportamento do alerón e o seu efecto na aerodinámica do vehículo. 

Existen moitos tipos, localizacións e funcións dos aleróns, os cales son 
deseñados para guiar o fluxo de aire, mellorar a refrixeración dos 
dispositivos, fomentar ou atenuar a adherencia do vehículo á estrada 
(efecto down force), aumentar ou reducir a velocidade do vehículo, mellorar 
a súa estabilidade, entre outras funcións. Os aleróns traseiros empregados 
en automoción buscan, en xeral, aumentar a forza aerodinámica cara o 
chan, permitindo así un maior agarre e unha maior estabilidade do 
vehículo, por exemplo, no momento de tomar unha curva a alta 
velocidade. Non obstante, o emprego de aleróns produce un aumento da 
forza de arrastre, o cal produce un efecto indesexable, xa que se traduce 
nunha redución da velocidade máxima do vehículo, tal e como 
exemplifica o esquema da Figura 5.1. Cando o vehículo circula por unha 
recta, o aumento da forza cara o chan non é beneficioso para o vehículo, 
xa que produce unha diminución da velocidade, por este motivo nas 
competicións automobilísticas as características do vehículo adáptanse en 
función do número, da lonxitude, da distribución e do tipo de curvas e 
rectas do trazado. 

 
Figura 5.1: Esquema do efecto aerodinámico dun alerón traseiro. 

No caso concreto do estudo proposto neste capítulo analizase un DRS 
(Drag Reduction System), o cal é empregado en vehículos de competición 
de Fórmula 1. Este dispositivo xurdiu na tempada 2011 [24], e a maior 
diferencia con respecto aos convencionais aleróns traseiros empregados 
ata ese momento, é a posibilidade de moverse ou axustarse durante a 
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circulación do vehículo. Polo tanto, en determinadas partes do circuíto, 
as cales están fixadas e controladas pola normativa da competición, 
permíteselles aos pilotos abrir a sección de paso do alerón, reducindo 
deste xeito o arrastre proporcionado polo mesmo, e dando lugar a un 
aumento da velocidade. Esta innovación realizada nos aleróns fíxose coa 
finalidade de facilitar as manobras de adiantamento, proporcionando 
maior espectacularidade á competición. 

Simular de xeito realista o movemento dos flaps ou aletas do sistema 
DRS escapa dos obxectivos fixados para este capítulo, polo que, neste 
caso, o efecto de activar o sistema DRS será reproducido de xeito 
simplificado como a eliminación do alerón. 

5.3. Xeometría 

Neste capítulo emprégase unha única xeometría bidimensional 
correspondente coa sección central dun vehículo de competición de 
automoción, similar aos do campionato de Fórmula 1. As dimensións 
principais do vehículo de carreiras empregado están definidas na Figura 
5.2, na que se representa un corte no plano medio dun vehículo real.  

 
Figura 5.2: Dimensións principais do vehículo a simular (expresadas en 

función da lonxitude do vehículo). 

Trátase dunha xeometría bidimensional sinxela que non pretende 
acadar resultados que sexan comparables aos reais, posto que ao tratarse 
dunha simplificación en 2D non poderá captar a aerodinámica 
tridimensional e realista dun alerón nin dun sistema DRS completo. A 
dimensión de referencia indicada como L queda a decisión do usuario, o 
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cal deberá empregar un valor que considere adecuado para o estudo deste 
problema [25]. Do mesmo xeito, o usuario deberá decidir o grao de 
detalle e realismo da xeometría empregada. 

Cabe destacar que no proceso de realización desta xeometría xoga 
un papel importante diferenciar de xeito inequívoco as partes que 
compoñen o alerón do vehículo. As superficies que dan forma a esta parte 
da xeometría deberán estar identificadas e separadas do resto de 
dominio, co fin de facilitar as tarefas da fase de creación da malla e da 
posterior simulación. No caso de empregar o módulo de Ansys para a 
realización da xeometría, recoméndase utilizar a ferramenta Name 
Selection para identificar as diferentes partes do vehículo. 

A Figura 5.3 amosa as dimensións do dominio que se empregará 
neste caso. Ao igual que nos dominios utilizados nos capítulos anteriores, 
pode observarse como na xeometría se diferencia unha zona chamada 
Rexión próxima, con lonxitude igual ao triplo da lonxitude do vehículo. 
Esta zona servirá de apoio nas tarefas de elaboración da malla, na que se 
empregarán uns parámetros de mallado específicos para a obtención 
dunha malla máis fina nas partes do dominio máis próximas ás paredes 
do vehículo. A lonxitude do dominio esténdese 3L por diante da zona 
refinada e 9L por detrás da mesma, obtendo unha lonxitude total de 15L. 
Aínda que as dimensión globais deste dominio se afastan dos 
requirimentos máis esixentes para este tipo de estudos, son suficientes 
para pode levar a cabo a análise proposta. 

 
Figura 5.3: Dimensións do dominio a simular (expresadas en función da 

lonxitude do vehículo). 

5.4. Mallado 

Seguindo un procedemento similar ao empregado nos capítulos 

Mallado  
 

113 
 

previos, neste caso tamén se empregarán dous tamaños de malla 
diferentes para as dúas zonas definidas anteriormente na xeometría. 
Nesta ocasión utilizarase un tamaño de cela que permita reproducir de 
xeito apropiado a curvatura das superficies do vehículo, e prescindirase 
novamente das capas de elementos prismáticos situados a carón da 
superficie que representa o elemento de estudo. 

O tamaño de cela empregado na superficie do vehículo poderá variar 
entre os 10 mm e os 50 mm. Estes valores de tamaño de cela son os 
apropiados para vehículos cunha lonxitude entre os 4 e os 5 metros. No 
caso de seleccionar outras dimensións, deberase reconsiderar o tamaño 
de cela empregado na realización da malla. Esta metodoloxía de creación 
da malla na que se determina o tamaño da cela dentro dun rango fixado, 
dá lugar a unha malla que maximiza o número de elementos nas rexións 
con maiores cambios de curvatura e que, polo tanto, son susceptibles de 
acadar maiores gradientes. Deste xeito, localizarase o maior número de 
celas naquelas zonas de maior interese. 

Nas paredes da caixa externa empregarase un tamaño de cela de 1 
m. 

A Figura 5.4 amosa dúas vistas en detalle da malla empregada. Cabe 
destacar que a parte da malla relativa ao alerón deberá estar 
perfectamente identificada e separada da malla do resto da rexión, tanto 
as súas superficies como as celas do seu interior. Así, preténdese crear 
unha malla con dúas zonas diferenciadas: unha correspondente ao alerón 
e outra correspondente a todo o aire externo. Deste xeito, esta 
consideración permitirá determinar que a rexión ocupada polo alerón 
sexa tratada como aire ou non, segundo interese.  

 
Figura 5.4: Detalle da malla empregada. 
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Figura 5.4: Detalle da malla empregada. 
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5.5. Configuración da simulación 

Abrir o programa Fluent  

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2  

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 5.5).  

 
Figura 5.5: Ventá de configuración de Fluent Launcher. 

Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
fin de aumentar a precisión do solver. Con esta opción cada número 
decimal pasa a estar representado por 64 bits, en lugar dos 32 bits que se 
empregan nun solver de simple precisión e, ademais, aumenta o rango 
máximo e mínimo que poden alcanzar as variables que se van representar, 
aínda que isto require de máis memoria para poder ser executado. A 
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continuación debe escollerse como directorio de traballo unha carpeta 
que fose creada previamente (Working Directory) e logo facer clic en Start. 

Importar/abrir a malla  

File > Read > Mesh  

Deberase empregar o explorador de arquivos para acceder dentro do 
directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa reporta na 
consola de comandos información básica sobre as características da 
mesma. Debe verificarse que o número de nodos, caras e celas se 
corresponde cos da malla que se desexa empregar. Deberase comprobar 
que aparecen as entidades nas que se impoñerán as condicións de 
contorno. Ademais das entidades correspondentes ás fronteiras exteriores 
do dominio e da correspondente coa superficie do vehículo, neste caso 
deberase contar con outras tres entidades: a correspondente coas celas do 
interior do alerón, a fronteira do alerón co aire e a fronteira do alerón co 
vehículo. 

Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale):  

Setting Up Domain > Mesh > Scale...  

Setup > General > Mesh > Scale...  

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta.  

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado:  
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Setting Up Domain > Mesh > Check  

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Pola contra, se o software detecta posibles fallos, amosará 
unha ventá emerxente na que se reporta o erro. É importante detectar os 
problemas da malla dende o primeiro intre, pois evitarase perder tempo 
innecesariamente na configuración dunha simulación que, por culpa da 
malla, non vai poder ser levada a cabo.  

Deberase comprobar tamén o tamaño da malla de cálculo:  

Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas.  

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla a ventá de visualización das 
diferentes partes da malla, permitindo visualizalas, tal e como se aprecia 
na  Figura 5.6.  

 
Figura 5.6: Visualización da malla. 

É importante identificar inequivocamente as diferentes rexións que 
compoñen o dominio, nas cales posteriormente se impoñerán as 
condicións de contorno. Para facilitar o manexo e o recoñecemento das 
diferentes partes da malla, poderanse ocultar e amosar as rexións que se 
desexen, seleccionando ou deseleccionando as entidades no apartado 
Surfaces e posteriormente facendo clic no botón Display. 
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Definición do solver  

Setup > General 

Neste caso manteranse as opcións que por defecto selecciona o 
programa: Pressure-Based no apartado Type, Absolute no cadro de Velocity 
Formulation, Steady na sección de Time e Planar no apartado de 2D Space, 
tal e como recolle a Figura 5.7. 

 
Figura 5.7: Configuración xeral do solver. 

Propiedades dos fluídos  

Setup > Materials  

 
Figura 5.8: Configuración do material aire. 
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Nesta simulación o fluído de traballo é o aire (air), material que por 
defecto xa aparece recollido na lista de materiais. Manteranse as 
condicións de densidade e viscosidade constantes e cos valores asignados 
polo programa (Figura 5.8). 

Condicións de operación  

Setup > Boundary Conditions > Operating Conditions...  

Neste caso manterase o valor da presión de operación en 101325 Pa. 

Condicións de contorno  

Setup > Boundary Conditions  

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. 

Neste caso existen dúas posibles configuracións, dependendo de se 
consideramos ou obviamos a presenza do alerón. Por este motivo, 
deberanse realizar dúas configuracións de caso diferenciadas. Nunha 
delas simularase a xeometría que dá forma ao alerón como se fose parte 
do dominio de aire, o que equivalerá a un vehículo sen alerón. Pola 
contra, na outra configuración eliminaranse as celas do interior do 
alerón, transformando as súas fronteiras nas paredes que definen este 
dispositivo. 

Independentemente dos nomes asignados a cada entidade, cada un 
dos casos de simulación deberá contar polo menos coas seguintes 
entidades: 

Sen alerón  Con alerón 

Nome Condición/Tipo  Nome Condición/Tipo 

Entrada Velocity Inlet  Entrada Velocity Inlet 

Saída Pressure outlet  Saída Pressure outlet 

Parede_chan Wall (No slip)  Parede_chan Wall (No slip) 

Parede_teito Symmetry  Parede_teito Symmetry 

Parede_vehículo Wall (No slip)  Parede_vehículo Wall (No slip) 
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Parede_alerón Interior  Parede_alerón Wall (No slip) 

Interior_aire Interior  Interior_aire Interior 

Parede_vehículo_alerón Wall (No slip)    

Interior_alerón Interior    

Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto. Para este caso 
manteranse todos os parámetros asignados por defecto para cada unha 
das entidades, agás na entrada de aire, onde se deberá especificar a 
velocidade coa que accede o fluxo de aire ao interior do dominio. 
Deberase introducir o valor de 40 m/s no apartado Velocity Magnitude 
(m/s) do panel de configuración desta entidade, tal e como se mostra na 
Figura 5.9. 

 
Figura 5.9: Paneis de configuración das condicións de contorno. 

A fronteira superior, Parede_teito, deberá configurarse como un plano 
de simetría, posto que se considera como unha fronteira sen fricción. 

De xeito análogo ao movemento relativo analizado nos estudos de 
aerodinámica externa dos capítulos anteriores, na realidade o vehículo 
desprázase e o aire e o chan mantéñense quietos. Para analizar este 
movemento relativo, a simulación configúrase mantendo fixo o vehículo 
e impoñendo velocidade ao aire e ao chan. Por elo, deberase definir que 
a fronteira inferior, Parede_chan, se move á mesma velocidade que o aire 
de entrada, configurando no panel desta entidade o desprazamento na 
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dirección X cunha velocidade de 40 m/s, como se amosa na Figura 5.9. 

Para o caso de estudo do vehículo con alerón, poderase desactivar ou 
eliminar a rexión de celas que se encontran no seu interior. Para eliminar 
esta rexión de celas deberase acceder ao apartado superior Domain, na 
sección Zones e facer clic no botón Delete.... Na ventá emerxente que 
aparecerá na pantalla deberase seleccionar a rexión a eliminar e 
posteriormente farase clic no botón Delete (Figura 5.10). 

 
Figura 5.10: Panel para a eliminación da rexión de celas do interior do 

alerón. 

Modelo turbulento  

Setup > Models > Viscous  

 
Figura 5.11: Panel de configuración do modelo turbulento. 
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Deberase seleccionar o modelo turbulento de dúas ecuacións k-omega 
(SST), tal e como se observa na Figura 5.11. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. 

Solution > Initialization 

Dentro das opcións de Inicialización deberase escoller a 
inicialización híbrida (Hybrid Initialization). Este método de inicialización 
levará a cabo dez pseudo-iteracións en función das condicións de 
contorno impostas, conseguindo unha mellor inicialización do proceso 
de cálculo. Para executar a inicialización deberase facer clic no botón 
Initialize. O proceso de inicialización estará completado cando apareza na 
consola de comandos a mensaxe: Hybrid initialization is done. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
na pantalla un valor do residuo asociado a cada unha das ecuacións de 
goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que o usuario decida que os valores dos residuos son 
suficientemente baixos e estables. 

Solution > Monitors > Residual 

Deberase desactivar o criterio de converxencia (Convergence 
Criterion) seleccionando none no despregable, e para poder acceder a esta 
opción é preciso ter seleccionada a opción Show Advanced Options. 
Deberase asegurar que se atopan marcadas as opcións Print to Console e 
Plot no cadro Options (Figura 5.12). Desta forma o programa mostrará os 
valores na consola de comandos a medida que avanza o proceso iterativo 
e visualizará a gráfica da evolución dos residuais durante o cálculo. Para 
aceptar a configuración faga clic en OK. 
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Figura 5.12: Configuración dos residuais. 

Ademais da configuración xeral de converxencia dos residuais, para 
este estudo é fundamental avaliar a evolución do coeficiente 
aerodinámico de arrastre (CD) e do coeficiente de sustentación (CL), xa 
que son as principais variables de estudo que se están a analizar. Polo 
tanto, deberase determinar a evolución destes parámetros de xeito 
independente ao que lle ocorra aos residuais.  

Solution > Monitors > Report Plots 

 
Figura 5.13: Paneis de configuración dos coeficientes aerodinámicos. 

Facendo clic en New abrirase unha ventá emerxente na que, baixo o 
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apartado Selected Report Definitions, deberá facerse clic en New e 
seleccionar Force Report > Drag... para crear un novo monitor de 
coeficiente de arrastre, tal e como indican os paneis de configuración da 
Figura 5.13. Deberase seleccionar a entidade sobre a que se desexa avaliar 
o coeficiente, que neste caso é a superficie do vehículo e a superficie do 
alerón. Unha vez creado o monitor, este aparecerá no apartado Available 
Report Definitions da ventá Report Definitions, onde deberá ser seleccionado 
e engadido ao apartado Selected Report Definitions facendo clic no botón 
Add>>. 

Procederase do mesmo xeito para crear o monitor para o coeficiente 
de sustentación. 

Tendo en conta as definicións dos coeficientes aerodinámicos, co fin 
de evitar confusións coa área de referencia e a velocidade de referencia a 
empregar, é usual utilizar uns valores de área de referencia de 1 m², unha 
velocidade de referencia de 1 m/s e unha densidade de 2 kg/m³. Deste 
xeito, mediante o emprego destes valores de referencia os monitores 
creados mostrarán directamente o valor das forzas sobre a superficie en 
cuestión.  

Setup > Reference Values  

 
Figura 5.14: Panel de configuración dos valores de referencia. 
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Deberanse introducir os valores de referencia mencionados, tal e 
como amosa a Figura 5.14. 

Con este último paso finaliza o proceso de configuración do caso, así 
como a inicialización e a definición do modelo a resolver. Neste intre 
recoméndase gardar a simulación para non perder o traballo de 
configuración realizado.  

File > Write > Case&Data  

Deberase asignar un nome que identifique inequivocamente o caso 
en cuestión, por exemplo F1_Con_Alerón.cas. Comprobarase que 
efectivamente foron creados dous arquivos con extensión .cas e .dat na 
carpeta de traballo. Se por calquera razón se pecha o programa, poderase 
recuperar o traballo realizado ata o de agora lendo os arquivos 
F1_Con_Alerón.cas e F1_Con_Alerón.dat. 

Proceso iterativo 

Deberase fixar o número de iteracións que se levarán a cabo na etapa 
de cálculo.  

Solution > Run Calculation  

No apartado Number of Iterations deberase introducir o valor 1500, e 
a continuación facer clic no botón Calculate. Isto dará comezo ao calculo 
iterativo. Posto que o criterio de converxencia foi desactivado, o software 
levará a cabo as 1500 iteracións, salvo que o usuario decida paralo en vistas 
da evolución dos resultados. O proceso de cálculo poderase frear 
premendo nas teclas Ctr+C ou facendo clic no botón Stop situado na 
marxe inferior dereita do programa.  

Unha vez acadada a converxencia procederase a gardar os arquivos 
correspondentes ao caso calculado.  

File > Write > Case&Data  

Deberase ter especial coidado de non sobrescribir os arquivos 
gardados previamente. Para elo, aconsellase empregar un nome distinto 
que permita diferenciar o caso final. Deberá verificarse de novo que 

Análise dos resultados  
 

125 
 

ambos arquivos foron gardados no directorio de traballo. 

5.6. Análise dos resultados 

Deberá asegurarse unha correcta converxencia das simulacións 
realizadas, atendendo ao nivel dos residuais e facendo especial 
seguimento da estabilidade e converxencia dos monitores de forzas e 
coeficientes creados. Namentres non se acade a estabilidade de todos eles, 
non se poderá dar por finalizado o proceso de cálculo.  

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Os valores medios ou estacionarios das forzas de arrastre e 
sustentación para o caso con alerón e o caso sen alerón.  

• Gráfica de contornos de presión estática. Deberase empregar nos 
dous casos os mesmos valores mínimos e máximos da escala para 
comparar de xeito máis preciso os resultados acadados. 

• Gráfica de contorno de velocidade relativa adimensional. Esta 
variable deberá ser creada polo usuario e representarase no rango 
de 0 a 1 nos dous casos. 

• Gráfica de liñas de corrente creadas de xeito que se aprecien as 
diferencias no desprendemento da estela no dous casos. Queda 
aberta a posibilidade de crear vídeos os animacións das liñas de 
corrente. 

Para crear unha variable definida polo usuario deberase acceder na 
pestana User-Defined situada na marxe superior, no apartado Field 
Functions, facendo clic  no botón Custom.... Para crear a variable de 
velocidade relativa deberase seleccionar a magnitude da velocidade e 
dividila pola velocidade imposta na entrada (40 m/s). Seleccionando 
apropiadamente os límites da variable creada obterase unha comparativa 
de velocidades semellante á amosada na Figura 5.15. 

Coa axuda dos Rakes poderanse lanzar liñas de corrente en diferentes 
posicións, co fin de analizar o desprendemento da estela nos dous casos, 
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tal e como amosan as imaxes da Figura 5.15. 

 
Figura 5.15: Exemplo dos resultados a analizar neste capítulo, mostrados 

intencionadamente sen valores nin escala. 

5.7. Actividades propostas 

Como tarefa de entrega neste capítulo deberase crear un informe 
detallado onde se mostren os resultados indicados no apartado anterior 
para o caso do vehículo con alerón e para o caso do vehículo sen alerón, 
tanto os datos numéricos obtidos como as imaxes e contornos indicados. 

Deberanse comparar os resultados alcanzados nos dous casos, 
relacionando as imaxes obtidas cos datos numéricos das forzas calculadas 
para cada un deles. Todas estas comparativas deberán ser comentadas 
facendo uso dos coñecementos teóricos da materia. De xeito adicional 
deberase comentar o efecto que se produciría se, debido a unha rotura, 
desaparecese o alerón do vehículo cando este se atopa circulando nas 
condicións empregadas neste estudo. Ademais, deberase engadir un 
último apartado onde figuren as conclusións obtidas neste estudo. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. 

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, que serán indicados na sesión de prácticas da materia. 
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6. Fluxo compresible 
unidimensional nunha tobeira 
converxente-diverxente 

6.1. Obxectivos 

Os obxectivos fixados para a realización deste capítulo son os 
seguintes: 

• Ilustrar a posta en marcha e resolución dun fluxo axisimétrico e 
compresible ao seu paso por unha tobeira converxente-
diverxente. 

• Simular un fluxo compresible. 
• Calcular resultados para fluxo ideal (Inviscid). 
• Comparar resultados con diversos modelos. 

6.2. Fundamentos e descrición do 
problema 

O fluxo a través dunha tobeira converxente-diverxente é un dos 
problemas-tipo que se adoita utilizar para modelizar un fluxo compresible 
mediante ferramentas numéricas de CFD. A Figura 6.1 mostra a sección 
lonxitudinal dunha tobeira converxente-diverxente simétrica respecto do 
eixo horizontal. 
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A predición da onda de choque é unha das análises máis 
características do fluxo compresible e a descrición deste fenómeno 
constitúe un importante reto dentro desta disciplina da Mecánica de 
Fluídos. 

 
Figura 6.1: Forma de tobeira de Laval converxente-diverxente. 

A necesidade de resolver os grandes gradientes de presión que se 
xeran neste tipos de fluxos, condicionan o uso de esquemas numéricos 
especiais, así como de mallas moi finas con refinados graduais en zonas 
moi localizadas.  

O cálculo das tobeiras converxentes-diverxentes é de aplicación no 
eido da aerodinámica, posto que é frecuente empregalas en motores de 
foguetes. A xeometría destas tobeiras está deseñada de tal xeito que o 
fluxo subsónico na entrada se acelere ata acadar na garganta da tobeira 
condicións sónicas, e poida chegar a ser supersónico na parte diverxente 
da mesma. Dependendo da relación de presións na entrada e na saída, o 
fluxo pode ser subsónico durante todo o paso pola tobeira, pode acadar 
condicións sónicas na gorxa, e volver de novo a condicións subsónicas na 
zona diverxente, ou ben pasar a supersónico despois da gorxa. Neste 
último caso, se o fluxo acada condicións supersónicas, podería formarse 
unha onda de choque na zona diverxente, polo que o fluxo sairía 
subsónico, ou podería continuar supersónico ata a saída. Na Figura 6.2, 
resúmense todas estas posibilidades, mostrando as posibles evolucións da 
presión sobre o eixo da tobeira. 

A forma das tobeiras vén definida pola necesidade de acelerar o fluxo 
en condicións de fluxo subsónico e de fluxo supersónico. Para acelerar 
un fluxo subsónico é preciso reducir a sección de paso, por iso a súa 
xeometría é converxente, mentres que para acelerar un fluxo supersónico 

Entrada
Saída

Gorxa

Fundamentos e descrición do problema  
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é xusto ao revés, xa que é preciso aumentar a sección de paso. Este 
razoamento pode verse de xeito máis claro na Figura 6.3, onde se 
representa que é o que ocorre nunha sección converxente ou diverxente 
dependendo de si o fluxo é subsónico ou supersónico. 

 
Figura 6.2: Esquema de funcionamento das tobeiras converxentes-

diverxentes, xeometría, distribución de presións posibles e gasto másico. 
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Figura 6.3: Esquema de funcionamento en seccións converxentes e 
diverxentes, dependendo de se o fluxo é subsónico ou supersónico. 

Un xeito sinxelo de explicar esta inversión de tendencia é analizar a 
ecuación unidimensional para fluxo non viscoso que rexe este proceso,  a 
cal se pode expresar en función do número de Mach (Ma). De xeito que 
un número de Mach maior ou menor que a unidade, fai que se inverta o 
signo: 
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��2 − 1

 (6.1) 

Unha vez que se alcanzan as condicións de fluxo sónico na garganta 
da tobeira, o fluxo másico que pode pasar polo dispositivo queda 
bloqueado, é dicir, xa non aumenta máis aínda que se siga incrementando 
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a diferencia de presións entre a entrada e a saída, tal e como representan 
as situacións D a I da Figura 6.2.  

A onda de choque que se produce na zona diverxente da tobeira nos 
casos D e E da Figura 6.2, caracterízase por ser moi delgada, cun espesor 
da orde de micrómetros, a cal se comporta como unha descontinuidade 
do campo fluído. 

6.3. Xeometría 

A lonxitude total da tobeira (L) que se empregará neste estudo é 0.6 

m. O radio da entrada da tobeira ��1
2
� é 0.1m, e o da saída ��2

2
� é de 0.12m. 

O cociente entre a área da garganta e o radio da entrada é 0.5625. 

A forma exterior da tobeira definirase mediante unha serie de 
puntos, tal e como se observa na Figura 6.4. A separación entre cada 
punto é de 40 mm, e na Figura 6.4 especifícanse os diámetros 
correspondentes a cada posición. 

Posto que se trata dunha xeometría simétrica, deberá terse en conta 
que unicamente se resolverá a metade do dominio aquí presentado. 

 
Figura 6.4: Dimensións e forma do dominio a simular. 
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6.4. Mallado 

Neste caso empregarase unha malla completamente estruturada. 
Posto que para a realización desta malla non se teñen grandes esixencias 
en canto á calidade e á resolución da mesma, poderanse empregar as 
condicións de mallado automático de calquera programa de mallado. 

Deberase fixar a creación de 30 celas na rexión da entrada e na 
rexión de saída. Ademais, o tamaño das celas na dirección horizontal 
deberá ser variable, dentro do rango 2.5 mm a 10 mm, co fin de facilitar 
a adaptación das celas á curvatura da parede. En base a estes dous 
criterios, a dimensión vertical e horizontal das celas será variable ao longo 
da tobeira. Tal e como amosa a Figura 6.5, non existen variacións bruscas 
nin no tamaño nin na relación de aspecto das celas, polo que se verifica 
que a calidade da malla é boa. 

Deberán ser identificadas como entidades independentes as catro 
fronteiras do dominio, onde se impoñerán as condicións de contorno. 

 
Figura 6.5: Imaxe da malla final empregada. 

6.5. Configuración da simulación 

Abrir o programa Fluent  

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Configuración da simulación  
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Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 6.6). 

 
Figura 6.6: Ventá de configuración de Fluent Launcher. 

Importar/abrir a malla  

File > Read > Mesh  

Deberase empregar o explorador de arquivos para acceder dentro do 
directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa reporta na 
consola de comandos información básica sobre as características da 
mesma. Deberase comprobar que aparecen as entidades nas que se 
impoñerán as condicións de contorno. Neste caso deberase contar con 
cinco entidades: a entrada á tobeira, a saída, a parede exterior, o eixe 
central e as celas do interior. 

Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale):  

Setting Up Domain > Mesh > Scale...  
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Setup > General > Mesh > Scale...  

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta.  

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado:  

Setting Up Domain > Mesh > Check  

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done.  

Deberase comprobar tamén o tamaño da malla de cálculo:  

Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas. Se se empregaron os parámetros de mallado 
expostos anteriormente, deberase contar con 4500 celas rectangulares 
(quadrilateral cells), debido a que se empregaron 30 divisións na dirección 
radial e 150 na dirección axial.  

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla a ventá de visualización das 
diferentes partes da malla, permitindo visualizalas, tal e como se aprecia 
na  Figura 6.7. Para facer máis realista a visualización da mesma, deberase 
empregar a vista simétrica da malla. Para activar este modo de 
visualización deberase acceder na pestana View ao apartado Views..., que 
se atopa dentro da sección Display. Dentro da ventá emerxente, deberase 
seleccionar o eixe de simetría da malla dentro do apartado Mirror Planes 
(Figura 6.7), e seguidamente facer clic en Apply. 

Configuración da simulación  
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É importante identificar inequivocamente as diferentes rexións que 
compoñen o dominio, nas cales posteriormente se impoñerán as 
condicións de contorno. Para facilitar o manexo e o recoñecemento das 
diferentes partes da malla, poderanse ocultar e amosar as rexións que se 
desexen, seleccionando ou deseleccionando as entidades no apartado 
Surfaces e posteriormente facendo clic no botón Display. 

 
Figura 6.7: Visualización da malla. 

Definición do solver e dos modelos 

Setup > General 

No apartado 2D Space deberase cambiar a condición de Planar a 
Axisymmetric. O resto de condicións manterase tal e como a aparecen por 
defecto no programa:  Absolute no cadro de Velocity Formulation e Steady 
na sección de Time, tal e como recolle a Figura 6.8. 

Ademais, deberase activar a solución da ecuación da enerxía (Figura 
6.8): 

Setup > Models > Energy 

Deberase modificar o modelo turbulento seleccionado: 

Setup > Models > Viscous 
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Neste caso, posto que se desexa modelar un fluxo ideal, deberase 
seleccionar o modelo Inviscid, tal e como amosa a Figura 6.8. 

 
Figura 6.8: Configuración xeral do solver e dos modelos activados. 

 

Métodos de solución 

Solution > Methods 

Deberase verificar que o método de acoplamento presión-velocidade 
que está seleccionado sexa Coupled. Ademais, comprobarase que os 
esquemas de discretización aplicados sexan Least Squares Cell Based para 
o gradiente e Second Order Upwind para o resto de variables. 

Propiedades dos fluídos 

Setup > Materials 

Configuración da simulación  
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Figura 6.9: Configuración do material aire. 

O fluído de traballo é o aire (air), material que por defecto xa aparece 
recollido na lista de materiais. Neste caso modelarase a densidade do aire 
empregando a ecuación dos gases ideais. Os restantes parámetros 
deberán deixarse coas condicións que por defecto indica o programa 
(Figura 6.9).  

Condicións de operación  

Setup > Boundary Conditions > Operating Conditions...  

Neste caso fixarase como presión de operación 0 Pa. 

Posto que a presión absoluta é a suma da presión de operación e a 
presión manométrica, e en fluxos compresibles como o que estamos 
analizando o solver emprega os valores da presión absoluta, recoméndase 
poñer este valor a 0. Deste xeito poderase fixar o valor da presión absoluta 
en cada rexión do dominio e evitarase cometer erros nas tarefas de 
configuración. 

Condicións de contorno 

Setup > Boundary Conditions 

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. Independentemente dos 
nomes asignados a cada unha de elas, deberase contar polo menos coas 
seguintes entidades: 
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Nome Condición/Tipo 

Entrada Pressure Inlet 

Saída Pressure Outlet 

Parede Wall 

Eixe Axis 

Interior Interior 

 

Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto. Deberase verificar 
que, por exemplo, na entidade Eixe non é posible modificar ningún 
campo da súa condición de contorno. 

Na entrada da tobeira, no campo Gauge Total Pressure deberase 
introducir o valor 220000 Pa, e no campo Supersonic/Initial Pressure o valor 
210000 Pa. Na pestana Thermal introducirase o valor da temperatura do 
fluxo, que neste caso será de 300 K (Figura 6.10). 

 
Figura 6.10: Paneis de configuración das condicións de contorno. 
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Os valores de presión fixados na entrada determinarán as condicións 
do fluxo que entra no dominio de cálculo. A diferencia das dúas presións 
impostas (absoluta e relativa) empregaranse para determinar o número 
de Mach e a velocidade do fluxo na entrada, a cal será calculada, no caso 
do aire, segundo a expresión: 

�0
�

= (1 + 0.2��2)3.5 (6.2) 

A presión absoluta que existe á saída da tobeira é a presión 
atmosférica. Debido a que a presión de operación que se fixou 
previamente é de 0 Pa, na condición de contorno da saída deberase 
introducir este valor de presión no campo Gauge Pressure (100000 Pa 
aprox.). Na pestana Thermal da entidade da saída impoñerase tamén o 
valor de 300 K no campo Backflow Total Temperature (Figura 6.10). 

Deberá terse en conta que, segundo as condicións de presión 
impostas na entrada e na saída da tobeira, inicialmente a diferencia de 
presión entre os extremos da tobeira é de 0.12 MPa. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. Neste caso interesa inicializar todo o dominio de 
cálculo cos mesmos valores que foron asignados na condición de 
contorno da entrada. 

Solution > Initialization > Standard Initialization 

Dentro da opción de inicialización estándar (Standard Initialization) 
deberase escoller a entidade da entrada dentro do menú despregable do 
apartado Compute from. Deste xeito, o valor da compoñente axial da 
velocidade será imposto en todo o dominio en función da presión que foi 
seleccionada para a entrada, a cal estará máis próxima á solución final que 
unha velocidade nula en toda a rexión. Neste caso, dado que a presión 
manométrica utilizada na entrada é de 210000 Pa, a velocidade será de 
89.21 m/s. 

Para executar a inicialización deberá premerse no botón Initialize que 
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campo da súa condición de contorno. 

Na entrada da tobeira, no campo Gauge Total Pressure deberase 
introducir o valor 220000 Pa, e no campo Supersonic/Initial Pressure o valor 
210000 Pa. Na pestana Thermal introducirase o valor da temperatura do 
fluxo, que neste caso será de 300 K (Figura 6.10). 

 
Figura 6.10: Paneis de configuración das condicións de contorno. 
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Os valores de presión fixados na entrada determinarán as condicións 
do fluxo que entra no dominio de cálculo. A diferencia das dúas presións 
impostas (absoluta e relativa) empregaranse para determinar o número 
de Mach e a velocidade do fluxo na entrada, a cal será calculada, no caso 
do aire, segundo a expresión: 

�0
�

= (1 + 0.2��2)3.5 (6.2) 

A presión absoluta que existe á saída da tobeira é a presión 
atmosférica. Debido a que a presión de operación que se fixou 
previamente é de 0 Pa, na condición de contorno da saída deberase 
introducir este valor de presión no campo Gauge Pressure (100000 Pa 
aprox.). Na pestana Thermal da entidade da saída impoñerase tamén o 
valor de 300 K no campo Backflow Total Temperature (Figura 6.10). 

Deberá terse en conta que, segundo as condicións de presión 
impostas na entrada e na saída da tobeira, inicialmente a diferencia de 
presión entre os extremos da tobeira é de 0.12 MPa. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. Neste caso interesa inicializar todo o dominio de 
cálculo cos mesmos valores que foron asignados na condición de 
contorno da entrada. 

Solution > Initialization > Standard Initialization 

Dentro da opción de inicialización estándar (Standard Initialization) 
deberase escoller a entidade da entrada dentro do menú despregable do 
apartado Compute from. Deste xeito, o valor da compoñente axial da 
velocidade será imposto en todo o dominio en función da presión que foi 
seleccionada para a entrada, a cal estará máis próxima á solución final que 
unha velocidade nula en toda a rexión. Neste caso, dado que a presión 
manométrica utilizada na entrada é de 210000 Pa, a velocidade será de 
89.21 m/s. 

Para executar a inicialización deberá premerse no botón Initialize que 
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se atopa na marxe inferior. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
na pantalla un valor do residuo asociado a cada unha das ecuacións de 
goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que o usuario decida que os valores dos residuos son 
suficientemente baixos e estables. 

Solution > Monitors > Residual 

Deberase desactivar o criterio de converxencia (Convergence 
Criterion) seleccionando none no despregable, e para poder acceder a esta 
opción é preciso ter seleccionada a opción Show Advanced Options. 
Deberase asegurar que se atopan marcadas as opcións Print to Console e 
Plot no cadro Options. Desta forma o programa mostrará os valores na 
consola de comandos a medida que avanza o proceso iterativo e 
visualizará a gráfica da evolución dos residuais durante o cálculo. Para 
aceptar a configuración faga clic en OK. 

Con este último paso finaliza o proceso de configuración do caso, así 
como a inicialización e a definición do modelo a resolver. Neste intre 
recoméndase gardar a simulación para non perder o traballo de 
configuración realizado. 

File > Write > Case&Data 

Deberase asignar un nome que identifique inequivocamente o caso 
en cuestión, como por exemplo Tobera_1.cas. Comprobarase que 
efectivamente foron creados dous arquivos con extensión .cas e .dat na 
carpeta de traballo. Se por calquera razón  se pecha o programa, poderase 
recuperar o traballo realizado ata o de agora lendo os arquivos 
Tobera_1.cas e Tobera_1.dat. 

Proceso iterativo 

Deberase fixar o número de iteracións que se levarán a cabo na etapa 
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de cálculo. 

Solution > Run Calculation 

No apartado Number of Iterations deberase introducir o valor 2000, e 
no apartado Reporting Interval deberase fixar o valor 10, que será o 
intervalo de iteracións cada canto se actualizará o valor dos residuais na 
gráfica de evolución (Figura 6.11). A continuación facer clic no botón 
Calculate. Isto dará comezo ao calculo iterativo. 

 
Figura 6.11: Panel de configuración do proceso iterativo. 

COIDADO: É probable que durante o proceso de cálculo aparezan 
na consola de comandos mensaxes indicando diferentes tipos de erro, 
como avisos de Temperature limited, ou directamente se pare o proceso 
debido a que se produciu a diverxencia do cálculo (Divergence) ou ocorra 
algún outro error (Fatal Error). Calquera destas mensaxes é normal, xa 
que, de forma intencionada, cometeuse un pequeno erro na 
configuración, co fin de ilustrar a importancia da selección dos modelos 
empregados e do coñecemento do problema que se está a simular. 

Para comezar de novo co proceso de cálculo deberase abrir o arquivo 
gardado previamente (.cas e .dat). 

Dado que no problema que se está a simular a compresibilidade do 
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fluxo é un parámetro de especial importancia, deberase cambiar o tipo 
de solver de Pressure Based a Density Based no apartado Setup > General. 

Deberase introducir de novo no apartado Number of Iterations o valor 
de 2000 e facer clic no botón Calculate do apartado Setup > Run Calculation. 

Unha vez sexan executadas as 2000 iteracións, poderase apreciar na 
gráfica dos residuais que o proceso iterativo non foi capaz de chegar a 
unha solución estable (sen oscilacións e cun valor baixo dos residuais), tal 
e como se amosa na gráfica superior da Figura 6.12. 

 
Figura 6.12: Gráfica da evolución dos residuais durante o proceso de 

cálculo. 

Para intentar obter a converxencia, deberase fixar un esquema de 
primeiro orde para a resolución das ecuacións do fluxo. Para modificar 
este parámetro deberase acceder ao apartado Solution > Methods e escoller 
a opción First Order Upwind. A continuación deberanse executar 2000 
iteracións máis ata observar un descenso do valor dos residuais e 
posteriormente a súa estabilización, tal e como mostra a gráfica inferior 
da Figura 6.12.  

Unha vez acadada a converxencia procederase a gardar os arquivos 
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correspondentes ao caso calculado. 

File > Write > Case&Data 

Deberase ter especial coidado de non sobrescribir os arquivos 
gardados previamente. Para elo, aconsellase empregar un nome distinto 
que permita diferenciar o caso final. Deberá verificarse de novo que 
ambos arquivos foron gardados no directorio de traballo. 

6.6. Análise dos resultados 

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Gráfica de contornos do número de Mach no interior da tobeira. 

Coa representación do número de Mach no interior da tobeira 
poderase identificar en que se situación se atopa o fluxo de aire: 
subsónico, supersónico, etc., en base ao exposto no  apartado 6.2. A 
Figura 6.13 amosa un exemplo dos resultados acadados para as 
condicións de simulación seleccionadas. Para este caso, cun salto de 
presións de 120 kPa entre a entrada e a saída do dispositivo, os resultados 
amosan que a onda de choque prodúcese nunha rexión próxima á 
sección de saída, o que se corresponde coa situación E representada na 
Figura 6.2. 

• Gráfica do perfil lonxitudinal de presións na liña media (eixe). 

Para ver como varía a presión ao longo da tobeira deberá 
representarse a presión adimensionalizada, creando unha Custom field 
function, na que se divide a presión estática entre a presión da entrada 
(220000 Pa). Unha vez creada a función, dende o apartado Results > 
Plots/XY Plot, poderase crear a gráfica cos valores do coeficiente ao longo 
do eixe. É importante prestar atención a que os parámetros X Axis Function 
e Y Axis Function deste panel describen o eixe X e o eixe Y do gráfico, e 
non as coordenadas no interior da tobeira. Deberase seleccionar no 
apartado Y Axis Function a variable creada anteriormente, e deberase 
seleccionar a entidade correspondente ao eixe na apartado Surfaces. 
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Facendo clic no botón Plot obterase un gráfico semellante ao mostrado 
na Figura 6.13.  

Despois de visualizar a gráfica, poderanse gardar nun ficheiro os 
valores para poder tratalos externamente. Para isto deberá activarse a 
opción Write to file, e posteriormente facer clic no botón Write. O ficheiro 
creado con extensión .xy poderá abrirse en calquera editor de texto plano 
ou poderá ser inserido nun editor de folla de cálculo. 

 
Figura 6.13: Exemplo dos resultados deste capítulo. Os mapas amosados 

preséntanse intencionadamente sen valores nin escala. 

Vectores velocidade [m/s]

Contornos de número de Mach [-]

1

0

0.2

0.4

0.6

0.8

0 0.20.1 0.3 0.5 0.6 0.70.4
Posición

C
oe

fic
ie

nt
e 

de
 p

re
si

ón
 [-

]

Liña media

Actividades propostas  
 

145 
 

• Distribución da densidade do fluído ao longo da tobeira e 
verificación dos datos con expresións teóricas. 

Dado que o fluído se atopa a alta presión na entrada da tobeira, a 
densidade nese punto deberá ser alta. A medida que o fluído avanza pola 
tobeira e a súa presión vai diminuíndo producirase a súa expansión, 
aumentado a súa velocidade e reducindo a súa densidade. No punto no 
que se produce a onda de choque, o fluído recupera a densidade para o 
valor da presión de descarga, a presión atmosférica, polo que, analizando 
o mapa de contorno da densidade do aire poderase caracterizar o 
comportamento do fluxo no interior deste dispositivo. Deberanse extraer 
os valores de densidade a un lado e a o outro da onde choque, co fin de 
verificar estes datos coas predicións das fórmulas teóricas para o fluxo 
isoentrópico 1-D. 

• Análise da evolución dos vectores de velocidade despois do 
bloqueo sónico. Deberase crear unha gráfica cos vectores de 
velocidade en todo o dominio, prestando especial atención á 
rexión situada despois da onda de choque. Deberanse comparar 
os valores da velocidades antes e despois do bloqueo sónico. 
Adaptando os parámetros de visualización obterase unha gráfica 
semellante á mostrada na Figura 6.13. 

• Avaliar o fluxo másico que circula pola tobeira. 

Para obter o valor do fluxo másico deberase acceder ao apartado 
Results > Report > Fluxes, seleccionar a entrada na sección Boundaries, e 
facer clic no botón Compute. Aparecerá na consola de comandos o valor 
do fluxo másico na rexión seleccionada, sendo para o caso analizado de 
9.02 kg/s. 

6.7. Actividades propostas 

Como tarefa de entrega para este capítulo deberase repetir o proceso 
completo de simulación empregando diferentes relacións de presión 
entre a entrada e a saída, tal e como se recolle na seguinte táboa: 
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Facendo clic no botón Plot obterase un gráfico semellante ao mostrado 
na Figura 6.13.  

Despois de visualizar a gráfica, poderanse gardar nun ficheiro os 
valores para poder tratalos externamente. Para isto deberá activarse a 
opción Write to file, e posteriormente facer clic no botón Write. O ficheiro 
creado con extensión .xy poderá abrirse en calquera editor de texto plano 
ou poderá ser inserido nun editor de folla de cálculo. 
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Nome do caso 
Gauge Total 
Pressure (Pa) 

Supersonic/Initial 
Gauge Pressure (Pa) 

Tobera102kPa 102000 101000 

Tobera103.5kPa 103500 102000 

Tobera103.95kPa 103950 102000 

Tobera110kPa 110000 105000 

Tobera150kPa 150000 140000 

Tobera300kPa 300000 290000 

Tobera500kPa 500000 490000 

 

Como entrega deste capítulo deberase crear un informe onde se 
analicen os resultados acadados en todos os casos seguindo o seguinte 
esquema: 

• Contornos de número de Mach na tobeira. 

• Perfil lonxitudinal da presión adimensionalizada no eixe da 
tobeira. Deberase comparar o perfil obtido en todos os casos, 
identificando as diferentes situacións e indicando a que tipo de 
evolución se corresponde en base aos escenarios mostrados na 
Figura 6.2. 

• Caudal másico na saída da tobeira. Deberase representar nun 
gráfico o caudal másico adimensionalizado co valor máximo 
posible que se pode obter en función das presións impostas. 

O caudal máximo poderá calcularse coa expresión: 

�̇��� =
0.6847 �0 �∗

(��0)0.5  (6.3) 

onde  �0 representa a presión total na entrada, �∗ a área na garganta da 
tobeira, � a constante dos gases ideais e �0 a temperatura de 
estancamento na entrada, que para estes casos é de 300 K. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo de folla de cálculo. 
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Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 
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7. Simulación fluidodinámica do 
despegue dun foguete 

7.1. Obxectivos 

Os obxectivos fixados para a realización deste capítulo son os 
seguintes: 

• Resolver un problema numérico con dominios con partes móbiles 
mediante o emprego de mallas dinámicas. 

• Simular de xeito transitorio o movemento de despegue dun 
foguete. 

• Post-procesar unha simulación transitoria. 

7.2. Fundamentos e descrición do 
problema 

Os principios fundamentais nos que se basea o estudo do movemento 
dun foguete son similares aos abordados nos capítulos anteriores. As 
principais diferencias fronte aos casos previos son a velocidade de 
desprazamento, posto que o foguete móvese a moito maior velocidade 
que os vehículos analizados anteriormente, e a presencia dun fluxo de 
gases que é o responsable da propulsión deste dispositivo. Tal e como 
mostra a Figura 7.1, os gases expulsados cara abaixo polo foguete xeran 
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un empuxe na dirección contraria, o cal pode ser obtido a través da 
ecuación de conservación da cantidade de movemento aplicada ao 
volume de control definido polos gases produto da combustión que 
viaxan polo interior da tobeira de propulsión, que van evolucionando 
dende as condicións de remanso do interior da cámara de combustión ata 
a saída da tobeira. As condicións do fluxo de gases na saída da tobeira 
poderán ser calculadas supoñendo fluxo unidimensional e isoentrópico, 
de maneira similar aos cálculos abordados no capítulo anterior.  

 
Figura 7.1: Esquema do funcionamento dun foguete a reacción. 

As forzas e momentos presentes no despegue destes dispositivos son 
coñecidos e foron amplamente analizadas dende hai anos en diferentes 
estudos de investigación [26–28]. As ferramentas de CFD son empregadas 
acotío nas tarefas de optimización e deseño de novos compoñentes, así 
como en procesos de avaliación de parámetros xeométricos para 
condicións estacionarias de voo, aínda que son menos frecuentes na 
análise do proceso de despegue deste tipo de aeronaves [29–31]. 

Posto que a fluidodinámica realista do fluxo propulsor dun foguete 
é extremadamente complexa, a tarefa proposta para este capítulo terá 
como obxecto coñecer o movemento do foguete na etapa de despegue, 
sen necesidade de que os fluxos obtidos para a propulsión da aeronave 
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Xeometría  
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sexan estritamente fieis aos que suceden na realidade. 

7.3. Xeometría 

Para levar a cabo esta simulación empregarase unha única xeometría, 
a cal representa un foguete en posición de despegue vertical, tal e como 
amosa a Figura 7.2. O grado de realismo do vehículo empregado queda 
en mans do usuario, posto que, segundo os obxectivos fixados,  non é un 
factor fundamental para a simulación. Do mesmo xeito, poderase 
considerar que tanto o foguete como o dominio son simétricos con 
respecto ao plano central. 

 
Figura 7.2: Forma e dimensións (expresadas en [mm]) do dominio a 

simular. 
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Na parte dereita da Figura 7.2 recóllense as dimensións principais 
para reproducir este vehículo. Cabe destacar que é importante na 
realización desta xeometría que as catro rexións mostradas na Figura 7.2 
estean perfectamente delimitadas e identificadas. Cada unha delas deberá 
contar coa súa superficie propia que a separe do resto do dominio, co fin 
de poder configurar posteriormente as condicións da simulación que 
reproduzan os correspondentes movementos de cada rexión. 

Se para a realización da xeometría se emprega o módulo de Ansys, 
recoméndase utilizar a ferramenta Name Selection para identificar cada 
entidade. 

7.4. Mallado 

Posto que para a realización da malla que se empregará neste 
capítulo non existen grandes esixencias en canto á calidade e a resolución 
da mesma, poderanse empregar as condicións de mallado automático de 
calquera programa de mallado. 

A Figura 7.3 amosa unha vista en detalle da malla que se debería 
obter para unha correcta simulación. Todas as rexións deberán ser 
malladas empregando elementos cadrados ou rectangulares. No caso 
mostrado utilizouse un tamaño de cela de 2.5 m para a rexión máis 
afastada do foguete e un tamaño de 1.25 m para as celas da zona en 
contacto co mesmo. Deberá terse en conta o tamaño de cela empregado 
en cada rexión, pois será un parámetro clave para posteriormente 
configurar o movemento da malla coa metodoloxía Layering.  

Ao igual que se mencionou no apartado de xeometría, é fundamental 
que as catro rexións que compoñen o dominio de cálculo estean 
separadas en diferentes entidades.  
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Na parte dereita da Figura 7.2 recóllense as dimensións principais 
para reproducir este vehículo. Cabe destacar que é importante na 
realización desta xeometría que as catro rexións mostradas na Figura 7.2 
estean perfectamente delimitadas e identificadas. Cada unha delas deberá 
contar coa súa superficie propia que a separe do resto do dominio, co fin 
de poder configurar posteriormente as condicións da simulación que 
reproduzan os correspondentes movementos de cada rexión. 
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Figura 7.4: Ventá de configuración de Fluent Launcher. 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 7.4). 

Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
fin de aumentar a precisión do solver. A continuación debe escollerse 
como directorio de traballo unha carpeta que fose creada previamente 
(Working Directory) e logo facer clic en Start. 

Importar/abrir a malla  

File > Read > Mesh  

Deberase empregar o explorador de arquivos para acceder dentro do 
directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa reporta na 
consola de comandos información básica sobre as características da 
mesma. Debe verificarse que o número de nodos, caras e celas se 
corresponde cos da malla que se desexa empregar. Deberase comprobar 
que aparecen as entidades nas que se impoñerán as condicións de 
contorno. 
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Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale):  

Setting Up Domain > Mesh > Scale...  

Setup > General > Mesh > Scale...  

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta.  

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado:  

Setting Up Domain > Mesh > Check  

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Neste caso deberá terse en conta que, se previamente na 
fase de mallado a algunha das entidades se lles asignou a categoría de 
Interface, o programa mostrará unha mensaxe de advertencia na que se 
indica que estas rexións non están configuradas. Esta mensaxe deixará de 
aparecer cando o caso estea completamente configurado.  

Deberase comprobar tamén o tamaño da malla de cálculo:  

Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas.  

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla a ventá de visualización das 
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diferentes partes da malla, permitindo visualizalas, tal e como se aprecia 
na  Figura 7.5.  

 
Figura 7.5: Visualización da malla. 

É importante identificar inequivocamente as diferentes rexións que 
compoñen o dominio, nas cales posteriormente se impoñerán as 
condicións de contorno. Para facilitar o manexo e o recoñecemento das 
diferentes partes da malla, poderanse ocultar e amosar as rexións que se 
desexen, seleccionando ou deseleccionando as entidades no apartado 
Surfaces e posteriormente facendo clic no botón Display. 

Definición do solver  

Setup > General 

 
Figura 7.6: Configuración xeral do solver e dos modelos activados. 

Neste caso deberanse seleccionar a opción Pressure-Based no 
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apartado Type, Absolute no cadro de Velocity Formulation, Planar no 
apartado de 2D Space e Transient na sección de Time, tal e como recolle a 
Figura 7.6. 

Ademais, deberase activar a solución da ecuación da enerxía: 

Setup > Models > Energy 

Propiedades dos fluídos  

Setup > Materials  

O fluído de traballo é o aire (air), material que por defecto xa aparece 
recollido na lista de materiais. Neste caso proponse modelar a densidade 
dos gases de escape como se fose un gas ideal. Manterase o valor das 
restantes propiedades co valor asignado por defecto polo programa 
(Figura 7.7). 

Condicións de operación  

Setup > Boundary Conditions > Operating Conditions...  

Neste caso manterase o valor da presión de operación en 101325 Pa. 

 
Figura 7.7: Configuración do material aire. 
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Condicións de contorno 

Setup > Boundary conditions 

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. 

Independentemente dos nomes asignados a cada entidade, deberase 
verificar que cada rexión ten asignado o tipo (Type) que lle corresponda, 
segundo amosa o esquema da Figura 7.8. 

 
Figura 7.8: Tipos de condición de contorno nas diferentes rexións da 

malla. 

Neste caso manteranse por defecto as opcións das rexións con 
categoría de parede e de saída: Gauge Pressure 0 Pa. 

Na rexión correspondente coa saída dos gases do foguete, que ten 
asinado o tipo Velocity inlet, deberase impoñer unha velocidade de 3500 
m/s e unha temperatura dos gases de 3500K, tal e como amosa a Figura 
7.9. 

Ademais, as intercaras deberán definirse de maneira que se 
relacionen as entidades da parte superior, as da parte inferior, e as 
correspondentes ao lateral da caixa que contén o foguete, facendo un 
total de tres acoplamentos. Para configurar as intercaras deberase acceder 
ao apartado Setup > Mesh Interfaces. Dentro da ventá emerxente que 
aparecerá na pantalla estarán as entidades da malla que foron definidas 
co tipo Interface (Figura 7.9). Para definir as intercaras deberase facer clic 

Wall Pressure outlet

WallVelocity inlet

Interface

Symmetry

Interface

Symmetry
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non botón Auto Create, e o propio programa creará as interfaces de 
conexión entre as entidades presentes. Non obstante, tamén se poderá 
facer clic no botón Manual Create, e aparecerá unha nova ventá de 
configuración onde o usuario deberá seleccionar as entidades que 
pertencen a cada intercara. 

 
Figura 7.9: Condicións de contorno a modificar. 

Modelo turbulento  

Setup > Models > Viscous  

Deberase seleccionar o modelo turbulento de dúas ecuacións k-omega 
(SST), tal e como se observa na Figura 7.10. 
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facer clic no botón Manual Create, e aparecerá unha nova ventá de 
configuración onde o usuario deberá seleccionar as entidades que 
pertencen a cada intercara. 

 
Figura 7.9: Condicións de contorno a modificar. 

Modelo turbulento  

Setup > Models > Viscous  

Deberase seleccionar o modelo turbulento de dúas ecuacións k-omega 
(SST), tal e como se observa na Figura 7.10. 
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Figura 7.10: Panel de configuración do modelo turbulento. 

Malla dinámica 

Setup > Dynamic Mesh 

Para configurar o movemento de despegue do foguete, deberanse 
definir cinco rexións de movemento tipo piston-full, tal e como mostra a 
Figura 7.11. Estas cinco rexións correspóndense coa zona de fluído onde 
está o foguete e as catro interfaces que ten, dúas pola parte superior e 
outras dúas pola parte inferior. En canto aos parámetros que definen o 
movemento da caixa na que se atopa o foguete, a cal se desprazará como 
o movemento dun pistón, empregarase a ferramenta Layering para a 
creación e destrución da malla conforme avanza o bloque, e a ferramenta 
In-Cylinder para definir o movemento, empregando os parámetros que 
aparecen recollidos na Figura 7.11. En base a estes parámetros definirase 
o paso temporal que será empregado no proceso de cálculo. 
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Figura 7.11: Paneis de configuración da malla dinámica. 

Neste intre, previamente a facer unha previsualización do 
movemento da malla, deberase gardar o caso para non perder o traballo 
de configuración realizado ata o de agora: 

File > Write > Case 

Unha vez gardado o caso, antes de proceder a realizar o cálculo da 
simulación, procederase a visualizar o movemento da malla dinámica que 
foi programado, co fin de verificar que todos os parámetros impostos son 
os axeitados. Para executar esta visualización, dentro do apartado Setup > 
Dynamic Mesh, deberase facer clic no botón Preview Mesh Motion..., e 
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determinarase o número de pasos temporais que se deseña visualizar, por 
exemplo 20 pasos temporais (Figura 7.11). A continuación, coa malla 
mostrada na ventá de gráficos, deberá pulsarse o botón Preview. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. 

Solution > Initialization 

Dentro das opcións de Inicialización deberase escoller a 
inicialización híbrida (Hybrid Initialization). Este método de inicialización 
levará a cabo dez pseudo-iteracións en función das condicións de 
contorno impostas, conseguindo unha mellor inicialización do proceso 
de cálculo. Para executar a inicialización deberase facer clic no botón 
Initialize. O proceso de inicialización estará completado cando apareza na 
consola de comandos a mensaxe: Hybrid initialization is done. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
na pantalla un valor do residuo asociado a cada unha das ecuacións de 
goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que se acade a converxencia, a cal será avaliada segundo 
os criterios fixados por defecto no software. Deste xeito, posto que se trata 
dunha simulación en réxime transitorio, unha vez que se acade a 
converxencia en cada paso temporal da simulación, o programa pasará ao 
seguinte paso temporal, optimizando o número de iteracións que son 
necesarias realizar en cada time-step da simulación. 

 Solution > Monitors > Residual 

Deberanse manter os valores fixados por defecto para o criterio de 
converxencia. Ademais, deberase asegurar que se atopan marcadas as 
opcións Print to Console e Plot no cadro Options (Figura 7.12). Desta forma 
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o programa mostrará os valores na consola de comandos a medida que 
avanza o proceso iterativo e visualizará a gráfica da evolución dos residuais 
durante o cálculo. Para aceptar a configuración faga clic en OK. 

 
Figura 7.12: Configuración dos residuais. 

Proceso iterativo 

Solution > Run Calculation 

Na sección Number of Time Steps deberase introducir o número de 
pasos temporais que se desexan simular, que para este caso son 3600. 
Deberá manterse en 20 o número máximo de iteracións en cada time-step 
(Figura 7.13). 

O número de pasos temporais a resolver ven derivado dos parámetros 
de malla dinámica seleccionados. Neste caso fixouse na configuración un 
valor de 0.05° por cada paso temporal, polo que os 3600 pasos temporais 
se corresponden con 180° de xiro do pistón virtual, o cal rexerá o 
movemento do foguete desprazándose en sentido vertical en dirección 
ascendente.  

Para iniciar o proceso de cálculo deberase premer no botón Calculate. 

Nos casos de simulación en réxime transitorio, o aspecto do residuais 
é diferente ao dos casos en réxime estacionario. Dentro de cada paso 
temporal a evolución é semellante á dun caso estacionario, pero segundo 
avanza a simulación, o aspecto conxunto dos residuais de todos os pasos 
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temporais aseméllase máis a unha franxa que a unha converxencia usual, 
tal e como amosa a Figura 7.13. 

 
Figura 7.13: Configuración dos parámetros de cálculo e aspecto dos 

residuais en dous instantes da simulación. 

Unha vez finalizado o proceso de cálculo procederase a gardar o caso 
final: 

File > Write > Case&Data 

Deberase ter especial coidado de non sobrescribir os arquivos 
gardados previamente. Para elo, aconsellase empregar un nome distinto 
que permita diferenciar o caso final. Deberá verificarse de novo que 
ambos arquivos foron gardados no directorio de traballo. 

7.6. Análise dos resultados 

Antes de proceder á extracción dos resultados deberase comprobar  
que o nivel dos residuais en cada paso temporal acada valores axeitados, 
así como verificar a estabilidade da solución. 

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Gráfica de contornos de presión estática ao longo de todo o 
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despegue. 

• Gráfica de contornos da magnitude da velocidade ao longo de 
todo o despegue. 

• Gráficas de contornos da temperatura ao longo de todo o 
despegue. 

Para poder visualizar os resultados de forma máis clara, recoméndase 
crear vídeos ou animacións das diferentes gráficas de contornos. Para 
crear estes vídeos poderanse empregar diferentes opcións. 

A opción máis común sería empregar o sistema de creación de 
animacións do propio programa, no apartado Results > Animations, cuxo 
funcionamento está indicado no manual de usuario do programa. Esta 
ferramenta xera un arquivo unha vez que finaliza a simulación, pero non 
permite visualizar os resultados ata que remata o proceso de cálculo.  

Outro método de creación dos vídeos, que aínda que é menos 
directo, en ocasións pode resultar moi útil, é crear unha serie de 
comandos que se executan cada certo número de pasos temporais e que 
gardan unha imaxe dos resultados mentres a simulación vai avanzando. 
Deste xeito, este método permite visualizar os resultados a medida que se 
executa a simulación. 

 
Figura 7.14: Panel de configuración dos comandos e un exemplo de 

arquivo de comandos empregado. 

Para levar a cabo a configuración desta modalidade de obtención dos 
vídeos, deberase acceder  ao apartado Solution > Calculation Activities, onde 
se deberán crear os dez comandos que se amosan na Figura 7.14. Estes 
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comandos repiten varias veces tres pasos básicos que son: activar unha 
ventá gráfica, executar un arquivo con extensión .jou que levará a cabo a 
visualización dos contornos desexados e, por último, gardar a imaxe cun 
nome identificador. Un exemplo de arquivo de obtención de resultados 
con extensión .jou pode verse na Figura 7.14.  

A Figura 7.15 amosa un exemplo das gráficas nun instante dos vídeos 
obtidos.  

 

 
Figura 7.15: Exemplo dos resultados. Imaxes dun instante dos vídeos 

obtidos, mostradas intencionadamente sen valores nin escala. 
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7.7. Actividades propostas 

Como tarefa de entrega neste capítulo deberase crear un informe 
breve onde se analice a evolución dos tres contornos de resultados 
acadados, engadindo un apartado onde se analice a metodoloxía de 
mallas móbiles empregada, así como as conclusións extraídas deste 
estudo. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. Os vídeos ou animacións poderán ser entregados no 
seguintes formatos: .gif, .avi, .mp4, ou en calquera outro formato de vídeo.  

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 
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nome identificador. Un exemplo de arquivo de obtención de resultados 
con extensión .jou pode verse na Figura 7.14.  

A Figura 7.15 amosa un exemplo das gráficas nun instante dos vídeos 
obtidos.  

 

 
Figura 7.15: Exemplo dos resultados. Imaxes dun instante dos vídeos 

obtidos, mostradas intencionadamente sen valores nin escala. 
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7.7. Actividades propostas 

Como tarefa de entrega neste capítulo deberase crear un informe 
breve onde se analice a evolución dos tres contornos de resultados 
acadados, engadindo un apartado onde se analice a metodoloxía de 
mallas móbiles empregada, así como as conclusións extraídas deste 
estudo. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. Os vídeos ou animacións poderán ser entregados no 
seguintes formatos: .gif, .avi, .mp4, ou en calquera outro formato de vídeo.  

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 

  

166 
 

comandos repiten varias veces tres pasos básicos que son: activar unha 
ventá gráfica, executar un arquivo con extensión .jou que levará a cabo a 
visualización dos contornos desexados e, por último, gardar a imaxe cun 
nome identificador. Un exemplo de arquivo de obtención de resultados 
con extensión .jou pode verse na Figura 7.14.  

A Figura 7.15 amosa un exemplo das gráficas nun instante dos vídeos 
obtidos.  

 

 
Figura 7.15: Exemplo dos resultados. Imaxes dun instante dos vídeos 

obtidos, mostradas intencionadamente sen valores nin escala. 

Actividades propostas  
 

167 
 

7.7. Actividades propostas 

Como tarefa de entrega neste capítulo deberase crear un informe 
breve onde se analice a evolución dos tres contornos de resultados 
acadados, engadindo un apartado onde se analice a metodoloxía de 
mallas móbiles empregada, así como as conclusións extraídas deste 
estudo. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. Os vídeos ou animacións poderán ser entregados no 
seguintes formatos: .gif, .avi, .mp4, ou en calquera outro formato de vídeo.  

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 



169 
 

8. Fluxo interno con 
transferencia de calor: EGR-
cooler 

8.1. Obxectivos 

Os obxectivos fixados para a realización deste capítulo son os 
seguintes: 

• Analizar o funcionamento dun sistema de arrefriamento dun 
equipo de recirculación de gases de escape empregado en 
automoción (EGR-cooler, Exhaust Gas Recirculation cooler) 
mediante a utilización de ferramentas CFD. 

• Simular de forma combinada o fluxo de dous fluídos diferentes: 
gases de escape e líquido refrixerante. 

• Avaliar a importancia das propiedades dos materiais empregados 
nas simulacións, mediante a caracterización das propiedades dos 
fluídos considerándoas funcións da temperatura. 

• Empregar paredes con espesor virtual como xeito para reducir o 
custe computacional da simulación. 

• Determinar condicións de operación realistas para a simulación, 
empregando coñecementos específicos de motores de 
automoción. 
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8.2. Fundamentos e descrición do 
problema 

Un dos principais problemas dos motores de combustión é a 
contaminación que producen os gases de escape, sendo os hidrocarburos 
(HC), o monóxido de carbono (CO), a materia particulada (PM) e os 
óxidos de nitróxeno (NOx) os máis importantes. Os catalizadores e filtros 
de partículas diminúen de xeito controlado os tres primeiros, pero é 
preciso empregar algún sistema adicional para reducir os óxidos de 
nitróxeno. 

O sistema EGR (Exhaust Gas Recirculation) é a principal técnica para 
controlar as emisións de NOx nos motores de combustión interna. É un 
sistema que consiste en introducir parte dos gases de escape no colector 
de admisión. Coa recirculación dos gases de escape redúcese a 
temperatura da cámara de combustión conseguindo así unha sensible 
diminución na formación dos óxidos de nitróxeno (NOx), en proporcións 
de ata un 60%. Os gases de escape son inertes, isto é, non reaccionan co 
combustible ao introducilos no cilindro, polo que inhiben as reaccións 
químicas de combustión e conseguen unha atmosfera máis pobre de 
osíxeno que dá lugar a unha combustión menos quente. A proporción de 
gases recirculados (dun 5 a un 15%) dependen basicamente do réxime e 
da carga do motor. Un proceso de combustión normal vólvese nun 
proceso de combustión lenta ao aumentar a porcentaxe de gases 
recirculados. Mesmo se pode dar unha combustión incompleta ou un 
fallo do aceso do combustible se superamos o límite superior de 
operación. 

Os sistemas EGR empregáronse para reducir as emisións de óxidos 
de nitróxeno dos motores de combustión interna dende fai máis de vinte 
anos. Foron introducidos por primeira vez en motores americanos na 
década dos 70. Eran sistemas moi sinxelos que nun principio constaban 
unicamente dunha válvula e dos condutos necesarios para comunicar o 
colector de escape co de admisión, a través de sinxelos orificios 
practicados nos devanditos colectores. Co fin de reducir as emisións 
contaminantes as novas normativas anticontaminación obrigaron aos 
fabricantes de vehículos a buscar solucións cada vez máis esixentes para a 
minimización das emisións de NOx, é por iso polo que nos últimos anos 
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foron deseñadas moitas formas diferentes para recircular os gases de 
escape. Nos motores diésel é onde máis relevancia conseguiron na 
actualidade, xa que estes motores emiten maiores cantidades de NOx por 
quilómetro e o seu emprego é cada vez maior, sobre todo se se analiza o 
transporte de pasaxeiros por estrada. 

A activación do sistema EGR e a cantidade de gases de escape que 
deben ser enviados ao colector de admisión, son controladas pola 
unidade de control do motor tendo en conta o réxime do motor (rpm), 
o caudal de combustible inxectado, o caudal de aire aspirado, a 
temperatura do motor e a presión de traballo [32]. 

Pódense facer varias clasificacións dos sistemas EGR, en función do 
modo de recirculación, da temperatura, da súa configuración e da 
presión. 

Clasificación en función do modo de recirculación: 

• EGR interno: non pode falarse estritamente de recirculación dos 
gases de escape, senón que por medio da actuación dunha válvula 
de escape ou unha válvula especial, os gases produto da 
combustión non conseguen saír do cilindro durante a carreira de 
escape, ou son devoltos ao interior do cilindro durante a carreira 
de admisión. 

• EGR externo: os gases son devoltos ao interior do motor a través 
dunha ruta externa ao sistema. Para os motores con 
turbocompresor e refrixerador existen dúas opcións importantes 
para esta ruta: que os gases de escape despois de mover a turbina 
sexan devoltos a un lugar situado antes do compresor, ou que os 
gases de escape que non pasan pola turbina sexan devoltos ao 
colector de admisión situado despois do compresor e do 
refrixerador. A maioría dos sistemas actuais son externos xa que 
teñen a vantaxe de que tanto o turbocompresor como o 
refrixerador non están expostos ás partículas, aos hidrocarburos e 
aos sulfatos presentes nos gases de escape.  

Clasificación en función da temperatura: 

• EGR quente: os gases de escape son recirculados sen ser 
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arrefriados, producíndose un incremento da temperatura na 
entrada do cilindro. 

• EGR de arrefriado total: os gases de escape arrefríanse mediante 
un intercambiador aire-auga antes de ser mesturados coa carga 
fresca á entrada. Neste caso, a humidade presente nos gases de 
escape pode condensar e as gotas de auga que resultan poden 
producir efectos indesexables no cilindro. 

• EGR refrixerado parcialmente: para evitar a condensación da 
auga, a temperatura dos gases de escape mantense por enriba do 
punto de condensación. Isto mellora a eficacia do EGR reducindo 
aínda máis a temperatura de combustión e por tanto reduce as 
emisións de NOx a elevadas cargas. Intensificar a refrixeración dos 
gases de escape no intercambiador EGR non ten practicamente 
efectos nas emisións de fumes e de NOx a cargas baixas, pero 
incrementa as emisións de HC e de CO. Polo tanto, para controlar 
estas emisións será necesario instalar un by-pass no 
intercambiador que evite o paso de todo ou parte dos gases 
recirculados polo intercambiador, dependendo da carga e da 
velocidade. Son os denominados sistemas EGR-cooler. 

Clasificación segundo a súa configuración: 

• Sistema LR (Long rout system): nun sistema LR a caída de presión 
na entrada e o estancamento de presión dos gases de escape 
permiten a súa recirculación. Os gases de escape saen cunha 
velocidade que xera un pequeno estancamento da presión, que 
combinado coas baixas presións no colector de entrada, dá lugar 
a un gradiente de presións que facilita a entrada da mestura no 
motor. Todo isto tradúcese nun aumento do par e da velocidade 
do motor.  

• Sistema SR (Short route system): estes sistemas difiren 
principalmente do anterior no método usado. Nestes créase unha 
diferenza positiva de presións que permite a recirculación dos 
gases de escape, fronte ao anterior onde esa circulación 
conséguese por depresión no colector de aspiración. Outra forma 
de controlar o cociente de EGR é usando unha turbina VNT 
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(variable nozzle turbine). A maioría dos sistemas VNT só teñen unha 
entrada, o que reduce enormemente a eficiencia debido á 
pulsación que se orixina no escape. 

Clasificación en base á presión: 

• De baixa presión: o EGR sitúase entre a entrada da turbina e a 
saída do compresor. Mediante este sistema é posible traballar en 
zonas de alta carga cunha importante redución de NOx. Con todo, 
aparecen unha serie de problemas que inflúen na vida útil do 
EGR, como temperaturas demasiado baixas  que dan lugar a 
procesos de condensación, ou o bloqueo do propio 
intercambiador debido á deposición de materia particulada. 

• De alta presión: o EGR sitúase entre a saída da turbina e a entrada 
do compresor. Neste sistema, aínda que é posible traballar na 
rexión de alta carga, o dosado diminúe e o consumo de fuel 
aumenta de forma importante. 

Nos últimos anos, co fin de aumentar a eficiencia do sistema EGR, 
non é suficiente coa recirculación de gases, senón que os gases de escape 
recirculados deber ser arrefriados antes de entrar de novo na admisión. 
Isto realízase mediante un intercambiador de calor, arrefriador ou cooler, 
que se encarga de arrefrialos utilizando o fluído do sistema de 
refrixeración, e que é o elemento máis sensible do sistema de reciculación 
gases de escape. 

Hoxe en día é común empregar ferramentas CFD para a simulación 
de EGR coolers [33] co fin de mellorar o seu comportamento fronte a 
diferentes problemas, como o ensuciamento provocado pola deposición 
da feluxe presente nos gases de escape [34–36], ou o risco de que se 
produza a ebulición do refrixerante [37]. 

8.3. Xeometría 

Neste capítulo detállase a creación dunha única xeometría 
tridimensional que representa un intercambiador de calor do tipo carcasa 
e tubos, que é empregado de forma común na industria en xeral, e neste 
caso preséntase coas dimensións e especificacións tipicamente 
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entrada, o que reduce enormemente a eficiencia debido á 
pulsación que se orixina no escape. 

Clasificación en base á presión: 

• De baixa presión: o EGR sitúase entre a entrada da turbina e a 
saída do compresor. Mediante este sistema é posible traballar en 
zonas de alta carga cunha importante redución de NOx. Con todo, 
aparecen unha serie de problemas que inflúen na vida útil do 
EGR, como temperaturas demasiado baixas  que dan lugar a 
procesos de condensación, ou o bloqueo do propio 
intercambiador debido á deposición de materia particulada. 

• De alta presión: o EGR sitúase entre a saída da turbina e a entrada 
do compresor. Neste sistema, aínda que é posible traballar na 
rexión de alta carga, o dosado diminúe e o consumo de fuel 
aumenta de forma importante. 

Nos últimos anos, co fin de aumentar a eficiencia do sistema EGR, 
non é suficiente coa recirculación de gases, senón que os gases de escape 
recirculados deber ser arrefriados antes de entrar de novo na admisión. 
Isto realízase mediante un intercambiador de calor, arrefriador ou cooler, 
que se encarga de arrefrialos utilizando o fluído do sistema de 
refrixeración, e que é o elemento máis sensible do sistema de reciculación 
gases de escape. 

Hoxe en día é común empregar ferramentas CFD para a simulación 
de EGR coolers [33] co fin de mellorar o seu comportamento fronte a 
diferentes problemas, como o ensuciamento provocado pola deposición 
da feluxe presente nos gases de escape [34–36], ou o risco de que se 
produza a ebulición do refrixerante [37]. 

8.3. Xeometría 

Neste capítulo detállase a creación dunha única xeometría 
tridimensional que representa un intercambiador de calor do tipo carcasa 
e tubos, que é empregado de forma común na industria en xeral, e neste 
caso preséntase coas dimensións e especificacións tipicamente 
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empregadas en automoción. Na Figura 8.1 poden verse as dimensións 
básicas (expresadas en milímetros) e o aspecto final do intercambiador 
empregado para esta tarefa. 

Neste tipo de intercambiador o fluído refrixerante vai polo exterior 
dos tubos, e o gas de escape, que é o fluído quente, circula polo interior 
dos mesmos. Neste caso o intercambiador está formado por nove tubos 
de 9 mm de diámetro e 200 mm de lonxitude, que son os elementos onde 
se producirá o intercambio de calor entre ambos fluídos. Nesta xeometría 
non se contempla o espesor do metal dos tubos, e traballarase unicamente 
con superficies, polo que o metal correspondente ás paredes dos tubos 
será simulado a través de espesores virtuais.  

Mantendo todas as dimensións indicadas na Figura 8.1 agás unha 
delas, poderanse crear diferentes xeometrías. Por exemplo, se se modifica 
a lonxitude dos tubos e se manteñen o resto de parámetros, poderanse 
crear tantos intercambiadores como lonxitudes de tubo se desexe avaliar. 
Deste xeito, mediante a xeración de diferentes dispositivos, poderase 
avaliar o efecto da xeometría nos resultados finais acadados. 

 
Figura 8.1: Dimensións do EGR-cooler [mm] e detalles do dominio a 

simular. 

Para poder impoñer posteriormente as condicións de contorno, é 
importante identificar de antemán as entradas, as saídas e as demais zonas 
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do dispositivo de xeito inequívoco. Se se emprega o módulo de Ansys para 
a realización da xeometría, poderase levar a cabo esta identificación coa 
ferramenta Name Selection. 

8.4. Mallado 

Á hora de levar a cabo a creación da malla deberase ter en conta que 
neste caso estase a traballar cunha xeometría tridimensional, polo que é 
necesario prestar especial atención aos parámetros de mallado 
empregados, co propósito de obter unha malla de cálculo cuxa extensión 
non exceda os valores máximos manexables polo equipo de traballo no 
que se realizará a simulación. 

Para a creación desta malla deberase empregar maioritariamente un 
mallado estruturado, agás nas rexións do volume que rodea aos tubos. 
Para a creación da malla dos tubos empregase un mallado con celas 
prismáticas nas paredes, engadindo 15 celas na periferia dos tubos, tal e 
como pode apreciarse na Figura 8.2. Na dirección lonxitudinal o tamaño 
das celas dos tubos é constante. 

 
Figura 8.2: Detalles da malla empregada. 
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Unha vez realizada a malla das rexións estruturadas, asegurando que 
os nomes das rexións que teñen fluídos diferentes quedan claramente 
identificadas, procederase ao mallado do volume comprendido entre os 
tubos e a carcasa exterior. Nesta rexión partirase de celas prismáticas na 
superficie dos tubos que servirán de base para a creación das celas 
tetraédricas que encherán o volume. 

Empregando unha metodoloxía de mallado similar a esta, deberase 
obter unha malla cun número total de celas que deberá estar na orde das 
300000. 

8.5. Configuración da simulación 

Abrir o programa Fluent  

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

 
Figura 8.3: Ventá de configuración de Fluent Launcher. 

Outro xeito é executar a icona do programa, se se dispón de acceso 
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directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 8.3). 

Posto que o problema vai ser abordado de xeito tridimensional, debe 
seleccionarse Dimension: 3D. Debe marcarse a opción Double Precision co 
fin de aumentar a precisión do solver. A continuación debe escollerse 
como directorio de traballo unha carpeta que fose creada previamente 
(Working Directory) e logo facer clic en Start. 

Importar/abrir a malla  

File > Read > Mesh  

Deberase empregar o explorador de arquivos para acceder dentro do 
directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa reporta na 
consola de comandos información básica sobre as características da 
mesma. Deberase comprobar que aparecen as entidades nas que se 
impoñerán as condicións de contorno. 

Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale):  

Setting Up Domain > Mesh > Scale...  

Setup > General > Mesh > Scale...  

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta.  

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado:  
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Setting Up Domain > Mesh > Check  

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Pola contra, se o software detecta posibles fallos, amosará 
unha ventá emerxente na que se reporta o erro. 

Deberase comprobar tamén o tamaño da malla de cálculo:  

Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas. Se se empregaron os mesmos parámetros que 
se indicaron na etapa de mallado, deberase contar con aproximadamente 
300000 celas. 

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla a ventá de visualización das 
diferentes partes da malla, permitindo visualizalas, tal e como se aprecia 
na  Figura 8.4.  

 
Figura 8.4: Visualización da malla. 

É importante identificar inequivocamente as diferentes rexións que 
compoñen o dominio, nas cales posteriormente se impoñerán as 
condicións de contorno. Para facilitar o manexo e o recoñecemento das 
diferentes partes da malla, poderanse ocultar e amosar as rexións que se 
desexen, seleccionando ou deseleccionando as entidades no apartado 
Surfaces e posteriormente facendo clic no botón Display. 
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Definición do solver e dos modelos 

Setup > General 

Deberase seleccionar a condición Pressure Based no apartado Type, 
Absolute na sección Velocity Formulation e Steady no cadro de Time, tal e 
como amosa a Figura 8.5. 

Posto que nesta simulación é fundamental simular os procesos de 
transferencia de calor, deberase activar a solución da ecuación da enerxía 
(Figura 8.5): 

Setup > Models > Energy 
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Setting Up Domain > Mesh > Check  

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Pola contra, se o software detecta posibles fallos, amosará 
unha ventá emerxente na que se reporta o erro. 

Deberase comprobar tamén o tamaño da malla de cálculo:  

Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas. Se se empregaron os mesmos parámetros que 
se indicaron na etapa de mallado, deberase contar con aproximadamente 
300000 celas. 

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla a ventá de visualización das 
diferentes partes da malla, permitindo visualizalas, tal e como se aprecia 
na  Figura 8.4.  

 
Figura 8.4: Visualización da malla. 

É importante identificar inequivocamente as diferentes rexións que 
compoñen o dominio, nas cales posteriormente se impoñerán as 
condicións de contorno. Para facilitar o manexo e o recoñecemento das 
diferentes partes da malla, poderanse ocultar e amosar as rexións que se 
desexen, seleccionando ou deseleccionando as entidades no apartado 
Surfaces e posteriormente facendo clic no botón Display. 
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Métodos de solución 

Solution > Methods 

Deberase cambiar o esquema de discretización das ecuacións de 
cantidade de movemento, de turbulencia e de enerxía a QUICK 
(Quadratic Upwind Interpolation for Convection Kinematics), xa que é o máis 
axeitado para a resolución de fluxos con mallas estruturadas (Figura 8.5). 

Propiedades dos fluídos  

Para esta simulación empregaranse dous fluídos: o gas de escape e o 
líquido de refrixeración. Xa que ambos fluídos non aparecen na base de 
datos de Fluent, deberase buscar información sobre as propiedades destes 
materiais. Do mesmo xeito, deberase obter información das propiedades 
dos metais que forman as paredes do dispositivo. 

Unha vez atopada a información, deberase introducir no apartado 
Setup > Materials. 

 
Figura 8.6: Configuración do material correspondente aos gases de 

escape. 
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Neste caso proponse modelar a densidade dos gases de escape como 
se fose un gas ideal incompresible. O calor específico, a condutividade 
térmica e a viscosidade deste fluído calcularase empregando polinomios 
en función da súa temperatura, tal e como amosan os paneis de 
configuración da Figura 8.6. 

De xeito análogo, para o líquido refrixerante empregarase unha 
viscosidade constante, mentres que a densidade, o calor específico e a 
condutividades será determinados en función da temperatura. 

Condicións de operación 

Setup > Boundary Conditions > Operating Conditions... 

Neste caso manterase o valor da presión de operación en 101325 Pa. 

Condicións de contorno 

Setup > Boundary Conditions 

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. Independentemente dos 
nomes asignados a cada unha de elas, deberase contar polo menos coas 
seguintes entidades: 

Nome Condición/Tipo 

Entradas Mass Flow-Inlet 

Saídas Outflow 

Paredes Wall (No slip) 

Interior Interior 

 Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto. Deberá terse en conta 
que tanto nas entradas coma nas saídas deberán terse dúas entidades, 
unha para cada un dos fluídos empregados na simulación. 

Con respecto aos valores a empregar, deberanse buscar en estudos 
similares valores realistas das condicións de traballo destes dispositivos, 
tanto de temperaturas como de caudais típicos. A modo de orientación, 
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no caso do refrixerante o fluxo de líquido deberá estar en torno aos 0.25 
kg/s cunha temperatura arredor dos 90°C. No caso do gas de escape, o 
caudal poderá ser próximo aos 0.015 kg/s, cunha temperatura de 500°C.  

A configuración das condicións de contorno das entidades interiores 
manterase por defecto segundo as seleccionadas polo programa. 

Nas entidades relativas ás paredes dos tubos e das superficies de 
conexión entre os tubos e as seccións de entrada e saída, será preciso 
determinar o espesor virtual destas paredes. En cada unha destas 
entidades deberase acceder á pestana Thermal da configuración das 
condicións de contorno, onde se deberá impoñer o espesor da parede no 
cadro Wall thickness e o material empregado para esa parede na sección 
Material Name. Tipicamente o grosor das paredes dos tubos dun EGR 
cooler estará en torno aos 0.25 mm e o material será aceiro.  

No caso das paredes exteriores, poderase impoñer un fluxo de 
convección ao ambiente. Tipicamente os valores para esta convección 
estarán no rango de 25 W/m²K para o coeficiente de convección e de 
90°C para a temperatura, que son as condicións que poden atoparse nas 
inmediacións do motor do vehículo. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. 

Solution > Initialization 

Dentro das opcións de Inicialización deberase escoller a 
inicialización híbrida (Hybrid Initialization). Este método de inicialización 
levará a cabo dez pseudo-iteracións en función das condicións de 
contorno impostas, conseguindo unha mellor inicialización do proceso 
de cálculo. Para executar a inicialización deberase facer clic no botón 
Initialize. O proceso de inicialización estará completado cando apareza na 
consola de comandos a mensaxe: Hybrid initialization is done. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
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na pantalla un valor do residuo asociado a cada unha das ecuacións de 
goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que o usuario decida que os valores dos residuos son 
suficientemente baixos e estables. 

Solution > Monitors > Residual 

Deberase desactivar o criterio de converxencia (Convergence 
Criterion) seleccionando none no despregable, e para poder acceder a esta 
opción é preciso ter seleccionada a opción Show Advanced Options. 
Deberase asegurar que se atopan marcadas as opcións Print to Console e 
Plot no cadro Options. Desta forma o programa mostrará os valores na 
consola de comandos a medida que avanza o proceso iterativo e 
visualizará a gráfica da evolución dos residuais durante o cálculo. Para 
aceptar a configuración faga clic en OK. 

Con este último paso finaliza o proceso de configuración do caso, así 
como a definición do modelo a resolver. Neste intre recoméndase gardar 
a simulación para non perder o traballo de configuración realizado.  

File > Write > Case&Data  

Deberase asignar un nome que identifique inequivocamente o caso 
en cuestión, tendo en conta as diferentes configuracións de 
intercambiadores que se van simular, por exemplo EGR_200mm.cas. 
Comprobarase que efectivamente foron creados dous arquivos con 
extensión .cas e .dat na carpeta de traballo. Se por calquera razón se pecha 
o programa, poderase recuperar o traballo realizado ata o de agora lendo 
os arquivos EGR_200mm.cas e EGR_200mm.dat. 

Proceso iterativo 

Deberase fixar o número de iteracións que se levarán a cabo na etapa 
de cálculo. 

Solution > Run Calculation 

No apartado Number of Iterations deberase introducir o valor 2000, e 
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a continuación facer clic no botón Calculate. Isto dará comezo ao calculo 
iterativo. Posto que o criterio de converxencia foi desactivado, o software 
levará a cabo as 2000 iteracións, salvo que o usuario decida paralo en vistas 
da evolución dos resultados. O proceso de calculo poderase frear 
premendo nas teclas Ctr+C ou facendo clic no botón Stop situado na 
marxe inferior dereita do programa. 

Unha vez acadada a converxencia procederase a gardar os arquivos 
correspondentes ao caso calculado. 

File > Write > Case&Data 

Deberase ter especial coidado de non sobrescribir os arquivos 
gardados previamente. Para elo, aconsellase empregar un nome distinto 
que permita diferenciar o caso final. Deberá verificarse de novo que 
ambos arquivos foron gardados no directorio de traballo. 

8.6. Análise dos resultados 

Debe asegurarse unha correcta converxencia das simulacións 
realizadas, atendendo ao nivel dos residuais e facendo especial 
seguimento do valor do balance térmico global do dispositivo. 

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Os valores globais do funcionamento dos dispositivo: 
temperaturas de saída dos fluídos, eficiencia térmica do 
intercambiador, potencia intercambiada entre ambas correntes e 
perdas de carga nos dous fluxos. 

• Análise dos campos de velocidades coa intención de identificar as 
rexións de remanso ou mal refrixeradas polo líquido, nas cales é 
probable que se produza a ebulición do fluído. Visualización de 
remuíños, liñas de corrente, etc., coa posibilidade de crear vídeos 
ou animacións se fose preciso. 

• Análise das temperaturas nas paredes das diferentes partes do 
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intercambiador. 

A Figura 8.7 amosa un exemplo das gráficas de resultados que se 
deberán obter neste capítulo. 
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8.7. Actividades propostas 

Como tarefa de entrega neste capítulo deberase crear un informe 
detallado onde se mostren os resultados indicados no apartado anterior. 

Deberá repetirse o estudo para polo menos unha lonxitude do 
intercambiador diferente á orixinal. Ademais, poderase estender a análise 
empregando outras condutividades térmicas do metal empregado ou 
variando as propiedades dos fluídos. Deberanse especificar de xeito claro 
os cambios propostos, vinculándoos  ademais cos resultados acadados 
para cada situación.  

Todas as comparativas que se inclúan no informe deberán ser 
comentadas facendo uso dos coñecementos teóricos da materia, e 
deberase engadir un último apartado onde figuren as conclusións obtidas 
neste estudo. 

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. Queda aberta a posibilidade de entregar un vídeo 
ou animación (inserido no propio informe ou achegado externamente) 
no que se poida determinar de xeito claro as rexións onde existe maior 
risco de ebulición do refrixerante. 

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 
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9. Fluxo interno nun sistema de 
inxección common-rail 

9.1. Obxectivos 

Os obxectivos fixados para a realización deste capítulo son os 
seguintes: 

• Simular, resolver e analizar mediante a utilización de CFD a 
inxección de combustible mediante un sistema common-rail. 

• Caracterizar as propiedades do combustible a simular, así como as 
presións de operación do sistema common-rail, procurando o 
establecemento de condicións de operación realistas para a 
simulación. 

• Implantar un ciclo de funcionamento transitorio mediante a 
configuración da apertura e do peche dos inxectores, 
empregando rutinas externas en linguaxe journal e scheme.  

• Estudar e analizar os tempos, caudais e fluxos másicos inxectados 
durante un ciclo completo de traballo do sistema. 

9.2. Fundamentos e descrición do 
problema 

Os sistemas common-rail son sistemas de inxección de combustible 
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empregados en motores de combustión diésel en automoción. Este 
sistema emprega un conduto común que traballa a altas presións e 
distribúe o combustible a todos os inxectores do motor. A apertura e 
peche dos inxectores está controlada de xeito electrónico pola unidade 
de control do motor (ECU, Engine Control Unit). O emprego de presións 
elevadas nos pequenos orificios dos inxectores permite acadar mellores 
pulverizacións do combustible, que melloran o seu proceso de mesturado 
co aire, conseguindo unha mellor combustión. As principais vantaxes 
deste sistema son unha maior potencia, un mellor rendemento do motor 
e menores niveis sonoros. 

O esquema da disposición habitual e compoñentes principais dun 
sistema common-rail pode verse na Figura 9.1.  

 
Figura 9.1: Esquema da instalación e principais compoñentes dun 

sistema common-rail. 

Aínda que é un sistema que foi deseñado por primeira vez na década 
dos anos 60, o seu uso comezou a popularizarse a finais da década dos 90. 
Durante os últimos anos esta tecnoloxía de inxección sufriu constantes 
avances e melloras [38–40], e na actualidade está presente na gran 
maioría de motores diésel de automoción [41]. 

9.3. Xeometría 

A imaxe da esquerda da Figura 9.2 amosa un detalle dun dispositivo 
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common-rail tridimensional e realista de inxección de combustible. A 
imaxe da dereita mostra as dimensións dunha simplificación 
bidimensional do sistema common-rail que se empregará para a simulación 
deste capítulo. 

A xeometría bidimensional simplificada consta dun conduto 
principal de 50 mm de diámetro e 500 mm de lonxitude, que é dende 
onde se reparte o combustible a cada un dos cilindros do motor, neste 
caso para catro cilindros. As canalizacións secundarias son de 2 mm de 
ancho e 90 mm de lonxitude, e en ambos tramos non se contemplan 
espesores. 

Ao igual que nas simulacións levadas a cabo anteriormente, é básico 
identificar de antemán as entradas, as saídas e as demais rexións do 
dominio onde posteriormente se impoñerán as condicións de contorno. 
Se se emprega o módulo de Ansys para a realización da xeometría, 
poderase utilizar a ferramenta Name Selection para identificar cada unha 
das rexións. 

Deberá terse en conta que a xeometría amosada poderá adaptarse 
para a análise do sistema common-rail para un maior número de cilindros. 
Nas actividades propostas para este capítulo fixarase estender o estudo 
para 8 e 12 cilindros, e neses casos a xeometría empregada será similar á 
mostrada na Figura 9.2, simplemente estendendo a súa lonxitude e 
mantendo o resto de medidas. 

 

 
Figura 9.2: Forma e dimensións (expresadas en [mm]) do dominio a 

simular. 
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9.4. Mallado 

Para a realización da malla de cálculo do sistema common-rail 
presentado, empregarase un mallado estruturado en todas as rexións do 
dominio. Neste caso a malla estará composta por celas cadradas de 
tamaño uniforme de 1 mm na rexión central, e un tamaño máis reducido 
nas canalizacións cara os inxectores, chegando a un tamaño mínimo de 
0.25 mm. Deberá permitírselle ao programa de mallado certa 
flexibilidade nos parámetros de creación da malla, co fin de que esta sexa 
completamente estruturada. A Figura 9.3 amosa o aspecto da malla 
empregada nas dúas rexións principais. 

 
Figura 9.3: Detalles da malla do sistema common-rail empregada. 

Deberá asegurarse que todas as rexións da malla se atopen 
perfectamente identificadas. 

Configuración da simulación  
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Empregando os valores indicados para o mallado, obterase unha 
malla formada aproximadamente por 40000 celas. 

9.5. Configuración da simulación 

Abrir o programa Fluent  

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 9.4). 

 
Figura 9.4: Ventá de configuración de Fluent Launcher. 

Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
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Empregando os valores indicados para o mallado, obterase unha 
malla formada aproximadamente por 40000 celas. 

9.5. Configuración da simulación 

Abrir o programa Fluent  

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 9.4). 

 
Figura 9.4: Ventá de configuración de Fluent Launcher. 

Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
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fin de aumentar a precisión do solver. A continuación debe escollerse 
como directorio de traballo unha carpeta que fose creada previamente 
(Working Directory) e logo facer clic en Start. 

Importar/abrir a malla  

File > Read > Mesh  

Deberase empregar o explorador de arquivos para acceder dentro do 
directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa reporta na 
consola de comandos información básica sobre as características da 
mesma. Deberase comprobar que aparecen as entidades nas que se 
impoñerán as condicións de contorno. 

Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale):  

Setting Up Domain > Mesh > Scale...  

Setup > General > Mesh > Scale...  

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta.  

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado:  

Setting Up Domain > Mesh > Check  

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Pola contra, se o software detecta posibles fallos, amosará 
unha ventá emerxente na que se reporta o erro. 
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Deberase comprobar tamén o tamaño da malla de cálculo:  

Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas. Se se empregaron os mesmos parámetros que 
se indicaron na etapa de mallado, deberase contar con aproximadamente 
40000 celas rectangulares (quadrilateral cells). 

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla de visualización as diferentes 
partes da malla. É importante identificar inequivocamente as diferentes 
rexións que compoñen o dominio, nas cales posteriormente se 
impoñerán as condicións de contorno. Para facilitar o manexo e o 
recoñecemento das diferentes partes da malla, poderanse ocultar e 
amosar as rexións que se desexen, seleccionando ou deseleccionando as 
entidades no apartado Surfaces e posteriormente facendo clic no botón 
Display. 

Definición do solver e dos modelos 

Setup > General 

Deberase seleccionar a condición Pressure Based no apartado Type, 
Absolute na sección Velocity Formulation, Planar no apartado 2D Space e 
Transient no cadro de Time, tal e como amosa a Figura 9.5. 

Deberase modificar o modelo turbulento seleccionado: 

Setup > Models > Viscous 

Deberase seleccionar o modelo turbulento de dúas ecuacións k-
epsilon (Figura 9.5). 
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Figura 9.5: Configuración xeral do solver e do modelo turbulento 

empregado. 

Métodos de solución 

Solution > Methods 

Deberase cambiar o esquema de discretización das ecuacións de 
cantidade de movemento, de turbulencia e de enerxía a QUICK 
(Quadratic Upwind Interpolation for Convection Kinematics), xa que é o máis 
axeito para a resolución de fluxos con mallas estruturadas (Figura 9.6). 

 
Figura 9.6: Paneis de configuración dos esquemas de discretización e do 

material empregado. 
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Propiedades dos fluídos 

Setup > Materials 

Neste caso o fluído empregado é combustible diésel, polo que deberá 
ser engadido dende a base de datos de materiais de Fluent (diesel-liquid). 
Empregarase este fluído considerando as súa propiedades constantes, tal 
e como amosa a Figura 9.6. 

Condicións de operación  

Setup > Boundary Conditions > Operating Conditions...  

Neste caso fixarase como presión de operación 0 Pa. 

Posto que a presión absoluta é a suma da presión de operación e a 
presión manométrica, e en fluxos como o que estamos analizando o solver 
emprega os valores da presión absoluta, recoméndase poñer este valor a 
0. Deste xeito poderase fixar o valor da presión absoluta en cada rexión 
do dominio e evitarase cometer erros nas tarefas de configuración. 

Condicións de contorno 

Setup > Boundary Conditions 

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. Independentemente dos 
nomes asignados a cada unha de elas, deberase contar polo menos coas 
seguintes entidades: 

Nome Condición/Tipo 

Entrada Pressure-Inlet 

Inxectores Wall / Pressure-outlet 

Paredes Wall 

Interior_diesel Interior 

 

Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto. 
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Deberá existir unha entrada a través da cal se subministre o 
combustible e que garanta que estea a altas presións, neste caso a 500 bar 
(Figura 9.7). O resto de entidades, agás a rexión correspondente ao 
interior do dominio, deberán configurarse inicialmente como paredes, 
cos valores por defecto asignados polo programa (Figura 9.7). Debe terse 
en conta que as paredes correspondentes aos inxectores deben permitir 
a inxección do combustible nun determinado momento, polo que se 
deberá transformar o tipo de condición de contorno destas entidades 
durante o transcurso da simulación.  

 
Figura 9.7: Paneis de configuración das condicións de contorno. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. 

Solution > Initialization 

Dentro das opcións de Inicialización deberase escoller a 
inicialización híbrida (Hybrid Initialization). Este método de inicialización 
levará a cabo dez pseudo-iteracións en función das condicións de 
contorno impostas, conseguindo unha mellor inicialización do proceso 
de cálculo. Para executar a inicialización deberase facer clic no botón 
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Initialize. O proceso de inicialización estará completado cando apareza na 
consola de comandos a mensaxe: Hybrid initialization is done. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
na pantalla un valor do residuo asociado a cada unha das ecuacións de 
goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que o usuario decida que os valores dos residuos son 
suficientemente baixos e estables. 

Solution > Monitors > Residual 

Deberase desactivar o criterio de converxencia (Convergence 
Criterion) seleccionando none no despregable, e para poder acceder a esta 
opción é preciso ter seleccionada a opción Show Advanced Options. 
Deberase asegurar que se atopan marcadas as opcións Print to Console e 
Plot no cadro Options. Desta forma o programa mostrará os valores na 
consola de comandos a medida que avanza o proceso iterativo e 
visualizará a gráfica da evolución dos residuais durante o cálculo. Para 
aceptar a configuración faga clic en OK. 

Con este último paso finaliza o proceso de configuración do caso, así 
como a inicialización e a definición do modelo a resolver. Neste intre 
recoméndase gardar a simulación para non perder o traballo de 
configuración realizado. 

File > Write > Case&Data 

Deberase asignar un nome que identifique inequivocamente o caso 
en cuestión, como por exemplo Common_Rail_1.cas. Comprobarase que 
efectivamente foron creados dous arquivos con extensión .cas e .dat na 
carpeta de traballo. Se por calquera razón  se pecha o programa, poderase 
recuperar o traballo realizado ata o de agora lendo os arquivos 
Common_Rail_1.cas e Common_Rail_1.dat. 
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Figura 9.7: Paneis de configuración das condicións de contorno. 
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Proceso iterativo 

O proceso de apertura dos diferentes inxectores vén definido en 
función da orde de acendido dos cilindros e do número de cilindros nos 
que se inxecta o combustible. Para poder simular o proceso de apertura 
de cada un dos inxectores do common-rail empregarase un arquivo tipo 
scheme. Posto que neste arquivo está definida a secuencia temporal que 
controla os eventos de apertura e peche, este código incluirá tamén os 
parámetros de iteración e de time-steps da simulación. 

A Figura 9.8 amosa un exemplo do código scheme onde se detallan os 
pasos para levar a cabo a secuencia de inxección típica nun motor de catro 
cilindros: 1-3-4-2. O código atópase comentado especificando os 
comandos relativos á secuencia de traballo do primeiro inxector, e 
repítese para os resto de inxectores. Este exemplo deberá adaptarse as 
condicións particulares que se estean a modelar.  

 

Figura 9.8: Exemplo de código scheme da secuencia de apertura e peche 
dos inxectores. 

Unha vez finalizada a simulación non é preciso gardar a mesma, xa 
que ao tratarse dunha simulación en réxime transitorio, só quedaría 
gardado o instante final. Por este motivo, recoméndase configurar 
adecuadamente o post-procesado da simulación, que deberá ser 
executado durante o proceso de cálculo, co fin de obter os resultados nos 
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diferentes instantes da secuencia de traballo do dispositivo. 

9.6. Análise dos resultados 

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Evolución da gráfica de vectores de velocidade nas rexións 
próximas aos inxectores. Poderase realizar un vídeo que recolla os 
diferentes instantes da secuencia de traballo do dispositivo. 

• Análise do ciclo completo de traballo para diferentes secuencias 
de inxección. 

• Análise dos contornos de presión estática e dinámica en todo o 
dominio do common-rail. 

Para a obtención dos vídeos ou animacións poderanse empregar 
diferentes opcións, tal e como se expuxo no apartado 7.6 deste manual. 
A opción máis común é empregar o sistema de creación de animacións 
do propio programa, no apartado Results > Animations, cuxo 
funcionamento está indicado no manual de usuario do programa. Esta 
ferramenta xera un arquivo unha vez que finaliza a simulación, pero non 
permite visualizar os resultados ata que remata o proceso de cálculo. 
Outro método de creación dos vídeos, que aínda que é menos directo en 
ocasións pode resultar moi útil, é crear unha serie de comandos que se 
executan cada certo número de pasos temporais e que gardan unha imaxe 
dos resultados mentres a simulación vai avanzando. Deste xeito, este 
método permite visualizar os resultados a medida que se executa a 
simulación. 

Para levar a cabo a configuración desta modalidade de obtención dos 
vídeos, deberase acceder  ao apartado Solution > Calculation Activities, onde 
se deberán crear os comandos que se amosan na Figura 9.9. Estes 
comandos repiten varias veces tres pasos básicos que son: activar unha 
ventá gráfica, executar un arquivo con extensión .jou que levará a cabo a 
visualización da gráfica desexada e, por último, gardar a imaxe cun nome 
identificador. Un exemplo de arquivo de obtención de resultados con 



  

198 
 

Proceso iterativo 

O proceso de apertura dos diferentes inxectores vén definido en 
función da orde de acendido dos cilindros e do número de cilindros nos 
que se inxecta o combustible. Para poder simular o proceso de apertura 
de cada un dos inxectores do common-rail empregarase un arquivo tipo 
scheme. Posto que neste arquivo está definida a secuencia temporal que 
controla os eventos de apertura e peche, este código incluirá tamén os 
parámetros de iteración e de time-steps da simulación. 

A Figura 9.8 amosa un exemplo do código scheme onde se detallan os 
pasos para levar a cabo a secuencia de inxección típica nun motor de catro 
cilindros: 1-3-4-2. O código atópase comentado especificando os 
comandos relativos á secuencia de traballo do primeiro inxector, e 
repítese para os resto de inxectores. Este exemplo deberá adaptarse as 
condicións particulares que se estean a modelar.  

 

Figura 9.8: Exemplo de código scheme da secuencia de apertura e peche 
dos inxectores. 

Unha vez finalizada a simulación non é preciso gardar a mesma, xa 
que ao tratarse dunha simulación en réxime transitorio, só quedaría 
gardado o instante final. Por este motivo, recoméndase configurar 
adecuadamente o post-procesado da simulación, que deberá ser 
executado durante o proceso de cálculo, co fin de obter os resultados nos 

Análise dos resultados  
 

199 
 

diferentes instantes da secuencia de traballo do dispositivo. 

9.6. Análise dos resultados 

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Evolución da gráfica de vectores de velocidade nas rexións 
próximas aos inxectores. Poderase realizar un vídeo que recolla os 
diferentes instantes da secuencia de traballo do dispositivo. 

• Análise do ciclo completo de traballo para diferentes secuencias 
de inxección. 

• Análise dos contornos de presión estática e dinámica en todo o 
dominio do common-rail. 

Para a obtención dos vídeos ou animacións poderanse empregar 
diferentes opcións, tal e como se expuxo no apartado 7.6 deste manual. 
A opción máis común é empregar o sistema de creación de animacións 
do propio programa, no apartado Results > Animations, cuxo 
funcionamento está indicado no manual de usuario do programa. Esta 
ferramenta xera un arquivo unha vez que finaliza a simulación, pero non 
permite visualizar os resultados ata que remata o proceso de cálculo. 
Outro método de creación dos vídeos, que aínda que é menos directo en 
ocasións pode resultar moi útil, é crear unha serie de comandos que se 
executan cada certo número de pasos temporais e que gardan unha imaxe 
dos resultados mentres a simulación vai avanzando. Deste xeito, este 
método permite visualizar os resultados a medida que se executa a 
simulación. 

Para levar a cabo a configuración desta modalidade de obtención dos 
vídeos, deberase acceder  ao apartado Solution > Calculation Activities, onde 
se deberán crear os comandos que se amosan na Figura 9.9. Estes 
comandos repiten varias veces tres pasos básicos que son: activar unha 
ventá gráfica, executar un arquivo con extensión .jou que levará a cabo a 
visualización da gráfica desexada e, por último, gardar a imaxe cun nome 
identificador. Un exemplo de arquivo de obtención de resultados con 

  

198 
 

Proceso iterativo 

O proceso de apertura dos diferentes inxectores vén definido en 
función da orde de acendido dos cilindros e do número de cilindros nos 
que se inxecta o combustible. Para poder simular o proceso de apertura 
de cada un dos inxectores do common-rail empregarase un arquivo tipo 
scheme. Posto que neste arquivo está definida a secuencia temporal que 
controla os eventos de apertura e peche, este código incluirá tamén os 
parámetros de iteración e de time-steps da simulación. 

A Figura 9.8 amosa un exemplo do código scheme onde se detallan os 
pasos para levar a cabo a secuencia de inxección típica nun motor de catro 
cilindros: 1-3-4-2. O código atópase comentado especificando os 
comandos relativos á secuencia de traballo do primeiro inxector, e 
repítese para os resto de inxectores. Este exemplo deberá adaptarse as 
condicións particulares que se estean a modelar.  

m  

Figura 9.8: Exemplo de código scheme da secuencia de apertura e peche 
dos inxectores. 

Unha vez finalizada a simulación non é preciso gardar a mesma, xa 
que ao tratarse dunha simulación en réxime transitorio, só quedaría 
gardado o instante final. Por este motivo, recoméndase configurar 
adecuadamente o post-procesado da simulación, que deberá ser 
executado durante o proceso de cálculo, co fin de obter os resultados nos 

Análise dos resultados  
 

199 
 

diferentes instantes da secuencia de traballo do dispositivo. 

9.6. Análise dos resultados 

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Evolución da gráfica de vectores de velocidade nas rexións 
próximas aos inxectores. Poderase realizar un vídeo que recolla os 
diferentes instantes da secuencia de traballo do dispositivo. 

• Análise do ciclo completo de traballo para diferentes secuencias 
de inxección. 

• Análise dos contornos de presión estática e dinámica en todo o 
dominio do common-rail. 

Para a obtención dos vídeos ou animacións poderanse empregar 
diferentes opcións, tal e como se expuxo no apartado 7.6 deste manual. 
A opción máis común é empregar o sistema de creación de animacións 
do propio programa, no apartado Results > Animations, cuxo 
funcionamento está indicado no manual de usuario do programa. Esta 
ferramenta xera un arquivo unha vez que finaliza a simulación, pero non 
permite visualizar os resultados ata que remata o proceso de cálculo. 
Outro método de creación dos vídeos, que aínda que é menos directo en 
ocasións pode resultar moi útil, é crear unha serie de comandos que se 
executan cada certo número de pasos temporais e que gardan unha imaxe 
dos resultados mentres a simulación vai avanzando. Deste xeito, este 
método permite visualizar os resultados a medida que se executa a 
simulación. 

Para levar a cabo a configuración desta modalidade de obtención dos 
vídeos, deberase acceder  ao apartado Solution > Calculation Activities, onde 
se deberán crear os comandos que se amosan na Figura 9.9. Estes 
comandos repiten varias veces tres pasos básicos que son: activar unha 
ventá gráfica, executar un arquivo con extensión .jou que levará a cabo a 
visualización da gráfica desexada e, por último, gardar a imaxe cun nome 
identificador. Un exemplo de arquivo de obtención de resultados con 



  

200 
 

extensión .jou pode verse na Figura 9.9. 

 
Figura 9.9: Configuración dos comandos para o post-procesado do caso. 

A Figura 9.10 amosa un exemplo das gráficas de vectores de 
velocidade obtidas en diferentes instantes da secuencia de traballo do 
common-rail. 

9.7. Actividades propostas 

Como tarefa de entrega neste capítulo deberase crear un informe 
detallado onde se mostren os resultados indicados no apartado anterior. 
Deberá repetirse o estudo para diferentes configuracións do common-rail, 
por exemplo para 8 e 12 cilindros, quedando aberta a posibilidade de 
facer unha simulación cunha xeometría tridimensional realista para o 
caso de 4 cilindros. Deberase especificar a secuencia de inxección 
empregada, así como as propiedades dos fluídos que son utilizadas.  

A análise dos resultados realizada nesta tarefa deberá ser comentada 
facendo uso dos coñecementos teóricos da materia, e deberase engadir 
un último apartado onde figuren as conclusións obtidas neste estudo.  

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. Queda aberta a posibilidade de entregar un vídeo 
ou animación, que poderá ser inserido no propio informe ou achegado 
externamente, no que se aprecien de xeito máis claro as secuencias de 
traballo empregadas e a evolución das gráficas ao longo de toda a 
simulación. 

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 
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Figura 9.10: Exemplo dos resultados a analizar neste capítulo. 
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10. Simulación fluidodinámica 
dun motor de dous tempos 

10.1. Obxectivos 

O obxectivo deste capítulo é coñecer e reproducir o fluxo de gases 
no interior dun motor de combustión de dous tempos, no que se 
producen unha serie de eventos, cambios, e movementos dos seus 
compoñentes que dificultan o estudo mediante ferramentas numéricas 
de CFD. En xeral, esta práctica contribuirá na aprendizaxe de: 

• Simular un fluxo transitorio. 

• Empregar mallas dinámicas. 

• Analizar resultados de forma dinámica. 

10.2. Fundamentos e descrición do 
problema 

Os motores de dous tempos son motores de combustión interna 
alternativos que fan as mesmas catro etapas que un motor de catro tempos 
convencional (admisión, compresión, explosión e escape) pero en só 
dous movementos lineais do pistón, ou o que é o mesmo, nunha soa volta 
do cegoñal. A Figura 10.1 amosa un esquema das catro fases de 
funcionamento que se producen durante un ciclo de traballo dun motor 
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de dous tempos, o cal se completa en dúas etapas: 

• Na primeira etapa, na que se produce a carreira de subida, o 
pistón comprime a mestura de aire e combustible que está 
presente na cámara do cilindro. Simultaneamente, na zona 
inferior, prodúcese a aspiración dunha nova mestura, debido á 
succión xerada polo movemento ascendente do pistón. Polo 
tanto, os procesos de admisión e compresión compoñen esta 
primeira etapa. 

• A segunda etapa, na que se produce a carreira de baixada, comeza 
coa combustión da mestura unha vez que a buxía crea unha 
chispa, coa que se produce a explosión que empurra cara abaixo 
ao pistón. É a carreira na que se obtén a potencia. 
Simultaneamente, durante este descenso do pistón, comprímese 
a mestura que está aloxada no cárter, producindo a súa entrada 
na cámara de combustión. A entrada da nova mestura despraza 
aos gases de escape, desaloxándoos do cilindro unha vez queda 
aberta a comporta de escape. Polo tanto, os procesos de 
combustión e de escape forman a segunda etapa. 

 
Figura 10.1: Esquema das fases de funcionamento dun motor de dous 

tempos. 

Ao conseguir as catro fases en dous movementos do cegoñal, implica 
que en cada volta se produce unha fase de combustión da mestura, polo 
que, en xeral, estes motores teñen máis potencia para a mesma cilindrada 
que un motor de catro tempos, aínda que presentan maior consumo de 
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combustible [42]. Dentro do ámbito do transporte, o emprego deste 
motor é habitual en motocicletas e motores de embarcacións. 

Na secuencia de funcionamento do motor de dous tempos son 
importantes os procesos de transporte de fluído entre as diferentes 
cámaras do motor, tanto no desaloxo dos gases de escape como na súa 
substitución por unha nova mestura. É por isto polo que tanto a sección 
de escape como a de carga deben estar coidadosamente deseñadas e 
axustadas. Neste aspecto é factible sacar partido das simulacións 
numéricas como ferramenta para optimizar os proceso de transporte de 
fluídos dentro do motor [43, 44].  

10.3. Xeometría 

Neste capítulo emprégase unha única xeometría que representa un 
motor de dous tempos simplificado de dimensións realistas (Figura 10.2). 
Para poder levar a cabo o proceso de simulación nun tempo razoable 
segundo os recursos computacionais dispoñibles polo usuario, proponse 
abordar o estudo de forma bidimensional (2D).  O grado de realismo da 
xeometría poderá ser adaptado polo usuario, sempre e cando se manteña 
o movemento lineal para o desprazamento do pistón, e que os parámetros 
tanto de xeración da malla como os do posterior movemento sexan 
coherentes co mesmo. 

A Figura 10.2 amosa as dimensións principais empregadas para 
reproducir o dominio completo. Se o usuario o considera oportuno, nesta 
xeometría poderase evitar incluír as paredes do motor, é dicir, posto que 
para a simulación dos procesos de transporte do fluído unicamente serán 
necesarias as fronteiras en contacto co mesmo, poderase evitar simular o 
espesor real das paredes do dispositivo. 

Nas tarefas de realización da xeometría é fundamental diferenciar de 
xeito inequívoco as diferentes rexións que compoñen o dominio, e que 
aparecen coloreadas en branco, gris e amarelo na imaxe da dereita da 
Figura 10.2. É preciso que cada rexión estea delimitada por unha 
superficie propia separada do resto do dominio, co fin de poder 
configurar posteriormente as condicións de contorno e de movemento 
de cada zona. No caso de empregar o módulo de Ansys para a creación 
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de dous tempos, o cal se completa en dúas etapas: 

• Na primeira etapa, na que se produce a carreira de subida, o 
pistón comprime a mestura de aire e combustible que está 
presente na cámara do cilindro. Simultaneamente, na zona 
inferior, prodúcese a aspiración dunha nova mestura, debido á 
succión xerada polo movemento ascendente do pistón. Polo 
tanto, os procesos de admisión e compresión compoñen esta 
primeira etapa. 

• A segunda etapa, na que se produce a carreira de baixada, comeza 
coa combustión da mestura unha vez que a buxía crea unha 
chispa, coa que se produce a explosión que empurra cara abaixo 
ao pistón. É a carreira na que se obtén a potencia. 
Simultaneamente, durante este descenso do pistón, comprímese 
a mestura que está aloxada no cárter, producindo a súa entrada 
na cámara de combustión. A entrada da nova mestura despraza 
aos gases de escape, desaloxándoos do cilindro unha vez queda 
aberta a comporta de escape. Polo tanto, os procesos de 
combustión e de escape forman a segunda etapa. 

 
Figura 10.1: Esquema das fases de funcionamento dun motor de dous 

tempos. 

Ao conseguir as catro fases en dous movementos do cegoñal, implica 
que en cada volta se produce unha fase de combustión da mestura, polo 
que, en xeral, estes motores teñen máis potencia para a mesma cilindrada 
que un motor de catro tempos, aínda que presentan maior consumo de 
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da xeometría, poderase facer uso da ferramenta Name Selection para 
identificar cada unha das entidades do dominio. 

 

 
Figura 10.2: Aspecto, dimensións principais (expresadas en [mm]) e 

rexións do dominio a simular. 

10.4. Mallado 

Posto que para a realización da malla que se empregará neste 
capítulo non existen grandes esixencias en canto á calidade e a resolución 
da mesma, poderanse empregar as condicións de mallado automático de 
calquera programa de creación de malla. A Figura 10.3 amosa unha imaxe 
da malla empregada neste capítulo, na que as diferentes rexións que a 
compoñen aparecen sombreadas de diferente cor. Na rexión na que se 
moverá o pistón, coloreada de amarelo, a malla está formada por 
elementos rectangulares, mentres que no resto do dominio, tanto nas 
zonas polas que se move o gas como nas paredes do motor, a malla está 
formada por elementos triangulares. En todas as rexións o tamaño de cela 
está arredor dos 5 mm. Nas fronteiras da rexión na que se move o pistón 
os nodos da malla non son coincidentes cos das rexións veciñas, e nesas 
zonas empregaranse intercaras. 

No caso de empregar outros tamaños de cela, deberanse ter presentes 
os tamaños utilizados, xa que este será un parámetro importante para a 
configuración da ferramenta Layering de malla dinámica.  
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Figura 10.3: Imaxe da malla empregada neste capítulo. 

10.5. Configuración da simulación 

Abrir o programa Fluent  

Dependendo da versión do sistema operativo de Windows instalada 
no ordenador de traballo, seguirase unhas das seguintes liñas de 
comando:  

Inicio > Todos os programas > ANSYS 2020 R2 > Fluid Dynamics > Fluent 
2020 R2 

Inicio > ANSYS 2020 R2 > Fluent 2020 R2 

Outro xeito é executar a icona do programa, se se dispón de acceso 
directo, ou tecleando o nome do software na barra de inicio de Windows. 
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Unha vez sexa executado o programa, aparecerá na pantalla a ventá de 
configuración inicial de lanzamento do software (Figura 10.4). 

Posto que o problema vai ser abordado de xeito bidimensional, debe 
seleccionarse Dimension: 2D. Debe marcarse a opción Double Precision co 
fin de aumentar a precisión do solver. A continuación debe escollerse 
como directorio de traballo unha carpeta que fose creada previamente 
(Working Directory) e logo facer clic en Start. 

 
Figura 10.4: Ventá de configuración de Fluent Launcher. 

Importar/abrir a malla  

File > Read > Mesh  

Deberase empregar o explorador de arquivos para acceder dentro do 
directorio de traballo e seleccionar o ficheiro correspondente á malla que 
foi xerada previamente. Unha vez cargada a malla, o programa reporta na 
consola de comandos información básica sobre as características da 
mesma. Deberase comprobar que aparecen as entidades nas que se 
impoñerán as condicións de contorno. 

Verificacións da malla 

Ben dende a árbore extensible á esquerda do programa, ou ben 
dende as pestanas de acceso da parte superior, abrirase a opción de escala 
(Scale):  
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Setting Up Domain > Mesh > Scale...  

Setup > General > Mesh > Scale...  

Deberase verificar coidadosamente que tanto as dimensións do 
dominio como as unidades empregadas son as desexadas. É un erro 
común traballar con mallas en unidades ou escalas distintas ás que se 
pretenden simular, polo que se deberá ser extremadamente rigoroso á 
hora de verificar que esta configuración sexa correcta.  

Despois de verificar as unidades de traballo e realizar o escalado da 
mesma se fose preciso, deberase comprobar que non houbo erros nin na 
súa apertura ou importación, nin no posterior escalado:  

Setting Up Domain > Mesh > Check  

Se a malla non presenta ningún problema mostrarase na consola o 
comando Done. Pola contra, se o software detecta posibles fallos, amosará 
unha ventá emerxente na que se reporta o erro. Neste caso deberá terse 
en conta que, se previamente na fase de mallado a algunha das entidades 
se lle asignou a categoría de Interface, o programa mostrará unha mensaxe 
de advertencia na que se indica que estas rexións non están configuradas. 
Esta mensaxe deixará de aparecer cando o caso estea completamente 
configurado. 

Deberase comprobar tamén o tamaño da malla de cálculo:  

Domain > Mesh > Info > Size  

Unha vez executado o comando aparecerá na consola a información 
relativa ao número de celas. Seguindo a metodoloxía presentada 
anteriormente, a malla creada para esta simulación estará formada por 
23146 celas e 8755 nodos, combinándose celas rectangulares e 
triangulares, repartidas en 5 rexións separadas. 

Do mesmo xeito, deberase comprobar a visualización de todas as 
entidades que forman parte da malla:  

Domain > Mesh > Display…  

Este comando mostrará na pantalla a ventá de visualización das 
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diferentes partes da malla, permitindo visualizalas, tal e como amosa a 
Figura 10.5. É importante identificar inequivocamente as diferentes 
rexións que compoñen o dominio, nas cales posteriormente se 
impoñerán as condicións de contorno. Para facilitar o manexo e o 
recoñecemento das diferentes partes da malla, poderanse ocultar e 
amosar as rexións que se desexen, seleccionando ou deseleccionando as 
entidades no apartado Surfaces e posteriormente facendo clic no botón 
Display. 

En ocasións, o número de compoñentes da malla é elevado, tal e 
como pasa neste caso, e para facilitar a identificación das diferentes 
rexións é recomendable empregar diferentes cores para visualizar 
claramente cada unha das entidades que a forman. Para activar a 
visualización por cores deberase premer no botón Colors... situado na 
marxe inferior da ventá Mesh Display, e seleccionar a opción Color by ID. 

 
Figura 10.5: Aspecto da malla unha vez aberta en Fluent. 

A malla empregada nesta simulación deberá estar formada polas 
seguinte rexións:  
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Nome proposto Rexión 

Interior_metal Celas internas de metal (zona exterior do dominio) 

Interior_aire Celas internas de aire (zona inferior do dominio) 

Interior_aire_pre Celas internas de aire (zona previa á entrada) 

Interior_aire_hot 
Celas internas de aire (zona superior do cilindro onde 

se producirá a combustión) 

Interior_aire_piston 
Celas internas de aire (celas cadradas na rexión onde 

se desprazará o pistón) 

Interior_aire_fronteira Celas internas de aire (fronteira entre zonas de aire) 

 

Definición do solver e dos modelos 

Setup > General 

 
Figura 10.6: Configuración xeral do solver. 

Deberase seleccionar a condición Pressure Based no apartado Type, 
Absolute na sección Velocity Formulation, Planar no apartado 2D Space e 
Transient no cadro de Time, tal e como amosa a Figura 10.6. 

Deberase activar a solución da ecuación da enerxía: 

Setup > Models > Energy 
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Ademais, deberase modificar o modelo turbulento seleccionado: 

Setup > Models > Viscous 

Deberase seleccionar o modelo turbulento de dúas ecuacións k-omega 
(SST). 

Métodos de solución 

Solution > Methods 

Manteranse todos os métodos numéricos prefixados polo programa, 
tanto no acoplamento presión-velocidade como nos diferentes esquemas 
de discretización espacial. 

Propiedades dos materiais 

Setup > Materials 

O fluído de traballo é o aire (air), material que por defecto xa aparece 
recollido na lista de materiais. Manteranse as condicións de densidade e 
viscosidade constantes e cos valores asignados polo programa (Figura 
10.7). 

 
Figura 10.7: Configuración do material aire. 

Para o material do metal deberase seleccionar o aceiro (Steel) na base 
de datos de materiais de Fluent. Deberase asignar este material á entidade 
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correspondente coas celas que forman a rexión das paredes do motor. 
Para iso accederase ao apartado Setup > Cell Zone Conditions e abrirase a 
ventá de edición da entidade correspondente, facendo dobre clic sobre o 
seu nome. Na ventá emerxente que aparecerá na pantalla deberase 
seleccionar o material Steel no despregable da sección Material Name. 

 
Figura 10.8: Panel de configuración para a asignación de material a 

unha rexión do dominio. 

Condicións de operación 

Setup > Boundary Conditions > Operating Conditions... 

Neste caso manterase o valor da presión de operación en 101325 Pa, 
que se corresponde coa presión atmosférica, e que representará a presión 
na saída do motor. 

Condicións de contorno 

Setup > Boundary Conditions 

Neste panel aparecen as entidades que previamente se visualizaron e 
que foron creadas na fase de xeración da malla. Independentemente dos 
nomes asignados a cada unha de elas, deberase contar polo menos coas 
seguintes entidades: 

Nome Condición/Tipo 

Entrada Pressure inlet 

Saída Pressure outlet 
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Paredes Wall (No slip) 

Interior Interior 

Intercaras Interface 

 Deberá verificarse no apartado Type que todas as entidades teñen 
asignado o tipo de condición de contorno correcto.  

Deberase introducir na entrada o valor de 500 Pa no apartado Gauge 
Total Pressure e unha temperatura de entrada de 300 K. A saída do motor 
manterase a presión atmosférica, polo que se deixará o valor de 0 Pa no 
apartado Gauge Total Pressure e unha temperatura de 300 K para a 
temperatura de refluxo se a houbese (Backflow Total Temperature). 

O pistón do motor realizará un movemento alternativo, no que se 
producirá a modificación da malla, polo que para que este desprazamento 
sexa factible deberase permitir que as fronteiras laterais do pistón deslicen 
ao longo da malla. Para iso deberanse configurar intercaras que se 
actualizarán sen necesidade de modificar as condicións de contorno a 
medida que se produce o avance do pistón. 

 
Figura 10.9: Panel de configuración das intercaras. 

Para configurar as intercaras deberase acceder ao apartado Setup > 
Mesh Interfaces. Dentro da ventá emerxente que aparecerá na pantalla 
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estarán as entidades da malla que foron definidas co tipo Interface (Figura 
10.9). Para definir a intercara deberase facer clic non botón Auto Create, 
e o propio programa creará a interface de conexión entre as entidades 
presentes. Non obstante, tamén se poderá facer clic no botón Manual 
Create, e aparecerá unha nova ventá de configuración onde o usuario 
deberá seleccionar as entidades que pertencen a cada intercara. 

Malla dinámica 

Nesta simulación definirase un movemento periódico de vaivén 
asociado tipicamente ao movemento dun pistón, (In-Cilinder). Ademais, 
empregarase o sistema de remallado denominado Layering. 

Setup > Dynamic Mesh 

Deberase activar a opción Dynamic Mesh. Dentro do apartado Mesh 
Methods deberá activarse a opción Layering e no apartado Options deberase 
marcar a opción In-Cylinder. 

Facendo clic no botón Settings... do apartado Mesh Methods, 
estableceranse os parámetros da ferramenta Layering. Neste caso 
manteranse os valores por defecto determinados polo programa (0.4 para 
Split factor e 0.2 para Collapse Factor), tal e como amosa a Figura 10.10. 

De modo análogo, facendo clic no botón Settings... do apartado 
Options, estableceranse os parámetros para a opción In-Cylinder. 
Determinarase unha velocidade de xiro do cegoñal de 15  rpm, 
empezando o movemento en 180°, durante un período de 360° e cunha 
carreira do pistón de 100 mm (manivela de 50 mm), tal e como mostra a 
Figura 10.10. 

Para asociar este movemento á rexión da malla, deberase facer clic 
no botón Create/Edit… e seleccionar no despregable do apartado Zones 
Names o nome da parede inferior do cilindro. No apartado Type 
manterase seleccionada a opción Rigid Body e deberase introducir o valor 
de 0.1 m no apartado Lift/Stroke (Figura 10.10). Na pestana Meshing 
Options, deberase introducir o tamaño da cela no apartado Cell Height, que 
para a malla empregada é de 0.005 m. Unha vez configurados estes 
parámetros deberase facer clic no botón Create. 
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Figura 10.10: Paneis de configuración e de visualización da malla 

dinámica. 

Para asociar o movemento á parede superior do cilindro, 
procederase do mesmo xeito, empregando os mesmos parámetros. 

Unha vez definido o movemento do pistón, quedan pendentes de 
configurar unha serie de eventos importantes que sucederán durante o 
desprazamento do pistón, e que son: 

• A apertura da válvula de admisión. 

• O peche da válvula de admisión. 

• A explosión da mestura. 
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Para crear estes eventos deberase facer clic no botón Events..., dentro 
da sección de Dynamic Mesh. Definiranse tres eventos denominados open, 
close e buxía_on nos ángulos 240, 480 e 350 respectivamente. No primeiro 
deles o que se levará a cabo é a transformación do tipo de condición de 
contorno da parede denominada Entrada, pasando de Wall a Interior, o que 
representará a apertura da válvula de entrada, tal e como a amosa a Figura 
10.11. Do mesmo xeito, configurarase o peche da válvula, modificando o 
tipo de condición de contorno de Interior a Wall (Figura 10.11). 

 
Figura 10.11: Paneis de configuración dos eventos. 

Aínda que sería posible reproducir as reaccións químicas que teñen 
lugar durante o proceso de combustión, para reproducir este proceso 
dentro da cámara do cilindro, empregarase a simplificación do aumento 
da temperatura de forma instantánea, posto que se considera unha 
explosión moi rápida. Para recrear este proceso de aumento súbito da 
temperatura deberase crear un evento que execute o comando: file read-
journal “patch”, que o que fará será executar un arquivo tipo journal, 
denominado patch.jou, que deberemos ter creado previamente no 
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• A apertura da válvula de admisión. 

• O peche da válvula de admisión. 

• A explosión da mestura. 
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Para crear estes eventos deberase facer clic no botón Events..., dentro 
da sección de Dynamic Mesh. Definiranse tres eventos denominados open, 
close e buxía_on nos ángulos 240, 480 e 350 respectivamente. No primeiro 
deles o que se levará a cabo é a transformación do tipo de condición de 
contorno da parede denominada Entrada, pasando de Wall a Interior, o que 
representará a apertura da válvula de entrada, tal e como a amosa a Figura 
10.11. Do mesmo xeito, configurarase o peche da válvula, modificando o 
tipo de condición de contorno de Interior a Wall (Figura 10.11). 

 
Figura 10.11: Paneis de configuración dos eventos. 

Aínda que sería posible reproducir as reaccións químicas que teñen 
lugar durante o proceso de combustión, para reproducir este proceso 
dentro da cámara do cilindro, empregarase a simplificación do aumento 
da temperatura de forma instantánea, posto que se considera unha 
explosión moi rápida. Para recrear este proceso de aumento súbito da 
temperatura deberase crear un evento que execute o comando: file read-
journal “patch”, que o que fará será executar un arquivo tipo journal, 
denominado patch.jou, que deberemos ter creado previamente no 
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directorio de traballo. Os comandos incluídos neste arquivo (Figura 
10.11) executarán a operación patch, que impoñerá unha temperatura de 
2000 K en toda a rexión seleccionada. 

Cos parámetros previos que foron introducidos queda definida a lei 
de movemento que terá o pistón e os eventos que se producen durante o 
recorrido do mesmo. Neste intre, e antes de facer ningunha 
previsualización do movemento da malla, é importante gardar o caso para 
non perder o traballo de configuración realizado ata o de agora: 

File > Write > Case 

Unha vez gardado o caso, poderase visualizar o movemento da malla 
para verificar que todos os parámetros impostos son os adecuados. Para 
visualizar o movemento deberá estar mostrada a malla na ventá de 
visualización. No caso de que non o estea, deberase acceder ao apartado 
Display > Mesh e seleccionar as rexións do dominio que se desexen 
mostrar. Para reproducir o movemento deberase facer clic no botón 
Preview Mesh Motion... do apartado Dynamic Mesh e deberase seleccionar o 
número de pasos temporais que se desexan visualizar. Tal e como amosa 
a Figura 10.10, neste caso para a previsualización seleccionáronse 20 pasos 
temporais, pero deberá terse presente que o ciclo completo transcorrerá 
en 720 pasos temporais (0.5 graos de xiro por paso temporal). Unha vez 
se prema no botón Preview a malla visualizada comezará a moverse. 
Calquera erro detectado nesta previsualización estará anticipando un erro 
no proceso de simulación, polo que se deberá verificar que o 
funcionamento sexa o correcto. Deberá terse en conta que durante o 
proceso de previsualización do movemento da malla dinámica, agás a 
solución do transporte do fluído polo interior do dominio, o resto de 
eventos, actuacións ou actividades programadas, executaranse do mesmo 
xeito que se o programa estivese executando o cálculo. 

Unha vez executada a previsualización do ciclo completo 
procederase a visualizar os contornos de temperatura no interior do 
dominio. Se a execución do arquivo journal que reproduce o aumento da 
temperatura foi correcta, o mapa de contornos deberá amosar unha 
temperatura elevada na rexión superior do cilindro, tal e como amosa a 
Figura 10.12. 
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Figura 10.12: Mapa de contornos de temperatura obtido durante o 

proceso de verificación da configuración. 

Antes de proceder coa simulación, deberase verificar que o pistón se 
atopa na posición inicial. Por este motivo, recoméndase realizar a 
previsualización dun ciclo completo ou, pola contra, volver ler o arquivo 
gardado previamente. Ao mesmo tempo, deberanse eliminar todas 
aquelas imaxes e arquivos que foran creados durante o proceso de 
previsualización. 

Inicialización da solución 

Como en todo proceso iterativo, é preciso darlle valores iniciais a 
todas as variables de cálculo para que poida dar comezo o método 
iterativo de resolución. 

Solution > Initialiation 

Dentro das opcións de Inicialización deberase escoller a 
inicialización híbrida (Hybrid Initialization). Este método de inicialización 
levará a cabo dez pseudo-iteracións en función das condicións de 
contorno impostas, conseguindo unha mellor inicialización do proceso 
de cálculo. Para executar a inicialización deberase facer clic no botón 
Initialize. O proceso de inicialización estará completado cando apareza na 
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consola de comandos a mensaxe: Hybrid initialization is done. Neste caso é 
posible que apareza unha mensaxe indicando que non se acadou a 
converxencia na inicialización. Aínda que isto non é un fallo, podería 
arranxarse se se aumenta o número de iteracións da inicialización. Para 
elo deberase facer clic no botón More Settings... e indicar no cadro Number 
of Iterations un número de iteracións maior, e posteriormente volver a 
executar a inicialización. 

Fixar criterios de converxencia 

Mentres resolve as ecuacións de forma iterativa, Fluent vai mostrando 
na pantalla un valor do residuo asociado a cada unha das ecuacións de 
goberno do fluxo que está a resolver, indicando o grao de axuste da 
solución alcanzada en cada unha das iteracións coas ecuacións de 
goberno discretas. Neste caso proponse que o proceso iterativo sexa 
levado a cabo ata que se acade a converxencia, a cal será avaliada segundo 
os criterios fixados por defecto no software. Deste xeito, posto que se trata 
dunha simulación en réxime transitorio, unha vez que se acade a 
converxencia en cada paso temporal da simulación, o programa pasará ao 
seguinte paso temporal, optimizando o número de iteracións que son 
necesarias realizar en cada time-step da simulación. 

 Solution > Monitors > Residual 

 
Figura 10.13: Configuración dos residuais. 
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Deberanse manter os valores fixados por defecto para o criterio de 
converxencia. Ademais, deberase asegurar que se atopan marcadas as 
opcións Print to Console e Plot no cadro Options (Figura 10.13). Desta forma 
o programa mostrará os valores na consola de comandos a medida que 
avanza o proceso iterativo e visualizará a gráfica da evolución dos residuais 
durante o cálculo. Para aceptar a configuración faga clic en OK. 

Proceso iterativo 

Solution > Run Calculation 

Na sección Number of Time Steps deberas introducir o número de 
pasos temporais que se desexan simular, que para este caso son 720. 
Deberá manterse en 20 o número máximo de iteracións en cada time-step 
(Figura 10.14). 

 
Figura 10.14: Configuración dos parámetros de cálculo. 

O número de pasos temporais a resolver ven derivado dos parámetros 
de malla dinámica seleccionados. Neste caso fixouse na configuración un 
valor de 0.5° por cada paso temporal, polo que os 720 pasos temporais 
correspóndense con 360° de xiro do cegoñal. 

 Para iniciar o proceso de cálculo deberase premer no botón 
Calculate. 
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Nos casos de simulación en réxime transitorio, o aspecto do residuais 
é diferente o dos casos en réxime estacionario. Dentro de cada paso 
temporal a evolución é semellante á dun caso estacionario, pero segundo 
avanza a simulación, o aspecto conxunto dos residuais de todos os pasos 
temporais aseméllase máis a unha franxa que a unha converxencia usual. 

Ao ser unha simulación en réxime transitorio o criterio de 
converxencia difire dos empregados en cálculos estacionarios. Nestas 
simulacións o importante é a estabilidade da solución, que se poderá 
verificar se o nivel dos residuais acadado en cada un dos pasos temporais 
é o adecuado. 

Nesta simulación non é preciso gardar o caso final, posto que o 
interesante non é avaliar a situación final, senón todo o proceso. Neste 
tipo de cálculos transitorios é habitual gardar arquivos de solución 
intermedios, co fin de poder recuperar ou relanzar os cálculos dende 
instantes intermedios do proceso. 

10.6. Análise dos resultados 

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Gráficas de contornos de presión estática ao longo de todo o ciclo. 

• Gráficas de contornos da magnitude da velocidade ao longo de 
todo o ciclo. 

• Gráficas de contornos da temperatura ao longo de todo o ciclo. 

Para a obtención dos vídeos ou animacións dos resultados acadados 
nesta simulación poderanse empregar diferentes opcións, tal e como se 
expuxo no apartado 7.6 deste manual. A opción máis común é empregar 
o sistema de creación de animacións do propio programa, no apartado 
Results > Animations, cuxo funcionamento está indicado no manual de 
usuario do programa. Esta ferramenta xera un arquivo unha vez que 
finaliza a simulación, pero non permite visualizar os resultados ata que 
remata o proceso de cálculo. 
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Outro método de creación dos vídeos, que aínda que é menos directo 
en ocasións pode resultar moi útil, é crear unha serie de comandos que 
se executan cada certo número de pasos temporais e que gardan unha 
imaxe dos resultados mentres a simulación vai avanzando. Deste xeito, 
este método permite visualizar os resultados a medida que se executa a 
simulación. Para levar a cabo a configuración desta modalidade de 
obtención dos vídeos, deberase acceder ao apartado Solution > Calculation 
Activities, onde se deberán crear os comandos que se amosan na Figura 
10.15. Estes comandos repiten varias veces tres pasos básicos que son: 
activar unha ventá gráfica, executar un arquivo con extensión .jou que 
levará a cabo a visualización da gráfica desexada e, por último, gardar a 
imaxe cun nome identificador. Os arquivos con extensión .jou son moi 
sinxelos, e móstrase na Figura 10.15 unha imaxe do código dos arquivos 
empregados nesta simulación. 

A Figura 10.16 amosa un exemplo das gráficas de contornos obtidas 
en diferentes instantes do ciclo do motor. 

 
Figura 10.15: Paneis de configuración dos comandos para o post-

procesado da simulación. 
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temporais aseméllase máis a unha franxa que a unha converxencia usual. 

Ao ser unha simulación en réxime transitorio o criterio de 
converxencia difire dos empregados en cálculos estacionarios. Nestas 
simulacións o importante é a estabilidade da solución, que se poderá 
verificar se o nivel dos residuais acadado en cada un dos pasos temporais 
é o adecuado. 

Nesta simulación non é preciso gardar o caso final, posto que o 
interesante non é avaliar a situación final, senón todo o proceso. Neste 
tipo de cálculos transitorios é habitual gardar arquivos de solución 
intermedios, co fin de poder recuperar ou relanzar os cálculos dende 
instantes intermedios do proceso. 

10.6. Análise dos resultados 

A continuación, lístanse os principais resultados que deberán ser 
analizados neste capítulo para verificar a validez das simulacións e para a 
súa posterior entrega: 

• Gráficas de contornos de presión estática ao longo de todo o ciclo. 

• Gráficas de contornos da magnitude da velocidade ao longo de 
todo o ciclo. 

• Gráficas de contornos da temperatura ao longo de todo o ciclo. 

Para a obtención dos vídeos ou animacións dos resultados acadados 
nesta simulación poderanse empregar diferentes opcións, tal e como se 
expuxo no apartado 7.6 deste manual. A opción máis común é empregar 
o sistema de creación de animacións do propio programa, no apartado 
Results > Animations, cuxo funcionamento está indicado no manual de 
usuario do programa. Esta ferramenta xera un arquivo unha vez que 
finaliza a simulación, pero non permite visualizar os resultados ata que 
remata o proceso de cálculo. 
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Outro método de creación dos vídeos, que aínda que é menos directo 
en ocasións pode resultar moi útil, é crear unha serie de comandos que 
se executan cada certo número de pasos temporais e que gardan unha 
imaxe dos resultados mentres a simulación vai avanzando. Deste xeito, 
este método permite visualizar os resultados a medida que se executa a 
simulación. Para levar a cabo a configuración desta modalidade de 
obtención dos vídeos, deberase acceder ao apartado Solution > Calculation 
Activities, onde se deberán crear os comandos que se amosan na Figura 
10.15. Estes comandos repiten varias veces tres pasos básicos que son: 
activar unha ventá gráfica, executar un arquivo con extensión .jou que 
levará a cabo a visualización da gráfica desexada e, por último, gardar a 
imaxe cun nome identificador. Os arquivos con extensión .jou son moi 
sinxelos, e móstrase na Figura 10.15 unha imaxe do código dos arquivos 
empregados nesta simulación. 

A Figura 10.16 amosa un exemplo das gráficas de contornos obtidas 
en diferentes instantes do ciclo do motor. 

 
Figura 10.15: Paneis de configuración dos comandos para o post-

procesado da simulación. 
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Figura 10.16: Exemplo dos resultados obtidos nesta simulación, 

mostrados intencionadamente sen valores nin escala. 
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10.7. Actividades propostas 

Como tarefa de entrega neste capítulo deberase crear un informe 
detallado onde se mostren os resultados indicados no apartado anterior.  

Ademais, deberanse avaliar tamén os seguintes parámetros: 

• A evolución da forza sobre o pistón, co fin de cuantificar a 
evolución ao longo de todo o ciclo da forza total que exerce o gas 
sobre o cilindro. 

• A influencia no cambio da velocidade de xiro do cegoñal. 
Deberase buscar información acerca da velocidade de xiro 
representativa dun motor de dous tempos, repetindo o proceso 
de simulación para as novas condicións seleccionadas. 

• A modificación do instante de apertura ou peche das válvulas de 
entrada e saída. Deberá avaliarse como afecta ao fluxo de gases no 
interior do motor o atraso ou adianto dos procesos de apertura e 
de peche das válvulas. 

A análise dos resultados realizada nesta tarefa deberá ser comentada 
facendo uso dos coñecementos teóricos da materia, e deberase engadir 
un último apartado onde figuren as conclusións obtidas neste estudo.  

O formato de entrega recomendado para o informe deste capítulo 
será un arquivo PDF. Os vídeos ou animacións poderán ser entregados no 
seguintes formatos: .gif, .avi, .mp4, ou en calquera outro formato de vídeo.  

Deberase prestar atención á forma de envío e ao prazo de entrega 
desta actividade, os cales serán indicados na sesión de prácticas da 
materia. 
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Sistemas fl uidomecánicos 
no transporte Sistemas fl uidomecánicos 

no transporte
Prácticas de simulacións numéricas

A tecnoloxía CFD, siglas de Computational 
Fluid Dynamics, en galego Dinámica de 
Fluídos Computacional, é unha técnica de 
análise numérica que permite determinar 
o comportamento dos fl uídos mediante 
a realización de experimentos virtuais no 
ordenador. Esta técnica conta con varias 
décadas de desenvolvemento científi co 
de respaldo, converténdose a día de hoxe 
nun dos estándares de análise para nume-
rosos sectores industriais. É por iso que as 
simulacións numéricas son empregadas 
actualmente como efi caces ferramentas de 
diagnóstico nas etapas de deseño, mellora 
e optimización de produtos e procesos de 
fabricación en industrias como a naval, a 
automobilística, a aeroespacial, a hidráu-
lica, as enerxías renovables, a enxeñería 
biomédica ou a construción.

Co fi n de achegar o emprego desta técnica 
ao alumnado do grado de Enxeñería Me-
cánica, este manual foi creado para servir 
de apoio á docencia da materia Sistemas 
� uidomecánicos e materiais avanzados para o 

transporte, enfocándose na aplicación prác-
tica de simulacións numéricas en casos 
reais da enxeñería nos que se atopan invo-
lucrados fl uxos de fl uídos. Esta  colección 
de exercicios prácticos pretende servir de 
axuda na etapa formativa do alumnado, 
facilitándolle a información necesaria e a 
metodoloxía que deberá empregar para 
levar a cabo o estudo de diferentes casos, 
e favorecendo así unha comprensión intui-
tiva dos problemas propostos mediante a 
análise dos resultados obtidos nas simula-
cións numéricas.

Por tratarse dun dos programas de CFD 
máis empregados na industria, o software 
utilizado nas actividades deste manual é 
ANSYS Fluent 2020. Así tamén, as activi-
dades propostas neste manual foron dese-
ñadas para poder ser levadas a cabo con-
tando cunhas esixencias computacionais 
accesibles para o alumnado, o cal poderá 
realizar nun tempo axeitado os exercicios 
aquí recollidos.
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Os catro autores deste 
manual son docentes na Área 
de Mecánica de Fluídos da 
Escola de Enxeñería Industrial 
da Universidade de Vigo, e 
contan con experiencia no 
ensino da materia Sistemas 
fluidomecánicos e materiais 
avanzados para o transporte, 
no Grado de Enxeñería 
Mecánica. Concienciados 
coa importancia de 
incorporar a innovación 
ao ensino universitario, 
e con inquedanza por 
mellorar a calidade da 
docencia impartida, os 
autores forman parte 
dun grupo de innovación 
docente denominado CFD 
aplicado á docencia. Este 
grupo ten como obxectivo 
explorar as capacidades 
do CFD (Dinámica de 
Fluídos Computacional) 
como ferramenta de 
axuda na aprendizaxe dos 
conceptos da Mecánica 
de Fluídos. Mediante a 
creación de novos contidos 
e explicacións, busca 
mellorar a comprensión dos 
coñecementos por parte do 
alumnado, favorecendo, ao 
mesmo tempo, as tarefas 
de aprendizaxe autónoma e 
asíncrona.  Nos últimos anos 

este grupo de innovación 
docente colaborou en 
diferentes proxectos nos que 
levou a cabo a realización 
de cursos masivos online e 
abertos (MOOCs), a creación 
dunha videoteca con material 
formativo ou a realización de 
actividades de aprendizaxe-
servizo. 
No eido da investigación, os 
autores pertencen ao Grupo 
de Tecnoloxía Enerxética 
(GTE), adscrito ao Centro de 
Investigación en Tecnoloxías, 
Enerxías e Procesos 
Industriais (CINTECX), no 
que colaboran en proxectos 
de investigación nacionais 
e internacionais. Este grupo 
destaca polo elevado número 
de contratos de colaboración 
con diferentes empresas do 
sector do transporte, como 
son o sector ferroviario, o 
aeronáutico, e súa estreita 
colaboración coa industria 
automobilística. A experiencia 
dos autores na aplicación 
da enxeñería en proxectos 
industriais e de investigación 
conxúgase neste manual, co 
fi n de trasladar ao alumnado 
unha visión aplicada e 
práctica dos conceptos desta 
materia. 
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A tecnoloxía CFD, siglas de Computational 
Fluid Dynamics, en galego Dinámica de 
Fluídos Computacional, é unha técnica de 
análise numérica que permite determinar 
o comportamento dos fl uídos mediante 
a realización de experimentos virtuais no 
ordenador. Esta técnica conta con varias 
décadas de desenvolvemento científi co 
de respaldo, converténdose a día de hoxe 
nun dos estándares de análise para nume-
rosos sectores industriais. É por iso que as 
simulacións numéricas son empregadas 
actualmente como efi caces ferramentas de 
diagnóstico nas etapas de deseño, mellora 
e optimización de produtos e procesos de 
fabricación en industrias como a naval, a 
automobilística, a aeroespacial, a hidráu-
lica, as enerxías renovables, a enxeñería 
biomédica ou a construción.

Co fi n de achegar o emprego desta técnica 
ao alumnado do grado de Enxeñería Me-
cánica, este manual foi creado para servir 
de apoio á docencia da materia Sistemas 
� uidomecánicos e materiais avanzados para o 

transporte, enfocándose na aplicación prác-
tica de simulacións numéricas en casos 
reais da enxeñería nos que se atopan invo-
lucrados fl uxos de fl uídos. Esta  colección 
de exercicios prácticos pretende servir de 
axuda na etapa formativa do alumnado, 
facilitándolle a información necesaria e a 
metodoloxía que deberá empregar para 
levar a cabo o estudo de diferentes casos, 
e favorecendo así unha comprensión intui-
tiva dos problemas propostos mediante a 
análise dos resultados obtidos nas simula-
cións numéricas.

Por tratarse dun dos programas de CFD 
máis empregados na industria, o software 
utilizado nas actividades deste manual é 
ANSYS Fluent 2020. Así tamén, as activi-
dades propostas neste manual foron dese-
ñadas para poder ser levadas a cabo con-
tando cunhas esixencias computacionais 
accesibles para o alumnado, o cal poderá 
realizar nun tempo axeitado os exercicios 
aquí recollidos.
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